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Overview 
 

Please note that the PRIME User Guide is always in progress.   

 

PRIME is ChyronHego’s advanced graphics playout and authoring system.  It is based on 
ChyronHego’s fast and powerful dedicated PRIME Engine (previously known as as GS2) 

PRIME allows for both design and playout in a single application.  This fully featured application 
is designed as a multi-purpose platform that is dedicated to Advanced Systems Integration. 

PRIME’s “Event Driven” architectural model allows users to utilize an array of capabilities for 
connecting and reacting to scene changes. Binding objects and Data is quick, easy and 
intuitive. 

The “Point & Click” user interface enables advanced functionality without the usually required 
advanced scripting. 

The power of PRIME’s “Advanced Data Object,” along with the Expression builder, ensures 
simplicity and ease of use for both Point & Click Acquisitions and the Parsing and Playout of 
data.  PRIME also supports VB and Jscript for more advanced and complicated workflows.​
C# scripting is also available for an integrated development environment. 

Automation for PRIME includes:  

●​ gRPC 
●​ ChyronHego’s Intelligent Interface, along with an accompanying powerful Pattern 

matching Rules Engine 
●​ VDCP 
●​ PBus 
●​ UDP server to receive broadcast requests 

“Warp Technology,” an advanced and unique feature in the PRIME Render Engine, allows users 
to create and import animated clip effects created in After Effects, 3D Studio and other 3D 
design tools.  Additionally, PRIME Render Engine can map real time updateable content into the 
effect in design or during runtime. 

 
 

​
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PRIME First Time Startup 
Prime Application Security Warning 

After installation Prime, the Prime application can be found at C:\Program Files\Chyron\Prime 
5.0.0\Chyron.Prime.Application.exe if not available on your Desktop.​
​
Chyron Prime’s full functionality requires running the software with full administrative privileges.​
​
In order to permanently run Prime with administrative privileges, please do the following: 

●​ Windows 10: Right click on the Chyron Prime executable shortcut and go to properties​
 

●​ Windows 11: Right click on the Chyron Prime executable shortcut and select more 
options, then Properties​

​
​

 

 

​
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●​ Navigate to the Compatibility tab 
●​ Under Settings, turn on Run this program as an administrator 
●​ On the bottom right - Select Apply and then OK to exit​

 

​
 

​
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If Prime is not launched with administrative privileges, the following functionality will not work as 
a result: 

●​ Out-of-process JScript/VBScript execution will not have access to the Prime API and 
may fail. 

●​ Advanced Keyboard will not receive key presses for LED Keys.​
 

​
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non-NVIDIA Warning 

Chyron Prime only supports NVIDIA based graphics cards and is required to run as intended.​
​
On Startup, Prime will automatically detect if a NVIDIA Graphic Card is running Prime.​
If it detects this is not the case, PRIME will display a warning message similar to this along with 
the following three options.​
​

​
 

●​ Abort - Exits the Chyron Prime Application​
 

●​ Retry - Forces Prime to run on NVIDIA GPU by applying program settings within the 
NVIDIA Control Panel. 

○​ If Retry fails to apply the settings, the following message will display:​
Failed to apply NVIDIA settings. Please check that NVIDIA GPU and drivers are 
installed. The application will now close.​
 

●​ Ignore - Runs Prime on the currently detected non-NVIDIA based graphics card.​
This is not recommended and could cause Prime to run incorrectly. 

 

​
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Migrate Settings 

Prime 5.0 has a new default settings folder location. Due to this, If previous Prime 3 or 4 
settings are detected, Prime will ask if the user would like to migrate those settings.  

 
Prime settings new default location can be found in I:\Prime\Settings​
​
If a user does not have an I: drive present on the system, Prime will default back to 
C:\Prime\Settings​
​
I:\Prime\Settings includes the following: 

●​ Playout Configurations 

●​ Layouts 

●​ Shortcuts 

●​ Settings Files 

○​ ApplicationSettings 

○​ EditorSettings 

○​ PluginSettings 

 

 

​
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If you choose Do Not Migrate, the previous settings from Prime 3 or 4 will not be used and the 
software will ask you to create a new Prime Root Folder and Project Name.​
 

 

Prime Root Folder - User defined Root Folder location in which Prime will save and attempt to 
open all New and Existing Projects from​
​
Create New Project - Name of the New Project you would like to create​
​
Default Prime 5.0 Folder Locations unless redefined by the user:​
Root Settings Folder - I:\Prime\Settings​
Root Projects Folder - I:\Prime\Projects​
Common Folder - I:\Prime\Projects\Common  

​
​
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Select Language​

 

Please select your Language of choice.​
​
Once in the Prime software, if you should need to change your language selection, please 
navigate to Playout Mode > Config > Settings > Language. Please see the Language section of 
this document for more details.​

 

​
​
20 | PRIME 5.3 User Guide  



 

Startup Configuration

 

●​ PRIME provides a selection of pre-configured playout configurations, with a default of 8 
predefined buttons on the startup page. 

●​ The configuration files are stored in a subfolder of the user's “Config->Settings->Root 
Settings Directory.” 

●​ Users can define their own configurations by modifying the Playout Configuration and 
saving it, which automatically adds a button to the Startup Selection screen. 

●​ To delete a configuration button, you can right-click the button or remove the 
corresponding configuration file from the directory. 

Options 

●​ Prompt On Startup: Enables the setting to prompt for a Playout Configuration, 
displaying the Startup Configuration screen each time PRIME starts. This can be toggled 
by navigating to Prime Playout Configuration -> Config -> Settings -> General. 

●​ Start in Automation Mode: Starts Prime in a minimal 'Playout Only' state, designed to 
be operated solely by an Automation System. This setting is enabled/disabled via Prime 
Playout Configuration -> Config -> Settings -> General. 

 

​
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Prime Playout | Automation Mode 
Starts Prime in a minimal Playout Mode intended for operation by supported Automation 
Systems. The Playout user interface is restricted, making only the Automation Monitor, Workflow 
Logger, and Parameters Panels accessible; Output Channel Controls with Proxy and Control 
Panels are not available. 
 
The Prime Scene Designer is unavailable in this mode. 

​
​
If Start In Automation Mode is checked and greyed out in both the Startup Configuration / 
Prime Settings, this indicates you are only licensed to run PRIME in Automation Mode. 

 

 

​
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Prime Playout | Runtime User Interface 
The main Runtime User Interface in PRIME is used for playout.  PRIME can be configured for 
both a fully functional preview and program.  Both the preview and program allow for proxies.​
​

.  

​
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Channel Proxy Visibility 

 

​
Enable and disable visibility of: 

●​ Control Panel 
●​ Proxy Output 
●​ Audio Meters  

For each configured Channel (Preview & Program)  

Playing the preview to air, regardless of its state, will default it back to its default state to ensure 
proper operation. 

During Scene Design, each scene is assigned an output channel which may be any negative or 
positive value.  The channel number determines the compositing output order.  Each channel 
may only have a single scene assigned to it.  If a scene on output is occupying Channel 1 and a 
preview scene assigned to Channel 1 is played to air, it will “Effect out” the current scene on 
Channel 1.  Additionally, multiple scenes from preview may be moved to output in a single take. 

​
​
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In the image below, there are 3 scenes loaded into preview.  Each scene is in a different layer: 
Layer 1, Layer 2 and Layer 3. 

 

Users may choose to take all three scenes to air as a composite or select scenes individually. 

 

For example, here all three scenes have been taken to air while another scene is loaded into 
layer 1. 

 

​
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If the scene that is now loaded into layer 1 is sent from preview to air, it will bump off the existing 
scene on output that was assigned layer 1. 

 

Preview Load Behavior options allows for Multiple Scenes, Single Scene Per Layer or Single 
Scene only.  

Output Layer assignments are properties of the scene.  

 

 

​
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Preview Scenes 

Output channels can have “Previews”. Multiple scenes can be loaded into a preview channel. ​
​
Multiple scenes can be played to air simultaneously. Scenes can be fully previewed in the 
preview channel. No matter what the state is of the scene in the preview channel the scene will 
revert to the “Default” state when played to air. In the example below two scenes are loaded into 
preview. One scene is in layer 5 and the other scene is in layer 1.​
​

 

​
 

​
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Play and Play All​
These two scenes can be played to air individually or as a group.  

​
​
​
Clear and Clear All​
They can be cleared individually or all.​
​
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Preview / Program Display Options 

For each configured Preview and Program channel you can choose to hide or show a proxy 
output, control panel and audio meters. Use the drop down arrow in the proxy windows upper 
right hand corner to check or uncheck desired selection 

Control Panel Visible: 

 

​
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Control Panel / Replaceable Panel Toggle 

To toggle between a control panel (this requires a control panel resource has been added the 
loaded scene, and applicable control panel objects), and replaceables panel (required 
replaceable objects added to the parent scene) then click on the control panel / Replaceable 
toggle icon in the bottom right of the control panel region. 

 

Control panels allow for more complex and custom designs.  

A replaceable panel is more limited and restrictive than a control panel. Replaceable panel 
support:  

●​ Order: Enable / Disable II (Intelligent Interface for W commands) 
●​ EX: Enable / Disable External Updates  
●​ Databound: Enable / Disable 
●​ ID: Read only. Updates to this alphanumeric value must be made to the scene in Prime 

designers replaceables.  
●​ Description: Read only. Updates to this alphanumeric value must be made to the scene 

in Prime designers replaceables. 
●​ Value: This is an editable field. For a value update to take effect, click enter.   

ID, Description and Value columns can be rearranged, by dragging on the column 
header.  

The selection of either control panel or replaceable panel will hold true for each individual 
preview/program channel.   

 

 

​
​
30 | PRIME 5.3 User Guide  



 

Previewing Animations and Save Options 

The dropdown in the lower right-hand corner allows for the following 

 

●​ Preview Active Only: When enabled, only the selected scene will show in the Preview. 
Otherwise, the preview will be a composite of all loaded scenes. 

●​ Preview Animations: With this option enabled you can preview any animations that will 
occur within the scene. With this option disabled all animations will cut to the final 
keyframe and show the last state.  
 

●​ Save Message: This option will save the scene as a “Template Data Message” and 
show up in the “Messages” browser. Refer to the section on Messages. 
 

●​ Save Message As: Same as “Save Message” but prompts the user for a message 
name 

 
●​ Save Message Range As: This option is primarily intended to be used with II & EX 

commands workflow. An individual message range can be saved to span over multiple 
message numbers. For example 100-199. If an II command is received for any message 
between 0-99 then a message will load with the settings applied from the message 
range. This elevates saving out 99 separate messages. Message Range will save in 
Messages folder 100-199.pbm  
 

     
 
If a II/EX is received,  and an individual message exists between a message range, then 
the individual message will load, not the message range message.  

​
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After a Message or Message Range is saved, a visual indicator will appear in the 
Playout Channel’s Toolstrip for five seconds and then go back to normal.​

​

​
​
Users can also log saved messages by enabling the Message Save option within the 
Workflow Logger. Please see the Logging Settings of this guide to enable this option.​
 

●​ Save Output Image: Saves the proxy image to file. The file location is in a sub folder of 
the projects “Image” folder named “Captures”. Ex: 
I:\PRIME\Projects\News\Images\Captures. 

●​ Save Output Image As: Save As dialog prompts the user to save the image file type, 
location, and region of interest. Currently supported formats are .tif, .jpg and .png​
Region of interest must be predefined within the scene properties in Prime Scene 
Designer prior to saving out the image in Designer or Playout. 

●​ Save Output Clip: Saves the proxy scene as a clip file. The file location is in a sub 
folder of the project's “Clips” folder named “Captures”. Ex: 
I:\PRIME\Projects\News\Captures. Save output clip, will adhere to the last clip resolution 
set with Save Output clip as.  

 

​
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●​ Save Output Clip As: Save As dialog prompts the user to save the clip file name, output 
type, location and region of interest (cropped clip render). Currently supported formats 
are Quicktime Animation GTC, Motion JPEG, DNxHD, DNxHR, Web M.​
Region of interest must be predefined within the scene properties in Prime Scene 
Designer prior to saving out the image in Designer or Playout. 

Rendered clips using “Save Output Clip” will only honor the Effect In. If an action within 
the scene is triggered within the Effect In, this will be honored in the render. The Effect 
Out will not be rendered, unless it is triggered by the Effect In.   

​
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Scenes vs Messages 

Scenes: 

Scenes are saved to the file system as .pbx files and comprise of all the elements of a scene. 
Scenes are defined as “Templates” or “Base Messages”. 

Messages: 

Messages are a subset of scenes and are much smaller in size that contain a reference to the 
parent Scene file. Messages use the .pbm file extension. Messages are defined as “Template 
Data Messages”, “Automation files. See the separate section “Messages” for detailed 
information on creating and editing scene Messages. 

Scenes and Messages can have their own independent browsers.  

In the Messages browser, if you hover over the thumbnail you will get various metadata 
including the parent scene name.  

 

 

​
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Projects 
Creating a New Project 

To create a new project: 

●​ From the Main User Interface, select File from the top menu 
bar. 

●​ Then select New Project to create a new PRIME project. 

OR​  

●​ Click the Project icon on the top left-hand size of the Main 
User Interface, 

●​ From the drop-down menu, select New to create a new 
PRIME project. 

​
​
​
 

 

Hard Drive / Network Drive Best Practices and 
Recommendations​

​

PRIME supports mapped network drives for Prime Projects, however PRIME does NOT support 
search capabilities for projects over a network due to the Microsoft Search API. 

It is highly recommended to use a local high speed drive for Prime and Prime Engine.​
An NVME, high speed RAID, or SSD based hard drive provides the best performance 
capabilities for real time playback. 

Using a network based drive has its pros and cons. Network drives are great for centralizing 
storage; however, depending on its network I/O bandwidth capability, it can greatly hinder Prime 
and Prime Engine’s real time performance. 

 

​
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Opening a Pre-Existing Project 

To open a preexisting project: 

●​ From the Main User Interface, select File from the top 
menu bar. 

●​ Then select Open Project to open a new PRIME 
project. 

OR 

●​ Click the Project icon on the top left hand size of the 
Main User Interface,​
 

●​ Select Open to open a preexisting project. 

●​ The Select Project panel will be displayed.​
From here, the user may navigate to the preexisting 
project and open it. 

 

When saving scenes, if PRIME sees assets from folders outside the project PRIME, PRIME will 
prompt users to import the asset. 

​
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​
Removing a Project 

●​ From the Designer User Interface, click the “Project” 
icon from the top menu bar.​
 

●​ Then select Remove Project to Remove PRIME 
project. This will NOT delete the project. 
 
 

Deleting a Preexisting Project 

●​ Select Delete Project to Delete PRIME project and all the files associated with it.  

Editing a Pre Existing Project 

●​ From the Designer User Interface, click the menu File > Edit Current Project 
●​ This allows you to edit the Project Description, Project Parameters, Expressions, 

Conditions and C# code. 

 

 

 

​
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Layouts 
PRIME uses Windows docking panes which allows users to add/remove/position and size all of 
the available window panes. Layouts can be saved and loaded. 

 

 

 

 

 

 

 

There is also a quick layout loader on the left top of the main Runtime user interface: 

 

 

 

In the Prime settings dialog, there is a setting to automatically save the changes that are made 
to the layout.  This setting is available in both the main application form and the designer form.  
This is not a global setting.  If the “Auto Save Layout” checkbox is checked in the main 
application form, there is no guarantee it will be checked in the designer form and vice versa. 

​
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​
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This layout shows 2 graphic channels with previews, 4 clip players and a playlist 

 

This layout shows 6 clip players and a take list

 

​
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Tools 
Application Scripting 

Application scripts run the entire time the application is open as opposed to Scene Scripting 
which only runs while that scene is open. The scripting window language is C# and has access 
to the entire PRIME API. Refer to the separate document “API Scripting Guide”. 

  

Zip & Unzipping Assets 

Prime offers a built in Asset Viewer to view assets per scene or per project. Select column 
heading (File, Type, Size Modified, Parent) to sort assets by ascending or descending order. 

 

Additionally, users can zip or unzip these assets using the built in Zip/Unzip tool. 

​
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Prime Playout Settings  
The various configuration settings determine the behavior and appearance of PRIME.​
​
To access - In the top menu bar, select Config and select the desired item to configure: 

●​ Playout Configuration 
●​ Automation 
●​ Devices 
●​ Keyboard Shortcuts 
●​ Settings 
●​ Import Configs 
●​ Export Configs 

 

Settings Configuration  

Selecting Settings from the Config drop down menu allows the user to change various aspects 
of PRIME. 

 

​
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General 
Theme 
ChyronDark - Sets Prime’s UI/UX to Dark theme ​
Standard - Sets Prime’s UI/UX to Light theme ​
 
General 
Prompt Before Closing – If checked, PRIME will confirm with the user whether or not PRIME is 
to be closed.​
 
Prompt Administrator Warning on Startup – To run out of process VB,JScripts Prime needs 
to be started with Administrator privileges. 
 
Prompt for Playout Configuration – Shows the Prime Startup Configuration Screen pop up 
upon startup of Prime. Turning this off will Startup Prime in the last chosen Configuration. 
 
Start Minimized – Starts Prime in a minimized state within the Windows Environment 
 
Start in Automation Mode - Starts Prime in a minimal Playout mode which can only be 
operated by an Automation System. Prime Scene Designer is unavailable while in this mode. 
​
Status 
Show Bypass Indicator - shows the bypass indicator in the status bar of the playout window​
​
Show SDI Input Indicators - shows the SDI Input Indicators in the status bar of the playout 
window​
 

Layout 
Auto Save Layout - automatically saves the current layout when changes are made (ie the 
layout should look the same when the application is restarted)​
​
Always Show Both the Preview and Program Channel - if both the Preview and Program 
panels of a channel are not visible in the layout, and one is made visible, then the other will also 
be made visible​
 

 

​
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Import/Export Settings 
Allows users to export a series of settings into a zip file allowing users to import them on a target 
machine elsewhere. Any files in the source machines “Common” folder will be extracted to the 
target machines “Common Folder” only if a Common folder is defined on the target machine. 

 
 

 

​
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●​ Status – if the system is run in downstream mode and an external bypass panel is 
installed, the following options may be configured 

o​ Show Bypass Indicator – Show an icon on the main Runtime user interface 
toolbar   

o​ Show SDI input Indicator - Show an icon on the main Runtime user interface 
toolbar   
 

●​  Layouts - Auto Save Layout option automatically saves the changes that are made to 
the layout​
 

●​ Always Show Both the Preview and Program Channel  
○​ If setting is checked, both preview and program channel controls will be made 

visible when a channel is activated. 

○​ If setting is not checked, only the visible section of the channel will be activated 
and the user can hide either or both. 

*Enabled (checked) by Default. 

 
 

​
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Playout 
 

 
 

Numeric Keypad Entry 
 

When Numeric Keypad Entry is enabled numeric and alphanumeric values can be applied to 
the keypad entry field in the Runtime interface.  

 

Users can use Numeric Keypad playout mode for either Clips or Graphics. For Graphics the 
order of precedence will be: Scenes then Messages. Channel selectors will appear on the main 
toolbar. Shortcut keys can be assigned to select the “Active” channel. See Shortcut Key 
Manager for configured shortcut keys. 
Scenes, Messages or Clips will load to the active channel i.e whichever channel has focus.  
This means that the scene’s default Channel will not be honored if the Channel property is set in 
Designer.  See Scene Properties for more information   
 
Track Recall Per Channel - (applicable when operating PRIME with a multi channel graphics or 
clip player system). When selected, the Keypad Entry field will populate the text value of the 

​
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next numeric or alphanumeric graphic (scene, message) or clip for the selected channel. When 
unchecked, multiple channels share the same value for recall.  

Allow Recall Box Focus - When checked, operator can tab or mouse click into the recall box to 
open a scene or message. When unchecked, Recall Box is only accessible via Numpad keys. 

 
Messages 
Show Folder Selector - When this is enabled, Messages folder selection will be visible in Prime 
playout UI.  

 

Click on Messages Icon to add or remove messages folders.  

​  
​
​
​
Numeric keypad entry will apply to the selected message folder. Select from drop down to 
change selected folder. 

 

 

 

​
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Preview Load Behavior 

 

Multiple Scenes: Infinite number of scenes/messages can be loaded in preview regardless of 
layer assignment.  

Single Scene Per Layer: Only one scene per layer can be loaded per preview channel. A scene 
with the same layer assignment will displace the other.  

Single Scene Only: Only one can be loaded in preview regardless of layer assignment.​
​
Skip Preview In for Program - When checked, Preview in Event animations state will be 
skipped on Program Channel. This results in consistent effect in behavior in case where scene 
is played directly to Program Channel. 

Example use case: In Preview in Event a clip is set to cue frame 30, at its revealed state. But 
when the same scene is played to air, the clip should play from frame zero.  

 

 

​
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Control Panel 

​
​
Enabled 
Enables and Disables the Control Panels / Replaceables Panel in Playout​
​
When unchecked (Disabled), Playout will deactivate the Control Panel option​
​

 

​
Text Box Entry 
Specifies when changes to control panel text boxes should be applied to an output.​
 

Preview and Program Update allow for the following options:​
On Key Press - immediately when a key is pressed​
On Enter Key/On Lost Focus - only when Enter is pressed, or the control loses focus 

 

​
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Appearance 

 

Browser: Allows users to customize the appearance of all browsers in the PRIME application 

Highlight: Allows users to customize the appearance of the active channels and active Preview 
or Program 

​
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Folders  

 

*Each folder’s file path has a shortcut button to quickly set the desired folder location.​
​
Common Folder – ChyronHego suggests the use of a “Common” folder.  This stops the need 
for assets to be stored multiple times in multiple directories.   

Root Project Folder- Define the root folder for all your projects. 

Root Settings Folder - Defines the folder location of all the configurations, layouts etc.​
This is tied to the startup screen. 

CAMIO Folder - This folder location will contain all the Project folders. These Project folders 
contain their associated  assets (MOS Messages, CRD files and replaceable assets). 

The PRIME messages in the “Message” folder can be called up in PRIME playout. 

​
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******* IMPORTANT ******************************************* 

The CAMIO Context MUST match the PROJECT Name. 

Example: Context: News 5PM   PRIME Project: News 5PM 

******************************************************************* 

 

  

 

 

​
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Startup Scenes 

Scenes can be set to load or play when the PRIME application starts.    

 

​
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Clips 

 

 

​
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Read Clip Metadata from file Name Tags: 
PRIME has the ability to add metadata to the associated clip metadata file when the clip is 
imported using the “Folder Watcher” application.​
​
The metadata is part of the command line.​
​
When clip files are imported into Prime (ie, when .ppc files are generated when a new clip file is 
placed into the Clips folder of a project), and this option is enabled, then the file name will be 
parsed for these metadata tags.​
If found, the metadata values will be set in the .ppc automatically 

 

 

Generate Unique Clip Name: 

​
 

​
​
56 | PRIME 5.3 User Guide  



 

Clip File Name Tag​

 

​
Quality Control 

 

The Quality Control settings allow the user to define Quality Control states.”  These allow 
users to see the state of scenes.  This comes into play in the distribution of scenes and their 
associated assets.  See Asset Viewer also. 

​
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To view Quality Control states, select Details View from the Scene Browser.  This allows the 
Quality Control field to appear in the scene list.  From there, a state may be set as defined in 
the Quality Control Settings section. 

 

 

​
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Language 

 

Language Settings allow the user to select from the available list of languages.  Once a 
language is selected, the PRIME User Interface will switch languages. 

 

Not all language translations are guaranteed to be accurate 

 
 

 

​
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Logging 

Logging Settings enable the user to configure logging for the main PRIME application. 

 

Beginning in 5.0, the Default locations for Prime Logs will be the following​
​
Prime Logs Location:​
C:\ProgramData\Chyron\Prime\Logs​
​
Workflow Logger Log Location:​
C:\ProgramData\Chyron\Prime\Logs\Workflow  

​
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The Workflow Logger will log specific events in the application 

The workflow logging is useful for viewing the order of events that happen with a scene or scenes. The 

workflow log window can be viewed from the main Runtime user interface. 

You can select which events will be logged in the Workflow Monitor. 

 

Only check the Auto create dump file checkbox when asked to do so by ChyronHego service. 

The Scene Logger 

Scenes have a logger built into them. Clicking the log bar will show the current Scene Logger: 

 

​
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​
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BXF 

See the section that explains the BXF object as a scene resource 

 

 

​
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Chyron LIVE Uploader 

See the section that explains LIVE Uploader so users can Upload their graphics from Prime to 
Chyron LIVE.​
​

​
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CAMIO 

Apply your CAMIO Server settings here. 

 

 

 

​
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FileSync 

FileSync, previously known as Chyron Hub Drive, allows users to remotely sync PRIME 
Projects, files, and folders. 

 

 

​
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Scripting 

 

These settings allow Prime to function in Sandbox mode when unchecked. In addition it allows 
users to preview animations, without running/executing scripts. If a scene is loaded that utilizes 
a script, and Prime script settings is disabled, then Prime will log warning that the script can not 
compile and execute.   

Hardware/Playout Configuration 

Refer to the separate PRIME_Playout Configuration Guide 

Subchannels 

Subchannels are smaller defined areas of a larger output channel. Each subchannel is defined 
by its resolution and its “X” and “Y” position within the larger output channel. 

Each subchannel can have its own preview and output in the main Runtime user interface. 

You can have independent scene browsers for each subchannel that only shows scenes with 
the exact same resolution as the subchannel itself to ensure only scenes designed for that 
resolution can be played. 

Replaceables-Automation ID’s 

Object properties that can be “Replaced” by automation are added to this list. A Node in the 
Scene tree “Resources” section will display the “Replaceables Automation ID Editor”.  Objects 
​
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are required to be exposed in the Replaceable Editor for Update In/Out to execute; including for 
manual playback. Add items here 

 

Configuration 

Automation Configuration is documented in the 

 “PRIME Automation Guide.” 

Preparing the Scene for Automation (The 
Replaceables-Automation List) 

Commands that update scene objects can be 
connected in the following manner: 

●​ By the scene Object name 
●​ By the Control Panel name 
●​ By the ID name from the automation list 

 

 

Scene Object Name: The name of the object from the Scene Tree 

 

Control Panel Name: The name of the control Panel from the Control Panel section of the 
Scene Tree 

 

Replaceables-Automation List: The name of the ID from the Automation ID Editor 

​
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o​ Id: This is the ID automation will use to identify this item. 
o​ Description: This is a user-friendly description and is also used in the NRS 

Plugin (LUCI) as the label for the replaceable item. 
o​ Bindings: Object(s) Properties bound  
o​ Order: Used by legacy commands that expect the data in the order they are 

given in the command. The “W” command is a good example: W\100\200\A\B\C\\ 
o​ Auto Erase: Should the default value of this property be erased when viewed or 

loaded. 
o​ External Update: When checked, the replaceable is marked to send and receive 

X and R commands respectively.  Each replaceable is identified by is Bindings 
descriptor.  Referencing the picture above a X command would be sent as 
follows 

 X\1\****\Locator L3\Name.Text\Title.Text\Logo.File\\ 

​ ​ The automation system would respond with an R Command  

​ ​ ​ ​ R\1\Melville, NY\Joe Smith\Smith_Joe.jpg 

See the Prime Automation Guide for more.   

o​ Character Limit: Enforce a maximum number of characters when applying data 
supplied to this replaceable. For example, with a character limit of 5 a 
replaceable that received the value "ChyronHego" would only be updated with 
the truncated value “Chyro" 

To enter items into the Automation List, drag any property or keyframe into the list. Each item in 
the list can be bound to multiple properties. 

 

 

To get a keyframe into the list drag the keyframe from the Keyframe property window NOT the 
keyframe from within the Timeline. 

​
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In this example, there are two properties bound to ID# 1 

 

 

Note: Some scenes may contain Objects and Replaceable IDs that share the same name and 
are completely unrelated.  In this case, the Object name will take precedent when a P/UPDATE 
command is received. 

​
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Devices Configuration  

The Devices Settings panel provides the ability to add and edit an external device, as well as 
display a log of device activity once the connection is live.  PRIME allows for either a GPI or 
X-keys device to be used. 

 

The following parameters are displayed in the Device Settings panel: 

●​ Type - Displays a GPI or X-Keys symbol as the type of device. 
●​ Name - The name given to the device. 
●​ Enable on Startup - If enabled, then the device will be enabled every time that PRIME 

is started. 
●​ Status - Displays Enabled, Disabled or Waiting for Connection as the current status 

of the device. 

To configure the Automation Log: 

●​ Select the Automation Log drop-down menu to either Copy or Save the log. 
●​ Enable Show Data to show the data from the Automation Log. 
●​ Select Clear Log to clear the displayed data from the Automation Log. 
●​ Each log item will display the time of event, the connection in use and a message.  

​
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To edit a device setting, do one of the following: 

●​ Click the item in the Devices list, and then click the Edit icon.  The Device panel for the 
item will open. 

●​ Double-click the item in the Devices list.  The Device panel for the item will open. 
●​ Right-click the item in the Devices list, and then click Edit on the drop-down menu.  The 

Device panel for the selected item will open. 

To delete a device, do one of the following: 

●​ Click on the item in the Devices list, and then click Delete icon. 
●​ Right-click the item in the Devices list, and then click Delete on the drop-down menu. 

To enable a device, do one of the following: 

●​ Click on the item in the Devices list, and then click Enable icon. 
●​ Right-click the item in the Devices list, and then click Enable on the drop-down menu. 

​
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GPI In 

Up to 16 GPI inputs may be configured in PRIME.  To add a GPI connection: 

1.​ Select the GPI icon located on the top toolbar of the Device Settings panel. 

 

●​ Enable on Startup - Check the Enable on Startup check box to automatically enable 
the GPIs upon PRIME startup. 

●​ The Board Index specifies the GPI number.  Enter the desired Board Index, using the 
spin box. 

●​ Bounce specifies the minimum amount of time, in milliseconds, between triggers.  This 
prevents accidental triggering due to unintended multiple button pushes, which could be 
caused, for example, by a dirty switch.  The default Bounce setting is 10 ms.  To change 
the setting, enter a new setting or select using the spin box.      

To configure GPI Pins: 

1.​ Select the desired pin to be configured by clicking the corresponding box.  Note that the 
Selected Pin (0) group box label will reflect the number of the selected pin.  Pins are 
numbered from left to right as follows: 

●​ 0 through 7 in the top row 
●​ 8 through 15 in the bottom row 

​
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2.​ An action can be executed on both the Rise, i.e., 
when the GPI button is pressed, and the Fall, i.e., 
when the GPI button is released.   To set Rise and/or 
Fall actions: 

a.​ Check/uncheck the Rise and/or Fall 
checkboxes to enable or disable GPI execution 
when the button is pressed (Rise) and/or 
released (Fall). 

b.​ From the Execute drop-down, select an action 
to execute when the button is pressed (Rise) 
and/or released (Fall).  The available actions 
are as follows: Clear Channel, Select 
Channel, Cue Clip, Pause Clip, Play Clip, 
Stop Clip, Jog Clip (Fast Forward), Jog Clip 
(Rewind), Load Playlist, Play Playlist, Stop 
Playlist. 

c.​ From the Channel drop-down, select the 
Channel and Layer to which the action should 
apply when the button is pressed (Rise) and/or 
released (Fall). 

Depending upon the action that is selected from the Execute drop-down, additional 
information may be requested.  In the previous figure, Play Playlist is selected as the 
action to be executed when the GPI button is released.  The Select Playlist enable 
check box and Select Playlist drop-down are also displayed, in addition to the Channel 
enable check box and Channel/Layer selection drop-down.  

To clear all pins: 

●​ Select Clear Pins located on the top of the GPI configuration dialog.   

For GPI Out see “GPI Out” in the “Resources” section! 

 

 

​
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X-Keys 

X-keys® are a programmable keyboard that can be customized.  To add an X-keys connection: 

●​ Select the X-Keys icon located on the top toolbar of the Device Settings panel. 

 

●​ Select the corresponding X-keys model to be configured using the dropdown menu 
located next to Device Layout label.  Once selected, the X-keys model name will be 
displayed. 

o​ X-keys can be purchased through the X-keys website:  http://xkeys.com/ 

●​ The white boxes represent the buttons in the X-keys layout.  Click a box that is to be 
assigned a function to be executed.  The box will become highlighted. 

●​ Using the drop-down located in the Selected Key group box, select the desired function 
to be assigned to the highlighted key.   

o​ If a function regarding a Clip or Playlist is chosen (Ex: “Cue Clip” or “Load 
Playlist”), then option to specify a Clip or Playlist as well as the Channel will 
appear.  ​
​

                 ​
 

●​ Click Accept Changes to finalize your selection. 

To clear all X-keys configurations: 

●​ Click the Clear Keys button located on the top toolbar. 

 

 

​
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Import and Export Configs 

PRIME Playout > Config​
Import Configs​
Export Configs​
​

​
 

Prime export’s configuration files as a single zip file. By default will include: Settings, PSK, DSK, 
Auto, WXPL, Config and WXEL configuration files. User can deselect items as desired.  ​
This method is ideal for replicating on additional prime devices, performing backups, and 
providing Chyron Customer Success the necessary config files for assistance. ​
​

 

​
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Import Process 

●​ Select Import Configs 
●​ Choose a PRIME exported configuration zip file 
●​ Choose all or desired config files to import 
●​ Click Import Selected 
●​ Restart PRIME for new configuration files to take effect​

​

​
 

Export Process 

●​ Select Export Configs 
●​ Choose all or certain configuration files to export 

​
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●​ Click Export Selected and save zip file​
​

​
​
 

 

​
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Playlists 
Configure Playlists 

Use the “Playout Configuration” dialog to add playlists. 

 

 

Playlists are lists of items that can easily be played to air. Playlists can play Scenes, Images and 
clips all from the same list. You can have many playlists open and playing simultaneously. 

There are two modes for the Playlist selectable in each individual Playlist: 

o​ Take List 
o​ Sequence 

 

Takelist 

Allows scenes, messages, clips and images to be arranged in order to be played out manually.  
Each item is Loaded, Played, and Cleared using Enter or Spacebar keys. Items can be cleared 
using Escape key. The Takelist also includes an Auto Advance option that causes the next item 
to be automatically loaded and selected when the current item is played. Items can be selected 
by ID number using the Numpad + Enter. 

​
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Sequence 

In Sequence mode, the Playlist will operate as a Sequencer. Items can have pauses and be run 
in a linear fashion sequentially. You can add Graphic scenes, Images and clips to the 
sequencer. Each item can have a pause associated with it. 

There is a Sequence Loop toolbar selection.​
​
Allows scenes, messages, clips and images to be arranged in order to be played out 
sequentially. Clicking Play or pressing Enter or Spacebar on the sequence will start at the first 
item or the selected item and play each item according to the Duration set on each item. If an 
item does not have Duration enabled, then the sequence will wait for manual input to advance.  
The sequence can be set to pause for user input on an item by enabling the Trigger item.   

To add items to the Take List, drag and drop any item from its browser to the playlist. 

 

Disable - Disables the item from the Takelist and Sequence.  Disabled items will be skipped 

Trigger - Causes the sequence to be paused on this item, and waits for trigger to resume (Enter 
or Spacebar). Trigger is only applicable in Sequence mode. 

Duration - Sets a duration for the item to be played.  Sequence is only applicable in Sequence 
mode. 

ID – The ID is the number that is used to play the item to air from the keyboard. If the scene, 
image or clip does not have a “Message ID” associated with it the playlist will assign the next 
available ID. Scene and Clip “Message ID’s” are assigned from the Scene property editor. 

 

​
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Pressing 555 and hitting the Enter key will load the NASCAR clip from the playlist.

 

Expanding the item by clicking on the Right error next to the ID will expand the item to show any 
Control Panel items for this Scene. From this view, you can trigger buttons or do text, image and 
clip overrides. 

 

 

​
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Image overrides will show the Image Browser: 

 

Click on the link to show the Image Browser: 

 

 

​
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Name: The name field identifies the name of the item. The item can be a clip, Image or scene. 

Layer: The layer a scene is played to air can be modified in this field: 

 

The layer field is NOT accessible for clips. 

 

​
​
83 | PRIME 5.3 User Guide  



 

Status: Shows the status for clips 

 

Show the status for graphics: The status bar will show the duration of the effect In, then pause 
until the effect out is played: 

Here two graphics are on air. 

 

Now the second graphic, the live bug has been played off: 

To set a new appearance for the playlist click the dropdown in the upper right-hand corner 

 

 

 

 

​
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Channel Assignment: 

 

​
Playlist as a Still Store 

Simply drag images from the browser into the playlist… 

 

 

​
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Playlist Transitions 

The transition column is only active for clips or images, not scenes. It allows you to browse to 
clip transition files (.pct).​
​
Transition – The transition column is only active for clips or images, not scenes. It allows you to 
browse to clip transition files (.pct). When a Playlist ID is played, the selected Transition will play. 

​
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Shortcut Key Editor 
The Shortcut Key Editor allows the user to configure which shortcut keys correspond to which 
action defined in the “Description” column. Prime employs two Shortcut Key Editors. One for 
Playout and one for the Designer.  

 

Shortcut keys are assigned by selecting the shortcut and pressing the keyboard key(s) you wish 
to have assigned to that currently selected shortcut. For each Shortcut Key Editor, assigned 
Shortcut keys can be saved and loaded. Playout shortcuts are saved with a .psk file extension 
and Designer shortcut keys are saved as a .dsk file extension. 

 

Playout Shortcut Keys: 

Shortcut key categories: 

1.)​ Component - these target PRIME Components more generally eg Play Preview 
2.)​ Global - target PRIME Components more specifically eg Play Preview 1 

3.)​ Scripts - these target Application Scripts (Tools > Application Scripting) 

Compound Shortcuts - Multiple shortcuts can be set to a single shortcut key combination, 
which, when triggered execute all assigned functions simultaneously. 

Keyboard shortcuts can be executed at anytime regardless of the focused window in the 
application. 

Reset to Defaults 

Preassigned Keyboard shortcuts can be loaded via the Reset to Defaults dropdown 

Standard Keyboard  - PC keyboard based PRIME default 
shortcut keys 

​
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Classic Keyboard - These shortcuts are designed to be used with the Chyron Classic 
Keyboard. Shortcuts are familiar to Lyric users. Additional documentation located in the  

Chyron Classic Keyboard User Guide 

Blank  - no assigned shortcuts 

Default shortcut key files cannot be overwritten however they can be loaded, customised and 
saved to a file. 

 

Erase vs Clear Shortcuts 

Erase and Clear shortcuts exist at both Global and Component levels.  There are options to 
affect either a single scene or the entire output.   

Erase: Cuts a scene(s) from Preview or Program without playing the Effect Out event.  

Clear:  Removes a scene(s) from Program by playing the Effect Out event.  Clear shortcuts are 
not available for Preview outputs.  

The Keyboard Shortcuts are a growing list and can be different than currently documented. 

​
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Component 
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Global 

 

 

 

 

 

​
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Designer Shortcut Keys 

 

To set the “Keys” field back to “None”, right click and select “Clear Selected” 

​
Left click and select a Key text, then right click on the key text for unicode options 

 

​
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The keyboard arrow keys functions as follows when the scene tree or scene object in the 
canvas is selected: 

●​ Arrow Keys will change value by 1 unit in the direction of the arrow 
●​ Shift + Arrow Keys will change value by 10 units in the direction of the arrow 
●​ Ctrl + Arrow Keys will change value by .1 units in the direction of the arrow 

The Transform Spinner controls will work as follows: 

●​ Right click drag or mouse wheel will change the value by 1 unit 
●​ Shift + Right click drag or mouse wheel will change the value by 10 units 
●​ Control + Right click drag or mouse wheel will change the value by .1 unit 

To set the “Keys” field back to “None”, right click and select “Clear Selected” 

 

 

 

​
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Master Control Panels 
Master Control Panels are panels users create that, unlike scene control panels, are not tied to 
any specific scene. Controls and Resources can be either hooked up in the user interface or 
execute Java Script code for more sophisticated control.​
​
To Create - Select File > New Master Control Panel (Ctrl + M)​
​
Click and/or drag Controls or Resources from the “Toolbox” to the Master Control Panel Canvas. 

 

 

Beginning in Prime 5.0, some Advanced options have now been exposed within the base 
properties of certain Controls  

​
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Bind a Button using the “Properties panel” of the control.​
​
In this example, the button is bound to a Condition. 

 

You can continue to bind as many commands to the button as needed. 

Bindings can be made similar to Control Panels.​
Please navigate to the Scene Control Panel section of this User Guide for more details.​

​
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​

​
​
​
Load a Scene - To load a scene, add a Property item to a Condition and type a line such as: 
Playout.Channels(0).LoadScene("123").  This would load scene 123 on the first channel​
​
Play a Scene - To play a scene, add a Property item to a Condition and type a line such as: 
Playout.GetChannel("Program").PlayScene("123").  This would play scene 123 on a channel 
named Program​
​
Stop a Scene - To stop a scene, add a Property item to a Condition and type a line such as: 
Playout.ActiveChannel.StopScene("123").  This would stop scene 123 on the active channel​
​
Close a Scene - To close a scene, add a Property item to a Condition and type a line such as: 
Playout.GetChannel("Program").CloseScene("123").  This would close scene 123 on a channel 
named Program​
​
Active Channel - To access the active channel use the ActiveChannel property of the Playout 
object.​
​
For example:​
Playout.ActiveChannel.LoadScene("123") would load scene "123" on the active channel  

Get Channel - To access a channel by name or by number, use the GetChannel method of the 
Playout object.​
​
For example:​
Playout.GetChannel("Program").LoadScene("123") would load scene "123" on the channel 
named "Program". 

Playout.GetChannel(1).LoadScene("123") would load scene "123" on the first channel 

 

​
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Playout Help 

​
​
Show Current Log 
Opens the current log​
​
Open Log Folder 

 

All PRIME log files will be located in this folder 

​
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License Updater 
Launches the ChyronHego License Updater 

​
Documents Folder 
Opens the offline PRIME Documents folder installed with your version 

​
User Guide 
Opens this User Guide 
 

gRPC Documentation 
Opens a local file within Chrome to the new gRPC API Definitions. 

Each time you relaunch Prime, the gRPC Prime API Documentation will take 6 seconds or so to 
launch the first time.​
​
For more information regarding gRPC, please see the PRIME Automation User Guide.​
​

​
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License Agreement 
Opens the ChyronHego Software License Agreement 

 

About 
Displays the PRIME CG and Prime Engine versions currently running​
​

 

 

 

​
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Prime Scene Designer 
Scene Designer is the primary design application designers will use to create 2D and 3D 
graphics available in Prime Playout Mode. 

​
​
Prime Title Bar​

 

Application Menus 

●​ File 
●​ Edit 
●​ View 
●​ Window 
●​ Tools 
●​ Config 
●​ Help 

 

​
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Version Identifier 

○​ The Chyron Prime version currently being ran 
○​ Chyron Prime Engine version currently installed and being ran 
○​ File Name the canvas is currently focused on​

 

Release Notifications​
 

When a New Release is available, the Notifications Icon will display a Green Circle.​
Click on the Release Notifications Icon to display the latest available versions.​
 

○​ Latest Bug Fix Version:​
latest bugfix build based on the 
version currently running​
 

○​ Latest Prime Version:​
shows the latest Minor version 
available based on the Major Version 
you are running​
 

○​ Newest Prime Version:​
Newest Major Version Available​
(Users may need to purchase New Licensing in order to download and run this version)​
 

○​ Download Area - Links directly to the main Download Area​
​
*If no updates are available, only the Download Area link will be present 

​
Clicking on any one of the release notifications will open up your Windows default 
internet browser and link you directly to that release in the Chyron Download Area. 

The Chyron Download Area, also known as the Chyron DA, allows users to download 
the Chyron Products they are licensed for, read through the latest release notes, 
download Qualified NVIDIA drivers, as well as download additional files.​
​ ​  

 

​
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Prime Projects​

 

The creating and opening of Projects is covered at the beginning of this guide.​
 

Designer Tabs 

Quickly and easily navigate between multiple files at once.​

 

​
To re-organize tabs, drag and drop the tabs next to each other by utilizing the drop indicator line. 
Reorganizing the tabs on the Project Bar will automatically reorder your open files within the 
Window menu.  

 

Designer Tab Shortcut Keys 

Quick access shortcut keys are available for Tabs. Please see the Designer Shortcut Keys 
section of this document to learn how to access and modify shortcut key bindings. ​
​
Ctrl + Tab will tab / cycle through Tabs from left to right​
Ctrl + Shift + Tab will tab / cycle through Tabs from right to left​
​

 

​
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Hovering your mouse over a Designer Tab will display the file path​

 

​
Live Mode 

The Designer can be output to any of the defined outputs in the Playout Configuration. 

This allows for Realtime output previews. Select from the list of outputs. The currently selected 
output is “Program”. 

 

 

​
 

Design for specific licensed options 

You can enable/disable software features to match your playout license. This gives you the 
ability to target systems that are licensed differently. 

 

The toolbar has some quick pick shortcuts based on PRIMES use case pricing model. Select 
the options you would like to enable. You can load/save these settings. 

 

​
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File Menu  

New Scene 
Create a New Scene (.pbx). Useful to have a 
base scene and its elements when new scenes 
are created.​
 

New Base Scene 
Create a new Base Scene (.pbs) to be 
referenced by normal (.pbx) scenes.​
 

New Master Control Panel 
Create a new Master Control Panel (.mcp) ​
 

New Transition 
Create a New Transition (.pbt)​
 

New Clip Transition 
Create a New Clip Transition (.pct) 
​
​
New Switcher Transition 
Create a New Switcher Transition (.pst)​
 

Application Logic 
Create and Edit Application Logic (.pal)​
See the separate “Application Logic” Section for more details.​
 

Edit Current Project 
Edits the current project in the scene editor.​
This allows for custom resource objects to be loaded when the project is selected.​
 

Open 
Open a File​
 

​
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Open Recent 
Open a Recently Opened File​
 

Save 
Save the File 

​
Save As 
Save the File as a different file name 

​
Save Image 
Captures an image of the current state of the canvas​
 

Save as CAMIO File 
.CRD files are currently generated when ‘Saving to CAMIO’ from the Prime Designer. This 
process automatically exports the file into the Chyron CAMIO Context and Folder defined by the 
CAMIO export settings in Prime. 
 
To permit users to have more control over the upload process, and to prevent on-air content 
being accidentally overwritten, users can manually upload the .crd file using CAMIO Asset 
Manager. 
 
In addition, users using the CAMIO Render Engine outside of a CAMIO environment, with the 
Chyron Media Engine API requires a .crd file in order to specify jobs to be rendered. 
 

CAMIO Upload 
Upload your scene directly to CAMIO. Please see the CAMIO 

Import FBX 
Allows for importing FBX models. Refer to the Model object. (.fbx)​
 

Import Vector 
Allows for importing .AI. PDF and .SVG files. Please refer to the Importing Vector Files and 
Polygon object sections of this guide.​
 
 

​
​
104 | PRIME 5.3 User Guide  



 

Import AE 
Allows importing of After Effects Projects when using the AE\Prime Exporter. (.json)​
Prime 5.2 introduces new AE Export / Import functionalities. Please refer to the “PRIME After 
Effects Guide” for all details. 

Edit Messages 
Shows the Edit Scene Messages window.  This allows for visualizing and editing the messages 
built off of a Scene in a table view.​
 

Close 
Closes the File you have selected/focused 

​
Close All 
Close all opened files 

Exit 
Exits the Prime Designer Application, but not Playout or Prime Engine  

​
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Importing Vector Files 

Designers can import vector files into PRIME by opening Prime Scene Designer and going to 
File > Import Vector. Unlike the direct Polygon object Vector Import method, this method allows 
designers to import all supported layers individually at once. Each supported vector layer will be 
imported into the Prime scene’s scene tree separately. Please see Vector File Compatibility 
details below.​
​
Supported File Types 

●​ .SVG 
●​ .AI 
●​ .PDF 

​
 

​
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Import Vector Dialog​

 
​
 

●​ Center Position 
○​ Centers the polygons in the scene​

 
●​ Center Pivot 

○​ Centers the pivot point for each layer​
 

●​ Group Paths 
○​ The end result will be one polygon object in the scene created from all the data in 

the vector file. 
■​ Uncheck this option if you want all supported layers to come into PRIME 

individually​
 

●​ Enabled 
○​ Select which polygons in the file you would like to import by selecting the check 

box under Enabled. If an element is not supported, the Enabled checkbox is 
disabled by default and can't be enabled.  

​
​
107 | PRIME 5.3 User Guide  



 

●​ Index 
○​ Layer # from the file​

 
●​ Name 

○​ layer name if specified within the file​
 

●​ Type 
○​ type of element​

 
●​ Fill 

○​ Displays the Color Hex value it will import. Users can edit the color value during 
import if needed.​
 

●​ Status 
○​ Can display 3 different status types 

■​ Green Check mark = Supported 
■​ Yellow Exclamation = May not import correctly as the element contains 

an unsupported attribute or effect 
■​ Red X = Unsupported Element​

 
 

​
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File > Import Vector Method Scene Tree Example:​

 

​
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Vector File Compatibility 
*Please Note - Vector Import results will vary as not all Illustrator Designs, tools, and 
functionality scenarios are compatible since this can vary greatly. If a supported object is not 
importing please try outlining, vectorizing, or expanding the object first before importing into 
PRIME.   

●​ Color Import Support 

○​ RGB color space Only. 
■​ CMYK color space is not supported and will not convert properly 

○​ Only Fill Colors are supported 
■​ Stroke, Gradient and Mesh Colors are not supported 

○​ SVG files offer the best RGB color accuracy 
○​ .AI and .PDF RGB color values may differ slightly in Prime​

 
●​ .AI and .PDF Illustrator Tool Prime Import Support 

○​ For Best Results and Performance - We recommend using the same Artboard 
size as your PRIME Scene Resolution. 

○​ Shapes, Draw, Modify, Open and Closed Paths, and Type Tools are supported 
but results can vary 

■​ The Line Segment Tool is not supported. Lines will be imported into 
PRIME however due to the lack of a Stroke color option in PRIME, it will 
appear hidden. 

○​ Clipping Maks and Compound Paths results will vary 
○​ Illustrator Effect Support will vary 
○​ Photoshop Effects are not supported 
○​ 3D is not supported 
○​ Type must be outlined (Non-Outlined / Editable Type will not import into Prime) 

■​ Outlined Area Type, Type on Horiz and Vert Path, and Vertical Text is 
supported 

○​ Images are not supported 
○​ The Blend Tool support will vary. We do not recommend importing with Smooth 

Color Spacing or high steps / distance values as each blend step will import as its 
own individual path. 
 

●​ .SVG Prime Import Support 
○​ Exact vector shape and layer compatibility will vary  
○​ .AI and .PDF file types offer superior vector object support than .SVG files 
○​ RGB color value accuracy is greater with .svg files​
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Saving Vector Images from Adobe Illustrator for PRIME 
●​ Open or Create artwork in Illustrator based on the supported Vector options notes above 
●​ Go to File > Save 
●​ Choose your preferred save location 
●​ Save as Type 

○​ Select either .AI, .PDF, or .SVG 
■​ For .SVG - If needed, choose the required artboard you will to save out 

(artboards are not supported in PRIME 
■​ For .PDF - All and Range are supported in PRIME, however only 1 page 

can be imported at a time during the PRIME Import Vector process. 

 
●​ (.ai) Save Options 

○​ Files must be saved out as Illustrator 2020 
○​ Create PDF Compatible File option must be turned on 
○​ Illustrator artboards are not supported, single artboard only​

 
●​ (.pdf) Save Options 

○​ Please use the [Illustrator Default] pdf save options 
○​ Multiple PDF Pages are supported in PRIME, however you can only import one 

page at a time within PRIME’s import vector process.​
 

●​ (.svg) Save Options 
○​ Please use the Default SVG 1.1 save options  

​
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Designer Settings  

General  

 

 

New Scene 
Optional to define a default scene whenever New scene (ctrl + N) is created . 

​
Layout 
Auto Save Layout enabled will save all layout changes to the currently loaded layout. With this 
setting disabled, you must manually save any layout changes to the specified .wxel file. 

​
Default Region of Interest  
Define numeric values for Top, Left, Bottom and Right for the default region of interest guideline 
that will be displayed for each new scene. (0,0,0,0 is fullscreen)   

​
Thumbnail 
Default height of thumbnail image   

​
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Canvas Settings 

 

 
General 
Allows for visual control of selected objects. 

Color 
Allows setting background color, region of interest color, ruler guide color. 

​
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Safe Title 
Allows for visual control of the canvas safe title guides. 

Ruler Guides 
Creating Guides 
By default, objects will snap to ruler guides. You can adjust snapping settings in the Tools menu. 
 
You can also lock all guides from the Tools menu. This can be handy when you have lots of 
objects in your scene and you don’t want to accidentally select a ruler guide. 
 

 
To begin creating a ruler guide, open the designer. Next, open the tools menu and choose 
“Create Guide.” This will open the Guide Form, from which you can define the dimension and 
position of your new guide. The default shortcut to open this form is Ctrl+Alt+G. 
 
Alternatively, you can create guides by dragging them onto the designer canvas. First, make 
sure you are in the designer and that rulers are shown (Tools > Rulers/Ctrl+R). Then, click on a 
ruler and drag your mouse onto the canvas. A new guide will be created and placed wherever 
you drop it. 
 
Deleting Guides 
To delete a guide, simply drag it onto a ruler and it will automatically be deleted. To delete all 
guides, go to Tools > Clear Guides. 
 
If you want to hide all of the guides temporarily, you can go to Tools > Show Guides to toggle 
them off and on. 
 

Align (Smart Guides) 
Determines if the built-in alignment tools (Smart Guides) should align text objects by its 
bounding box or the bounds of the text itself. 

Copy/Paste Mode 
Renumber Parent only: When you copy and paste a group, only the pasted parent will 
autoincrement the suffix number value of the group name. 

Renumber Parent and Children: When you copy and paste a group, the pasted parent as well 
as all children objects will autoincrement the suffix number value of their node name. 

 

​
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Control Panel Settings 

 

Default Control Panel Size - Default size of new Control Panels 

Control Placement - When new Controls are added to a Control Panel, this determines the 
direction in which they are placed. 

​
Left to Right Example:​

​
​
Top to Bottom Example:​

 

​
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Scene Tree 

 

 

Filter 
With filter selected, only objects that meet the search criteria in the scene tree search bar will be 
displayed in the scene tree. 

Highlight 
With highlight selected, all objects in the scene tree will remain visible, and those that meet the 
search criteria of the scene tree search bar will be highlighted.  

​
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Action Settings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

​
​
Timeline 
Move Cursor with Keyframe - moves the playhead and cursor to the keyframe 

Always Show Cursor - always shows or hides the vertical timeline playhead cursor line​
 

​
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Animations 
Background: 

Parent 

 

 

Hide 

 

 

Show 

 

 

​  

​
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Default State: Expanded or collapsed 

Show Expanded when Keyframes Present 

Show Expanded when Selected 

 

Keyframes 
Default Interpolation: Sets the default keyframe behavior. 

Show Gridlines: Show or hide canvas gridlines 

Auto Default Keyframes: Adds keyframes to the “Default” action when keyframes are created 
in other Actions. Example: add “PositionX” into the setting then create a new action and you will 
see “PositionX” in the timeline. Add as many properties as you need. Separate them by 
commas. “PositionX,PositionY,ScaleX”. 

Default Ease Length: When a new “ease” keyframe is added, set the default ease to some 
value. 

​
Properties 
Show Properties: Define which properties you would like to be automatically added to the 
Timeline Editor when a new action is created. 

​
Behavior 
Never: If a second object of the same type is added to the Action the properties listed will not 
show. 

Empty: Remove properties defined in the “Show Properties” that have no keyframes. 

Selected: Shows the properties with or without keyframes from the selected object. 

Always: Always show the properties when the object has no keyframes. 
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Save 
Video Format: Select the video format when saving actions to a clip file. Right clicking on the 
Action tab allows users to record the animation to file.​
​
Action is saved using first output channel and certain restrictions apply based resolution of the 
Output Channel​
​
4K Support. Only DNxHR codes supports resolution higher than 1080p​
Interlace Support. DNxHD does not support. 

Save Action to Clip will only honor auto follow source mode on the first frame of the selected 
action. If autofollow expressions (including position and size) are evaluated after the initial 
keyframe then the render will not evaluate. For example if the source object's position or size 
changes during the animation, then autofollow will not evaluate on the target object.  

 

Default Location: Set the folder where Action clips will be stored 

Copy/Paste 
Paste Mode 

Create New Actions 

Paste in Existing Actions 

 

 

Project Settings 

 

​
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Text Settings 

 

Default Style 
Select from the list of Styles (Refer to the “Text” section on Styles).  This style will be the default 
style each time a new text object is added to your scene. 

 

Enable Tab Key to Cycle Text Objects 
With this option enabled the tab key will cycle to the next text object in the scene tree and 
automatically places focus in the properties text field. This allows you to quickly and easily 
update text fields within your scene in Prime Designer. Focus must be on either the Scene Tree, 
Canvas or Text Editor for this feature to function. Shift Tab cycles to previous text objects.  

 

​
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Configuration (Designer Canvas) 
*Changing this configuration will not affect Playout Channels​
​

​
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Use First Playout Configuration Channel 
Uses the very first PRIME Playout Configuration Channel Settings to configure the PRIME 
Scene Designer Canvas output settings (Traditional Method from all Previous PRIME Versions).​
*Checked on (Enabled) by Default to use the first playout configuration channel 

 

Video Standard Output resolution and frame rate to be used for the channel 

Range SDR or HDR (Windows HDR PQ Only) 
*Special Note 
If you are designing in HDR but do Not have an HDR Monitor, change 
this setting to SDR to prevent the Designer Canvas being washed out 
due to no HDR Monitor being used 

Depth 8Bit or 10Bit 

Audio Mode Chooses output audio type: Disabled or System Audio 

Audio Device Can be set to Primary Sound Driver to use the default audio output from 
the system, or to any of the audio devices available to the system  

Audio Channels The number of audio output channels 

Antialiasing Sets the antialiasing for the output: Disabled, Multi Sample 2x-16x, 
Coverage Sample (Quality) 8x-16x 

​
*After changing the settings, you will need to restart PRIME for the new settings to take effect

​
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Scene Tree Node Coloring 
Enable color coding in the scene tree will also color code the shaded areas above/ 

To enable Node Coloring right click on the toolbar left of the Scene Node where the “Lock” icon 
is located. 

 

 

 

 

​
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Canvas Properties 

Axis Mode 

 

Toggles between Local and World Axis View modes. 

World Axis View: When you move an object using this coordinate system, you are 
moving it relative to the space of the viewport. 

Local Axis View: Uses the coordinate system of the selected object. 

 

Auto Select 

Toggles between Auto Select and Lock Selection 

Auto Select: The active selection changes to where the user clicks on the Canvas. 

Lock Selection:  The active selection is persistent regardless of where the user clicks 
on the Canvas.  Changing focus is done on the Scene Tree. 

 

Selecting Overlapping Objects 

Right-clicking on the Canvas at the point where two or more objects overlap will display a 
context menu of the overlapping objects.  Objects with the same not are not distinguished in this 
menu. 

 

​
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Alt+left click at the overlapping area will cycle through the overlapping objects.  

 

Pan & Zoom 

Use the “-“and “+” buttons on the slider control or your mouse wheel for zoom control.  

Hold the middle mouse wheel down to pan the canvas. Zoom will “Zoom to Mouse” 

Show Wireframe-Normals-Key  

 

​
 

Show Bounding Box-Manipulators  

 

 

​
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​
​
128 | PRIME 5.3 User Guide  



 

Custom Canvas Resolutions 

This property is part of the “Scene/Resolution” property. 

 

Selecting “Custom” will bring up the following dialog: 

 

 

​
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Playout Configuration: 

 

The Prime Scene Designer Canvas derives the starting resolution from the first output channel 
within Prime Playout Configuration. Any Custom resolutions set in the Playout Configuration will 
be enumerated in the Canvas Resolutions list automatically and vice versa.  
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Setting up HDR within Windows 

To enable HDR for the Prime Scene Designer Canvas, your Windows Display Settings must be 
configured to use HDR. The monitor you will be using to display Prime Designer must be a 
HDR-capable monitor in order to turn on HDR in Windows.  

Enable HDR in Windows 10: 

1.​ Select the Windows Start Button, then select Settings > System > Display. 
2.​ Choose the HDR-capable display under Rearrange your displays. 
3.​ Select Windows HD Color settings 
4.​ Under Display capabilities, check to make sure it says Yes next to Use HDR. 
5.​ Turn on Use HDR. 

Enable HDR in Windows 11: 

1.​ Select the Windows Start Button, then enter Settings. Select Settings > System > 
Display. 

2.​ Choose the HDR-capable display at the top of Display Settings. 
3.​ Scroll down to HDR under Brightness & Color and switch HDR to On. 

​

 

​
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Prime Scene Designer HDR Canvas Setup 

Once HDR is set up within Windows, please startup Prime and navigate to Playout. Select 
Config > Playout Configuration. The Prime Scene Designer Canvas is tied to the first output 
channel within Playout Configuration unless it has been overridden by PRIME Designer’s 
Canvas Configuration in Prime Designer Settings. Due to this, please set either the first output 
channel to a Device type that will allow you to select HDR 10 Bit or manually setup the Prime 
Designer Canvas Configuration to HDR. Please see the Configuration (Designer Canvas) 
section of this document for details.​
​
HLG and S-Log3 based HDR are not available for use with the Canvas. However, if your first 
Output Channel is set to HLG or S-Log3, the canvas will automatically use HDR 10 Bit. LUT files 
are not compatible with HDR or Prime’s Scene Designer Canvas. HLG based channels are the 

only type of channel which supports LUT files as outlined in the Prime Playout 
Configuration User Guide.​
​

Even if your first output video channel is set to HLG with a selected LUT file, the LUT will Not be 
applied and displayed on the Canvas itself. It will only be applied to the Playout Video Output 
Channel itself as the Canvas does not support LUTs. 

​

 

​
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When HDR is enabled for the first Playout Video Channel but your monitor does not have 
HDR enabled within Windows, the Prime Scene Designer Canvas will appear washed out 
like in this example.​

​
​

​
​
Please see the Prime Playout Configuration User Guide for channel setup instructions and 
further HDR, HLG, and S-Log3 details. 

 

​
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Scene Properties 

 

 

​
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The following scene properties are displayed:  

●​ Description – The user may enter a simple description of the scene​
 

●​ Keywords: Add metadata to search for scenes​
 

●​ Style: Can be linked to a CAMIO context and changed in LUCI.  See Style Sheets for 
more.  ​
 

●​ Message Id - Messages recorded from this scene will start recording at the specified 
location or the next available location.  When a message is read, PRIME will read in the 
base message and fulfill the template with the data from the message.​
 

●​ Channel-On recall the scene will play to the defined channel​
 

●​ Layer-On recall the scene will be positioned in the defined layer on output​
 

●​ Effect In: When the scene plays use these triggers in the trigger list as the Effect In. 
Usually it’s just an Action or Condition to effect in​
 

●​ Effect Out: Execute these triggers when the scene transfers from Program to Preview​
 

●​ Layer In: Triggers when a scene in Preview plays to Program replacing another scene in 
the same layer. This supersedes the “Effect In”.​
 

●​ Layer Out: Triggers when a scene in Program is played off by an incoming scene in the 
same layer. This supersedes the “Effect Out”.​
 

●​ Preview In: Executes when a scene is loaded into Preview. The Defined “Effect In” will 
still execute when the scene is played. This is useful for LUCI previews in a CAMIO 
workflow.​
 

●​ Update Behavior: Only applies when the scene is playing on Output and the same 
scene (or message based on same) is cued to played next​
 

o​ Update Values: On playback of the cued scene, the cued scene updates the 
replaceable values of the playing scene without replacing the playing scene from 
the output​
 

o​ Replace Scene: On playback of cued, the playing scene is fully replaced by the 
cued scene.  Layer In and Layer Out will be used if defined.  Otherwise, Effect In 

​
​
135 | PRIME 5.3 User Guide  



 

and Effect Out will be used. ​
 

●​ Auto Priority - An incoming scene takes priority over an outgoing scene. To adjust the 
priority, uncheck Auto Priority and change the value in the Scene Properties > Render 
section of the Scene Group. The default is 2000. Auto Priority will override the Z position 
of multiple scenes in the same channel. ​
 

●​ Resolution - Set the resolution format for the scene.​
 

●​ Region of Interest - Set the Region of interest for the scene that can be used in 
designer to crop; save image and save clip files. (0,0,0,0 for Left, Top, Right and Bottom 
bounds is fullscreen resolution with no cropping applied).  

o​ Size: Reward only text for final size of defined region of interest 
o​ Set to Graphics Bounds: Selecting this button will update region of interest values 

to calculate the utmost bounding edges for top, left, bottom and right of all objects 
combined in the scene.     

 
●​ Thumbnail - Set the thumbnail that will be used in PRIME’s scene browser. 

o​ Use Region of Interest: Enable this to crop the thumbnail to the defined region of 
interest in the scene.  
*This will only be applied to Prime’s scene browser and does not apply to LUCI 
thumbnails and previews.  

 

 

​
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Command Sequence:  

The command sequence allows you to build a list of Trigger items to play out in a sequence: 

 

Adding a Command allows you to 
choose an item from the Trigger list: 

The right Green arrow indicates 
whether the item, after being 
executed, will move to the next item 
in the list. This is called “Follow 
Through”. Some items, like Action, 
can ONLY be follow through. 

 

The Command Sequence has its 
own API and can be controlled by a 
Condition, A script or from a Control 
Panel 
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C# Script: 

Scene.CommandSequence.Execute 

 

Condition: 
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Control Panel: 
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Scene Events 

●​ Before Load - Executes once before a scene 
is loaded into either Preview or Program 

●​ Effect In -Triggers when a scene is transferred 
to Program. (See Layer In) 

●​ Effect Out - Triggers when a scene is 
transferred from Program to Preview or Scene 
is closed. (See Layer Out) 

●​ Layer In - Triggers when a scene in Preview 
plays to Program replacing another scene in 
the same layer. This supersedes the “Effect In”. 

●​ Layer Out - Triggers when a scene in Program 
is played off by an incoming scene in the same 
layer. This supersedes the “Effect Out”. 

●​ Preview In - Triggers when a scene is loaded 
into Preview. Supersedes the Effect In for 
Preview. 

●​ Before Load -Triggers before a scene is 
loaded into Program 

●​ After Load - Triggers once after a scene is 
loaded into either Preview or Program 

●​ Before Play - Triggers before a scene is played 
from Preview to Program 

●​ After Play - Triggers after a scene is played to 
output 

●​ Before Update - Triggers before the elements 
of a scene are loaded. 

●​ After Update - Triggers after the elements of a 
scene are loaded. 

●​ Before Stop - Triggers when a scene is taken 
off Program 

●​ After Stop - Triggers after a scene is taken off Program 
●​ Before Close - Triggers before a scene is closed. (Cleared from both Preview and 

Program) 
●​ After Close - Triggers after a scene is closed. (Cleared from both Preview and Program) 
●​ Style Changed - Triggers when the scene’s Style Property is changed (See Style 

Property) 
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Opening a scene directly to output will trigger Before load, After Load, Before Play and 
After Play. 

All of the scene events handlers can be used to attach any of the other objects methods in the 
scene. EX:Timer1.Start 
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Example of assigning an “Effect In” and “Effect Out”: 
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Scene Objects 
The Toolbox 

​
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Base Scene 

Base scenes can be added as objects in a scene as well as a Scene resource.​
(See the “Resources” section). 

 

When Base scenes are added to scenes the Base Scene will be inserted into the current scene 
as a Scene child object. Control panel objects will be appended to the Control Panel.   
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Base Scene Actions and Conditions become available in the Triggers list and through 
Conditions. 
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Base Scene Properties 
Same as a normal scene. 
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Circle Object 

Render Properties 
 

Projection 
●​  

●​ Orthogonal - Orthogonal 
projection. 

●​ Perspective local - Central 
projection. The mid-point of 
projection is affected by an 
object. 

●​ Perspective Global - 
Central projection. The 
mid-point of projection is 
immovable in screen 
coordinates. 

●​ Camera - Projection in line 
with an external camera. 

●​ Camera Lens - Special kind of projection in line with an external camera.​
Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

 

Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 

smaller than Z-coordinate in depth buffer). This option ensures the correct 
visibility of 3D object surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to 

Z-coordinate from depth buffer. Appropriate for n-pass drawing of the same 
object. 
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●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

●​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in 
itself. 

o​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal 
to Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

Light Enabled 
Double Sided 
Depth Function 
Priority 
Transform Properties 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

Surface Properties 
●​ Opacity​

 
Circle Properties 

●​ File 
●​ Color 
●​ Angle 

○​ Visible angle in degrees from 0Â° to 360Â°.​
Value below 360Â° increases open angle in the circle. 

●​ Diameter 
○​ Circle diameter. 

●​ Hole 
○​ Creates a hole in the circle, making it into a ring. 
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●​ Tessellation 
○​ Number vertices on the circle perimeter.​

Higher tessellation makes the circle smoother but consumes more resources to 
render. 

●​ Alignment 
○​ Center - Open angle is centered at the top (Y+). 
○​ Clock Wise - Clockwise alignment. Angle starts at zero and opens clockwise. 
○​ Counter Clock Wise - Counter-Clockwise alignment. Angle starts at zero and 

opens counter clockwise 
●​ UV Mapping 

○​ Planar - UV coordinates projected linearly by a plane. 
○​ Polar - U is angle, V is distance from center. 
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Clip Object 

The Clip object allows designers to 
playback clips within Designer and 
Playout. 

Supported Playback Clip Formats: 

GTC is the native PRIME clip Format.  

Supported formats in various wrappers 
include .MOV. DNxHD, DNxHR, PRO 
Res, XDCam, .mxf, H264, AVC Intra, 
DVC Pro HD, HQ, HQX, MPEG2, and 
MPEG4 

DNx and ProRes both require a valid 
license for playback support.​
A warning prompt will display if these 
codecs are unlicensed.   

*There maybe some exceptions for 
key, audio, 4K, and HD support 
depending on the codec’s native 
support of those features​
​
If your use case requires more system 
resources for clip playback performance, 
especially when using Apple ProRes 
based clips, please read about the Copy 
Threads setting within the 
PRIME_Playout_Configuration_Guide.​
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The following settings may be configured on the Clip Properties window: 

●​ Name - The user friendly name to refer to the object throughout the application. 

Render Properties 
The Render subcategory includes:  

●​ Projection – Projection mode. It is method how to map 3D objects to 2D screen plane. 

●​ Orthogonal - Orthogonal projection. 
●​ Perspective local - Central projection. The mid-point of projection is affected by an 

object. 
●​ Perspective Global - Central projection. The mid-point of projection is immovable in 

screen coordinates. 
●​ Camera - Projection in line with an external camera. 
●​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens are tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is offset 
by current node position in the view of parent projection and transformations. 

 
●​ Projection Center – Center of projection. (Position on the screen where all lines meet in 

infinity.) 
●​ Light Enabled – Enable use of lights. Applies only to object with generated normals.​

This feature is ignored when using shaders. 
●​ Double Sided – Double side visibility. 
●​ Depth Function- Function for making decision whether it will write to scene according to 

z-buffer. 

●​ OFF - Disabled writing to depth buffers.​
Suitable for flat object which doesn't collide with any other objects. 

●​ ON - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 
smaller than Z-coordinate in depth buffer). This option ensures the correct 
visibility of 3D object surface and its mutual location with other objects.​
Default value. 

●​ ALWAYS - Fragment is rendered always independently of depth buffer. 
●​ NEVER - Fragment isn't rendered ever. 
●​ EQUAL - Fragment is rendered if Z-coordinate at a given point is equal to 

Z-coordinate from depth buffer. Appropriate for n-pass drawing of the same 
object. 
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●​ EQUAL - Fragment is rendered if Z-coordinate is less or equal to Z-coordinate 
from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

●​ NOWRITE - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in 
itself. 

●​ GEQUAL - Fragment is rendered if Z-coordinate is greater or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

 
●​ Priority- Rendering priority within a layer. The higher number the later the object gets 

rendered.​
Use with care! Rather use Position.Z instead.​
The priority change doesn't work well if objects use depth buffer. 

●​ Texture Quality 
●​ Texture Wrap 

 

Transform Properties 
The Transform subcategory allows for 
the manipulation of the Clip Objects 
Position, Scale, Rotation and Pivot 
along the XYZ axis. 

 

●​ To keep the Scale Aspect fixed 
to its current dimensions, click 
the lock icon to Lock Aspect Scale. 
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●​ Position: Position the object in X, Y or Z 

●​ Scale: Scale the object in X, Y or Z 

●​ Rotation: Rotate the object in X, Y or Z 

●​ Pivot: Move the Pivot Position of the object in X, Y or Z 

●​ Origin: Move the Origin Position of the object in X, Y or Z 

●​  

Surface Properties 
The Surface subcategory includes: 

●​ Size Width  
●​ Size Height  
●​ Opacity  

​
Clip Properties 
The Clip subcategory includes: 

●​ File – Clip file name 
●​ Command 

o​ None 
o​ Cue 
o​ Play 
o​ Stop 
o​ Pause 
o​ Resume 
o​ Rewind 
o​ Fast Forward 
o​ Play Reverse 
o​ End  
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●​ Frame – Current Frame number 
●​ Length –length of the clip file 
●​ Trim In – Trim the start of the clip. 

Marks the “In” point  
●​ Trim Out – Marks the “out point” of 

the clip 
●​ Loop – Loop the clip any number 

of times or indefinitely. 

 
Configure the loop as follows:  

●​ To enable/disable the loop, check/uncheck the check box.  
●​ To set the number of times that the clip loops:  

 
Enter a number: Loops the specified number of times.  

 
Indefinite: Select Indefinite to have the loop play indefinitely.  

●​ Loop Points: Two loop points can be set, so that the clip begins from one point 
and loops back to a point different from the start point of the clip and loops back 
from a point different from the end point of the clip.  

●​ Loop In: Set the point back to which the clip loops, i.e., the loop start point.  
●​ Loop Out: Set the point back from which the clip loops, i.e., the loop end point. 

This action is not yet available  
 

●​ Hold last Frame-Pause at last frame 
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Clip Events 
There are a few ready to use events 

●​ Finished 
●​ Play Finished 
●​ Reverse Finished 

 

 

 

 

 

 

There are events for all the clip 
properties as well: 
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The Clip subcategory includes: 

●​ Preview – These controls allow you to preview clips 

●​ Set Position to Crop Offset - GTC files can be generated by cropping off all 
pixels that are always transparent, and embedding this crop information as 
metadata into the clip. Enabling this option allows this crop position to be 
automatically set to the Position property of the clip 

●​ Synchronize - Enable to synchronize multiple clips using the same File 

●​ Progressive Still - Merges two interlaced fields into one frame during pause.​
Only available for interlaced clips. 

●​ Match Output Rate - If enabled, automatically adjusts the playback rate of the 
clip to match the output rate of the channel. 

o​ For Playout: Match Output Rate only supports the playout of audio if the 
video output channel you are playing out to is set to the same frame rate 
as the frame rate of the clip. 

o​ Example 1 - Clip is rendered at 50fps, Output Channel is set to 59.94. 
Clip will playback at 59.94 instead of 50fps but audio will not play. 

o​ Example 2 - Clip is rendered at 50fps, Output Channel is set to 50fps. 
Clip will playback at 50fps and audio will play.​
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●​ File – Shows the clip browser starting in the “Clips” folder of the current project. 

 

 

 

Clips with the “Warp” icon in the lower right hand corner are flagged as “Warp” clips that contain 
the UV Mapping information. 
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Clips with Key icon: 

 

 

The Events subcategory includes:  

●​ Finished Event - When the clip is finished perform something else available in the 
scene. 
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Cone Object 

Cube Object 

Render Properties 
Projection 

●​ Inherit 

●​ Orthogonal - Orthogonal 
projection. 

●​ Perspective local - Central 
projection. The mid-point of 
projection is affected by an 
object. 

●​ Perspective Global - Central 
projection. The mid-point of 
projection is immovable in 
screen coordinates. 

●​ Camera - Projection in line with an external camera. 
●​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

 

Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 

smaller than Z-coordinate in depth buffer). This option ensures the correct 
visibility of 3D object surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to 

Z-coordinate from depth buffer. Appropriate for n-pass drawing of the same 
object. 
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●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

o​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in 
itself. 

o​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal 
to Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

Light Enabled 
Double Sided 
Depth Function 
Priority 
Transform 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

Surface 
​ Opacity: 
Cube Properties 
File: 
Size: 
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Bevel 
 

 

o​ None: 
o​ Chamfer: 
o​ Round: 
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Cylinder Object 

Render Properties 
Projection 

●​ Orthogonal - Orthogonal projection. 
●​ Perspective local - Central projection. The mid-point of projection is affected by an 

object. 
●​ Perspective Global - Central projection. The mid-point of projection is immovable in 

screen coordinates. 
●​ Camera - Projection in line with an external camera. 
●​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is offset 
by current node position in the view of parent projection and transformations. 

▪​ Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is smaller 

than Z-coordinate in depth buffer). This option ensures the correct visibility of 3D object 
surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to Z-coordinate 

from depth buffer. Appropriate for n-pass drawing of the same object. 
●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 

Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous rendered 
objects. 

●​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in itself. 

●​  
●​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal to 

Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous rendered 
objects. Use just for special purposes! 
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Light Enabled 
Double Sided 
Depth Function 
Priority 
 
Transform Properties 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

 

Surface Properties 
Opacity 
​ ​ Set the opacity on the surface object 

 

 

Cylinder Properties 
Diameter 
Depth 
Angle 
Hole 
Tessellation 
Alignment 

▪​ Center 
▪​ Clockwise 
▪​ Counter Clockwise 

UV Mapping 
▪​ Planner 
▪​ Polar 
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Bevel Properties 
Size 
Cuve 
Scale 
Tessellation 
Back 
Inside 
 

 

Freehand 

Transform Properties 
Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

Data: 
Point X-Y: 33 
Data: CSV data in format: "x1,y1\nx2,y2" ... . \n is a new line character.​
You can use pipe "|" character instead of new line. 

 

Freehand: 
​ Color: Stroke color 

End Fade: Position on the stroke where to apply alpha gradient from 1 to 0. 

​ End Length: The length of end part of the stroke which is made thinner. 

Thickness: Half thickness of the stroke 
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Filter Step: Filter step affects finer (lower then 1.0) or coarse (higher then 1.0) sampling 
of input data. 

Texture: 
Texture: Filename of image file used as a texture on stroke.​
If set to empty string or undefined then no texture is used.​
The texture is always drawn in REPEAT mode.​
To shift the texture along the stroke use TextureMatrix effect and change Offset.X 

Stretch: When undefined the texture is repeated over the stroke.​
Otherwise the parameters define range in which the texture is stretched over the stroke.​
The parts outside the range is not stretched. 
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Group Object 

 
The default shortcut to add a group to your scene is Ctrl+G. Selecting objects in your scene tree 
using Ctrl and then pressing Ctrl+G will add a new group to your scene and automatically move 
the selected objects inside the new group. The default shortcut ungroup is Ctrl+U. 
 
Render Properties 
Projection 

●​ Inherit - inherits from the parent 
group. If there is no parent group, 
then it defaults to Perspective 
Global 

●​ Orthogonal - Orthogonal projection. 

●​ Perspective local - Central 
projection. The mid-point of 
projection is affected by an object. 
 

●​ Perspective Global - Central 
projection. The mid-point of 
projection is immovable in screen 
coordinates. 
 

●​ Camera - Projection in line with an external camera. 
 

●​ Camera Lens - Special kind of projection in line with an external camera.​
Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction.​
 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 
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Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 

smaller than Z-coordinate in depth buffer). This option ensures the correct 
visibility of 3D object surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to 

Z-coordinate from depth buffer. Appropriate for n-pass drawing of the same 
object. 

●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

●​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in 
itself. 

●​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal 
to Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

Light Enabled 
Double Sided 
Depth Function 
Priority 
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Transform Properties 
The Transform subcategory allows for the manipulation of the Clip Objects Position, 

Scale, Rotation and Pivot along the XYZ axis 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

Surface Properties 
​ Opacity: Set the opacity of the children in the group 
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HTML Input Object 

The HTML Input Graphic Object allows users to render a webpage within Prime Scenes and 
deliver it to any output channel. The webpage URL is defined through the HTML Input 
properties.​
​

 

HTML Input’s Intended Use and Performance 

The HTML Input feature is currently intended for static or minimally animated webpages, as part 
of a Prime Scene design. 

Performance may vary depending on the system demands of the website being displayed. 
Prime’s official 3RU System supports displaying up to two HTML Inputs simultaneously, subject 
to the performance requirements of the rendered webpages. 

At this time, we do not recommend displaying webpages with frequent or complex animations, 
particularly those requiring sustained 60 fps playback to render correctly or sites with video 
clips. 

Currently Not Supported 
●​ Prime Touch Effects / Touch screen interactivity 
●​ Website-based video playback, including video codecs and players such as MP4 (H.264) 

○​ Additional codecs and third-party video players (not guaranteed) 
●​ Hardware acceleration 
●​ Audio Playback 
●​ Mouse and Keyboard​

 
​
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HTML Input Licensing and Playout 
Use of HTML Input requires the purchase of HTML Input channel licenses. Users may purchase 
up to four HTML Input channels per Prime license, sold in quantities of two, (up to 4 / 2 on 
output max). 

While Prime Scene Designer allows designers to build scenes containing more than two HTML 
Inputs, only up to two licensed HTML Inputs may be played out simultaneously. HTML Input 
licenses must be purchased in pairs to maintain back-to-back playout workflows. 

An HTML Input license is consumed whenever a webpage is loaded into either Preview or 
Program. 

 

If a user attempts to use more HTML Inputs than are licensed in Preview or Program, an error 
message will be displayed, such as that shown above, and the HTML content will not render. To 
avoid this, users should limit the number of HTML Inputs, purchase additional licenses (up to 4 / 
2 on output max), or follow best practices by effecting out the current HTML Input scene on 
Program before loading the next scene into Preview and taking it to air. 

Furthermore, if all available HTML Input licenses are in use on Program and the user attempts 
to load additional HTML Inputs into Preview, the HTML content will not be displayed in Preview 
and the HTML Input licensing error will appear. This occurs because each HTML Input loaded 
into Preview or Program creates a new browser instance, consuming a license. This is the 
reason users must license HTML inputs in pairs. If Preview displays a blank HTML Input due to 
licensing, Program will behave the same way when the scene is played to air.​
 ​

 

​
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Prime HTML Input Control Panel Example and Setup Steps 

 

HTML Input provides the following control properties: 

●​ Back 
●​ Forward 
●​ Refresh 

 

 

 

​
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Setting Up HTML Properties 

Adding the URL Replaceable Text Field​
Designers can link the HTML Input URL as a replaceable and to a Control Panel Text Box by 
binding the replaceable to the URL and then dragging and dropping your Text Replaceable onto 
the Control Panel.​
​

 

 

​
Adding the Back, Forward, and Refresh Buttons​
To add navigation controls, create three buttons on a Control Panel. For each button, configure 
the Click Properties to bind it to the corresponding HTML Input property (Back, Forward, or 
Refresh).​
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Image Object 

 

The following settings may be configured on the Image Properties window: 

●​ Name – The name to be referenced throughout the scene 

​
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Render Properties 
The Render subcategory includes: 

●​ Projection -  

●​ Orthogonal - Orthogonal projection. 
●​ Perspective local - Central 

projection. The mid-point of 
projection is affected by a object. 

●​ Perspective Global - Central 
projection. The mid-point of projection is immovable in screen coordinates. 

●​ Camera - Projection in line with an external camera. 
●​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens are tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

 

●​ Projection Center - Center of projection. (Position on the screen where all lines meet in 
infinity.) 

●​ Light Enabled - Enable use of lights. Applies only 
to object with generated normals.​
This feature is ignored when using shaders. 

●​ Double Sided - Double side visibility. 
●​ Depth Function- Function for making decision 

whether it will write to scene according to z-buffer. 

●​ OFF - Disabled writing to depth buffers.​
Suitable for flat object which doesn't collide with any other objects. 

●​ ON - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 
smaller than Z-coordinate in depth buffer). This option ensures the correct 
visibility of 3D object surface and its mutual location with other objects.​
Default value. 

●​ ALWAYS - Fragment is rendered always independently of depth buffer. 
●​ NEVER - Fragment isn't rendered ever. 
●​ EQUAL - Fragment is rendered if Z-coordinate at a given point is equal to 

Z-coordinate from depth buffer. Appropriate for n-pass drawing of the same 
object. 
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●​ EQUAL - Fragment is rendered if Z-coordinate is less or equal to Z-coordinate 
from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

●​ NOWRITE - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in 
itself. 

●​ GEQUAL - Fragment is rendered if Z-coordinate is greater or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

 
●​ Priority- Rendering priority within a layer. The higher number the later the object gets 

rendered.​
Use with care! Rather use Position.Z instead.​
The priority change doesn't work well if objects use depth buffer. 

●​ Texture Quality 
●​ Texture Wrap 

 

Transform Properties 
The Transform subcategory allows for 
the manipulation of the Image Objects 
Position, Scale, Rotation and Pivot 
along the XYZ axis. 

Position: Position the object in X, 
Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

●​ To keep the Scale Aspect fixed to its current dimensions, click the lock icon to Lock 
Aspect Scale. 
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Surface Properties 
The Surface subcategory includes: 

 

The red arrow button will allow you to set the Size Mode to determine what happens when the 
image is replaced. This option gives you many choices. 

 

•​ Fixed Size: Image will use the Width and Height defined in the properties regardless of the 
file size 

•​ Size To File: When the File property changes, Width and Height will be set to the File 
dimensions 

•​ Fit To Width: The Width will be set to the specified Fit Bounds Width, and the Height will be 
calculated to maintain the aspect of the File Size 

•​ Fit To Height: The Height will be set to the specified Fit Bounds Height, and the Width will be 
calculated to maintain the aspect of the File Size 

•​ Fit To Bounds: The Size is set to fit within the Fit Bounds, while maintaining file aspect 

•​ Fill To Bounds: The Size is set to fill within the Fit Bounds, while maintaining file aspect 

 

​
​
176 | PRIME 5.3 User Guide  



 

Image Properties 
The Image subcategory includes 

 

File 
●​ Image Browser -  

 

Selecting images from folders outside the project will prompt you to import or not import 
the selected image to the project.

 

 

​
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Color  

 

Or use as a solid color, ramp or quad: 

 

​
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Shadow Properties 

Hide on Clear 
When the image is cleared make the image object Transparent. 

Shadow  

 

●​ Hide on Clear 
When enabled this option will clear the image placeholder. When not enabled it will use 
the default color to fill the image placeholder. 

 

​
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Image Events 
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Model 

The supported file types are .iv, .rtg, .3ds, .obj and FBX. 

​
Polygon Object 

Render Properties 
Projection 

●​ Orthogonal - Orthogonal projection. 
●​ Perspective local - Central projection. The mid-point of projection is affected by 

an object. 
●​ Perspective Global - Central projection. The mid-point of projection is 

immovable in screen coordinates. 
●​ Camera - Projection in line with an external camera. 
●​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 

smaller than Z-coordinate in depth buffer). This option ensures the correct 
visibility of 3D object surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to 

Z-coordinate from depth buffer. Appropriate for n-pass drawing of the same 
object. 

●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

●​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in 
itself. 
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●​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal 
to Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

Light Enabled 
Double Sided 
Depth Function 
Priority 
​
Transform Properties 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 
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Polygon Properties 

 

 

​
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Data 
●​ The data section is a string representation of the data needed to display a polygon in the 

designer or scene. 
●​ Data for a polygon can be directly imported from an existing AI, PDF, or SVG vector file 

by using the Import Vector button 
o​ Once the button is pressed and open file dialog will be presented where the user 

can select their desired file.​
 

o​ Once a file is selected the Import Vector dialog is shown.  

 
 
*Please Note - Importing vector files through the Polygon Object directly will import the entire 
vector image file as a single layer. Individual vector layer import requires users to import the 
vector file by going to File > Import Vector. Please see the Importing Vector Files section for 
details about that import method.​
​
The user can then select the polygons in the file they would like to import by selecting the check 
box next to the object. 

●​ The Center Paths option will center the polygons in the scene. 
●​ The end result will be one polygon object in the scene create from all the data in the 

vector file. 
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Texture​
Selects the texture for the polygon 

Color​
The color of the polygon 

Wrap​
Defines how the texture is wrapped on the polygon 

●​ Clamp – Clamps the texture to the polygon geometry 
●​ Repeat – Repeats the texture multiple times to fill polygon 

Depth​
Depth of the polygon along the Z-axis 

Quality​
Represents the level of detail on the edge of the polygon 

Bevel​
The type of bevel to apply. 

●​ None 
●​ Chamfer 

Size​
The size of the bevel​
 

Polygon Object Import Vector Example:​

​
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Pod Object 

Render Properties 
Projection 

o​ Orthogonal - Orthogonal projection. 
o​ Perspective local - Central projection. The mid-point of projection is affected by 

an object. 
o​ Perspective Global - Central projection. The mid-point of projection is 

immovable in screen coordinates. 
o​ Camera - Projection in line with an external camera. 
o​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

o​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

Projection Center 
On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 
smaller than Z-coordinate in depth buffer). This option ensures the correct visibility of 
3D object surface and its mutual location with other objects.​
Default value. 
Always - Fragment is rendered always independently of depth buffer. 
Never - Fragment isn't rendered ever. 
Equal - Fragment is rendered if Z-coordinate at a given point is equal to Z-coordinate 
from depth buffer. Appropriate for n-pass drawing of the same object. 
Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 
No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in itself. 

 
Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 
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Light Enabled 
Double Sided 
Depth Function 
Priority 
Transform Properties 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

Surface Properties 
Size 
​ ​ X,Y and Z size 

Opacity 
​ ​ Set the opacity on the surface object 

Pod Properties 
●​ Color 
●​ Top Left 
●​ Top Right 
●​ Bottom Left 
●​ Bottom Right 
●​ Corner Shape 
●​ Skew 
●​ Outline 
●​ Tessellation​

 
Bevel Properties 

●​ Size 
●​ Cuve 
●​ Scale 
●​ Tessellation 
●​ Back 
●​ Inside 
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Rectangle Object 

Render Properties 
Projection 

●​ Orthogonal - Orthogonal projection. 
●​ Perspective local - Central 

projection. The mid-point of 
projection is affected by an object. 

●​ Perspective Global - Central 
projection. The mid-point of 
projection is immovable in screen 
coordinates. 

●​ Camera - Projection in line with an 
external camera. 

●​ Camera Lens - Special kind of 
projection in line with an external 
camera.​
Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is offset 
by current node position in the view of parent projection and transformations. 

Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is 

smaller than Z-coordinate in depth buffer). This option ensures the correct visibility of 
3D object surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to Z-coordinate 

from depth buffer. Appropriate for n-pass drawing of the same object. 
●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 

Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. 

●​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in itself. 
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●​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous 
rendered objects. Use just for special purposes! 

Light Enabled​
Double Sided​
Depth Function​
Priority​
​
Transform Properties 

●​ Position: Position the object in X, Y or Z 
●​ Scale: Scale the object in X, Y or Z 
●​ Rotation: Rotate the object in X, Y or Z 
●​ Pivot: Move the Pivot Position of the object in X, Y or Z 
●​ Origin: Move the Origin Position of the object in X, Y or Z 

Surface Properties 

●​ Size 
●​ File 
●​ Opacity 

Rectangle Properties 

●​ File 
●​ Color 
●​ Skew - Skew angle in degrees from -90Â° (left) to 90Â° (right). 
●​ Tessellation - Number vertices on the circle perimeter.​

Higher tessellation makes the circle smoother but consumes more resources to render. 
●​ Corner Shape - Value -1 is flat, 0 is round, 1 is just a corner. 
●​ Top Left 
●​ Top Right 
●​ Bottom Left 
●​ Bottom Right 
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Sphere Object 

Render Properties 
Projection 

●​ Orthogonal - Orthogonal projection. 
●​ Perspective local - Central 

projection. The mid-point of 
projection is affected by an object. 

●​ Perspective Global - Central 
projection. The mid-point of 
projection is immovable in screen 
coordinates. 

●​ Camera - Projection in line with an 
external camera. 

●​ Camera Lens - Special kind of projection in line with an external camera.​
Only the lens is tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is offset 
by current node position in the view of parent projection and transformations. 

Projection Center 
●​ On - Fragment is rendered if object lies close to a observer (it's Z-coordinate is smaller 

than Z-coordinate in depth buffer). This option ensures the correct visibility of the 3D 
object surface and its mutual location with other objects.​
Default value. 

●​ Always - Fragment is rendered always independently of depth buffer. 
●​ Never - Fragment isn't rendered ever. 
●​ Equal - Fragment is rendered if Z-coordinate at a given point is equal to Z-coordinate 

from depth buffer. Appropriate for n-pass drawing of the same object. 
●​ Less than or Equal - Fragment is rendered if Z-coordinate is less or equal to 

Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous rendered 
objects. 

●​ No Write - Similar to option "ON" with difference of Stealth attribute.​
Object is rendered under the rule visibility, but it isn't placed in depth buffer in itself. 

●​ Greater than or Equal - Fragment is rendered if Z-coordinate is greater or equal to 
Z-coordinate from depth buffer.​
The later rendered objects in case of equality in Z-coordinate overlay previous rendered 
objects. Use just for special purposes! 
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Light Enabled 
Double Sided 
Depth Function 
Priority 
Transform Properties 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 
Surface Properties 
​ Opacity 
​ ​ Set the opacity on the surface object 

Sphere Properties 
File 

Applies a file to the sphere 

Angle 
Visible angle in degrees from 0Â° to 360Â° around Y axis.​
Value below 360Â° increases open angle in the sphere. 

Diameter 
Sphere diameter. 

Tessellation 
Sphere degree of detail.​

Higher tessellation makes the sphere smoother but consumers more performance to render. 

UV Mapping: 
●​ Absolute - Texture stretches over visible angle. 
●​ Relative Left - Texture is anchored at the left end and cut at the right side end. 
●​ Relative Right - Texture is anchored at the right side end and cut at the left side end. 
●​ Centered - Texture is centered to the middle of visible angle and cut at both ends. 
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Text Object 

 

The following settings may be configured on the Text Properties window: 

●​ Name – The name of the object that will show everywhere throughout the application. 

 

​
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Render Properties 
Projection - It is method how to map 3D objects to 2D screen plane 

 

●​ Orthogonal - Orthogonal 
projection. 

●​ Perspective local - 
Central projection. The 
mid-point of projection is 
affected by a object. 

●​ Perspective Global - 
Central projection. The 
mid-point of projection is 
immovable in screen coordinates. 

●​ Camera - Projection in line with an external camera. 
●​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens are tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

●​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

 

●​ Projection Center - Center of projection. (Position on the screen where all lines meet in 
infinity.) 

●​ Light Enabled - Enable use of lights. Applies only to object with generated normals.​
This feature is ignored when using shaders. 

●​ Double Sided - Double side visibility. 

Transform Properties 
The Transform subcategory allows for the manipulation of the Text Objects Position, Scale, 
Rotation and Pivot along the XYZ axis. 
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Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

●​ To keep the Scale Aspect fixed to its current dimensions, click the lock icon to Lock 
Aspect Scale. 
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Surface properties 
The Surface subcategory includes settings for: 

●​ Size – Sets the height and width of the bounding box. The dropdown gives the following 
choices: 

 
 
-Reset: Resets the bounding box 
-Full screen: Makes the bounding box full screen 
-Fit To Text: Wraps the bounding box around the bounds of the text 
Example: 

 
●​ Text- Read only property that shows the actual text bounds 

 
●​ Opacity – Sets the opacity level from 0 to 100% 

Text Properties 
The Text subcategory allows for the selection of the Font, Font Size, Opacity and a variety of 
other font attributes. 

The following “In-Line” text attribute tags are available: 
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●​ Color Picker - ​  

 

●​ Kerning - Adjusts the spacing between characters 
●​ Leading - Adjusts the spacing between lines of text 
●​ Space Width – Sets the width of the default space character 
●​ Fixed Pitch – Each character will occupy the same amount of horizontal space.  

This is good for clocks so the text will not “breathe” 
●​ Caps Ratio - Sets text to all uppers and adjusts the ratio between capital letters 
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Note that Kerning, Leading, Fixed Pitch and Caps Ratio are all keyframeable. 
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Text Shadow 
adds a shadow to text 

●​ When Shadow is Enabled, Depth Function will be set to On.​
The Depth function can be changed by selecting a different Depth Function option under 
Render properties. 

Text Outline (Border) 
adds an outline to text​
​
**Please Note - when Shadow and Outline are enabled at the same time on the same object, 
Designers should limit the Outline Size to no more than 10. Anything past 10 with Shadow 
turned on will greatly reduce system performance.​
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●​ Text Style Browser  

 

Text styles may be “referenced.”  This means that changing the style of a text affects all other 
text objects in the scene or project. 

 

If the Style is referenced, you will see an image of the style in the Style drop down box. 
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●​ Alignments  

    

First Character aligns column data by the first character it finds by the defined character 
in the text. 

Last Character aligns column data by the last character it finds by the defined character 
in the text. 

In this example we set the First character to the comma character: 
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●​ Line Flow 

 

●​ All Caps 

 

When All Caps is enabled, inputted text on output will be forced to capitalization. When a user 
types in the same text whether it is lowercase or uppercase, Prime will not see this as two 
different values when Behavior is set to On Change.​
​
e.g. hello vs Hello vs HELLO will not trigger a Transition with the Behavior set to On Change​
​
German Language Only - When All Caps is enabled, the German letter Eszett (Sharp S) will 
automatically change from ß to ẞ if provided for by the font used.  
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●​ Numbers 

 

●​ Direction 
Based on the Windows language setting the “Direction” icon will appear. This allows 
orientation and support for Right to Left languages 

 

 

●​ Gradients 
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●​ Number Format 

 

When added to keyframes the numbers will animate from their current value to the next value 

●​ Gradients 
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●​ Linear 

 

●​ Quad 
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●​ Target  
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3D Text 

 

 

​
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Advanced Text Settings​

​
 

●​ Auto Resolution - When checked, renders text at optimal resolution striking a balance 
between visual quality and engine output performance.​
 

●​ Optimize Updates - When enabled along with UDP setting, optimizes text data for real 
time rendering. Text Size updates and Transitions will not be supported with this option 
enabled. 

○​ Scene Example Use Case -  Enable for any text objects that are being updated 
frequently such as 10ths of a second on a timer to ensure updates are prioritized. 

*Users must enable UDP in playout configuration in order to enable Optimize Updates for real 
time rendering. If UDP is not enabled and user selects optimize text for real time rendering 
they will see warning in UI to enable UDP. 
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Text Events 

 

You can trigger other objects methods whenever the text changes. 

All of the Text objects properties have events when these properties change: 
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Text Tags 
You can use Text Tags to change the color attributes of the text within a single text object. 

Available Tags:​  

●​ Tag 0 (\c0) will reset the text color back to the text objects default color 
●​ Tag 1 (\c1) 
●​ Tag 2 (\c2) 
●​ Tag 3 (\c3) 
●​ Tag 4 (\c4) 

 

 

Text Tags require “Solid” mode to be selected 
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Style Tags 
Style tags are effects. See the section on “Style Tags” in the effects section. 

 

Tube Object 

Transform Properties 
The Transform subcategory allows for the manipulation of the Video Input Objects Position, 
Scale, Rotation and Pivot along the XYZ axis. 

​
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Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

Data Properties 
​ Point: Adds or removes a data point 

Data: CSV data in format: "x1,y1,z1\nx2,y2" ... . \n is a new line character.​
You can use pipe "|" character instead of new line. 

Path Length: Limit length of the tube. Value is relative. 0 is no tube drawn, 1 is full tube 
drawn. 

​ Texture Map: Type of V texture coordinate mapping. 

Texture V mapping type: 
ABSOLUTE - V goes from 0 to path's length.​
Unless the extrusion is very small, this length will probably be much larger than 
1.0. 

 
RELATIVE - V goes from 0 to 1 over the whole path. 

 
SEGMENTED - Integer part is equal to segment's index (from 0) and​
fractional part goes from 0.0 to 1.0 on every segment. 

 

Contour Properties 
​ Aspect: Higher value makes it wider. 

Rotation: Contour rotation in degrees.​
Useful for low tessellation settings. Applied before Aspect! 

​ Diameter: Contour diameter (tube thickness). 

Tessellation: Higher tessellation makes the contour smoother but consumes more 
resources to render. 

Smooth: Set to checked to make the contour faceted.​
Set to unchecked to make it smooth. 

​
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Video Input Object 

 

The following settings may be configured on the Video Input Properties window: 

●​ Name – The user-friendly name to refer to the object throughout the application 

​
​
215 | PRIME 5.3 User Guide  



 

Render Properties 
The Render subcategory includes:  

●​ Projection – Projection mode. It is method how to map 3D objects to 2D screen 
plane. 

o​ Orthogonal - Orthogonal projection. 
o​ Perspective local - Central projection. The mid-point of projection is affected by 

an object. 
o​ Perspective Global - Central projection. The mid-point of projection is 

immovable in screen coordinates. 
o​ Camera - Projection in line with an external camera. 
o​ Camera Lens - Special kind of projection in line with an external camera.​

Only the lens are tracked, it means just projection.​
The view matrix is the identity matrix,​
it doesn't depend on a location or camera direction. 

o​ Ortho Parent Offset - Orthogonal projection. The center of coordinate system is 
offset by current node position in the view of parent projection and 
transformations. 

●​ Projection Center – Center of projection. (Position on the screen where all lines meet in 
infinity.) 

●​ Light Enabled – Enable use of lights. Applies only to object with generated normals.​
This feature is ignored when using shaders. 

●​ Double Sided – Double side visibility. 

Transform Properties 
The Transform subcategory allows for the manipulation of the Video Input Objects Position, 
Scale, Rotation and Pivot along the XYZ axis. 

Position: Position the object in X, Y or Z 

Scale: Scale the object in X, Y or Z 

Rotation: Rotate the object in X, Y or Z 

Pivot: Move the Pivot Position of the object in X, Y or Z 

Origin: Move the Origin Position of the object in X, Y or Z 

 

 

​
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●​ To keep the Scale Aspect fixed to its current dimensions, click the lock icon to Lock 
Aspect Scale. 

Surface Properties 
The Surface subcategory includes: 

●​ Size Width  
●​ Size Height  
●​ Opacity  

Video Input Properties 
The Video Input subcategory allows the 
user to select the SDI Input. 

 

Audio Properties 
The Audio subcategory includes: 

●​ Volume – Decibel levels 
●​ Channels – The Audio Router is a matrix for routing inputs to outputs.  The default is 1 

to 1 etc. 

 

 

​
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o​ Duck Audio Channels 1 & 2 example action: 

 

 

​
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Video In Events 

 

 

 

 

 

​
​
219 | PRIME 5.3 User Guide  



 

Alignment Tools 
Accessible by the toolbar.​

 

Align 

●​ Align Edges – Aligns the bounding boxes. 
●​ Align to Safe Title – Aligns the bounding boxes to safe title. 

​
​
Distribute 

●​ Evenly distributes three or more selected items evenly 

 

​
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Snap to Grid​

 

 
 

Color Picker-Eye Dropper 

 

The color picker can do RGBA or HSL or HEX. 

The eye dropper is a mode when selected gives you use of the eye dropper cursor to select 
colors from the screen. Users can pick colors from any application running. 

Color swatches are saved globally with the color picker tool. 

Pressing the eye dropper toggles the mode. 

​
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Effects 
Align 

The Align effect will automatically distribute all child objects dynamically at run time. 

The Align effect will most likely be used with the Auto Spacing effect. 

The Align effect can only be applied to Group objects 

 

 

​  

Removing an image object will create this result 

​
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Horizontal: Align children horizontally 

Vertical: Align children vertically 

 

​
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Auto Follow 

Sibling Mode 

 

The Auto Follow rules of sibling mode are NOT Master/Follower necessarily. Based on the 
position of the elements in the scene The Auto Follow Effect is basically an Auto Align effect. 
Consider the object the effect is placed on as the following object. It will follow any of its 
parents. 

The “Parent” is not defined. The “Parent” is the nearest object to the Follower. The Parent object 
can change dynamically. 

Horizontal: 

o​ None: 
o​ Left: Follows the left edge of the nearest object maintaining distance 
o​ Center: Follows the center position of the nearest object 
o​ Right: Follows the right edge of the nearest object 

Vertical: 

o​ None: 
o​ Top: Follows the top 
o​ Middle: 
o​ Bottom: 

 

In the following example the effect is placed on a group that will follow its siblings: 

​
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The result is whenever the “Master” Text is moved on the X position the follower groups, both 
Group1 and Group 2 will follow. 

 

 

Source Mode 

Different to Sibling mode, Source mode allows you to select a specific object or group that you 
wish to follow and size to.  

●​ Position 
○​ X: Enable and select appropriate source to follow on X axis 
○​ Y: Enable and select appropriate source to follow on Y axis 

■​ X & Y source can be different  
○​ Source: Select source available in scene 

■​ Source from Base scene is not accessible  
○​ Anchor​ 

■​ X: Select Source Origin, Left, Middle or Right 

​
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■​ Y: Select Source Origin, Top, Middle or Bottom 
○​ Target 

■​ X: Select Source Origin, Left, Middle or Right 
■​ Y: Select Source Origin, Top, Middle or Bottom 

○​ Offset: Apply numeric value if offset is desired  
●​ Size 

○​ Width: Enable and select appropriate source to size scale width 
○​ Height: Enable and select appropriate source to size scale height 
○​ Padding: Apply numeric value if padding is desired  
○​ Minimum: Apply numeric value of smallest width and height values you wish to 

size to. If source object is smaller than minimum, then minimum value will be 
honored.  

●​ Advanced 
○​ Include Source Position 
○​ Include Source Scale 
○​ Use Parent Virtual Bounds 

●​ Expressions: (This is Read only and not editable) 
○​ Visual representation for each position and size selection made, and the 

corresponding expression syntax, calculated value and binding. 

Starting in PRIME 5.2.0, users can now copy and paste autofollow expressions into Logic, 
Conditions, or another Expression.  

Autofollow copy and paste or drag and drop for Expressions​
To Drag and Drop - left click and hold on an expression, drag and drop it into the Expressions area​

​
​
Autofollow copy and paste into Logic​

​
​
Autofollow copy and paste into Conditions

 

​
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Auto Hide 

The Auto Hide effect allows users to hide/show objects based on the Boolean evaluation of 
other objects in the scene. Ex: Hide MyImage if Text1 is empty. 

Example Scene Tree where the Auto Hide effect is placed on the Image object: 

​
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There are three modes for Auto Hide 

●​ Hide on Target Empty 
●​ Hide on Target Not Empty 
●​ Hide on Condition 

 

 

In the first example the Image object will hide if Text 1 is empty and in the second example 
the Image object will hide if Text 1 is NOT empty: 

 

Note that the “Condition” property will always show you what the actual condition is that will 
be evaluated. The condition property will only be enabled when “Hide on Condition” is 
selected allowing the user to manually create a condition. 

Hide on Condition allows the user to manual insert a statement that should evaluate to 
TRUE or FALSE is satisfy the Auto Hide condition. 

​
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Auto Scale 

The Auto Scale effect can be used to scale text within its bounds. This is a useful feature for 
bullet point graphics. 

 

 

 

​
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Auto Spacing 

The “Auto Spacing” effect can only be applied to Groups. Objects within the groups will be 
linked. 

Alignment Type 
o​ Tight - Objects are tightly positioned side by 

side.​
Additional space defined by attribute Spacing 
is added. 

o​ Fixed - Objects are placed at fixed pitch.​
The object size has no effect on positioning.​
The pitch is defined by attribute Spacing. 

o​ Justified - Aligns the row to the left and to 
the right at the same time. The margins are 
[0, Line Width]. The minimal spacing 
between objects is defined by attribute 
Spacing 

 

Direction 
o​ Horizontal - Objects are positioned horizontally from left to right. Only X 

coordinate is modified. 
o​ Up- Objects are positioned vertically from bottom to top. Only Y coordinate is 

modified. 
o​ Down - Objects are positioned vertically from top to bottom. Only Y coordinate is 

modified 
 
Line Width- Defines maximal size of row/column.​
When total size exceeds this limit then the objects are scaled down.​
Size of objects before pivot is not counted for the size 
 
Spacing- The value defines pitch or additional space. See Alignment type. 

 

​
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Billboard 

Billboard effect allows you to define the rotation of an object(s) within your scene 
towards a specified camera 
Transform 

●​ Rotation: Sets additional rotation which 
replaces rotation overridden by Billboard 
effect. 

Billboard controls 
●​ Type 

○​ Planar: Rotates the object in the 
direction parallel to the camera 
view vector. 

○​ Directional (default): Rotates the 
object in the direction towards the 
camera position. 

●​ Target: Selects target camera for billboard effect. If empty, the object is rotated towards  
the active camera, which is the default target for billboard effect. 

○​ Rotate X: If checked, rotates the object in the X-axis towards the camera (default 
true). 

○​ Rotate Y: If checked, rotates the object in the Y-axis towards the camera (default 
true). 

○​ Rotate Z: If checked, rotates the object in the Z-axis towards the camera (default 
false). 

○​ Keep size: If true, maintains the size of the object normalized regardless of how 
close it is to the camera.  The normalized size is the size that the object appears 
at when its Z position is at 0, and the camera is at its default Z position (default 
false). 

 

 

​
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Blur 

Motion Blur: Performs a blur in one direction or two opposite directions based on the 

desired Angle 
Compound Blur: Uses Level of Detail and neighbor pixel sampling to perform a blur in all 
directions 

 

 

 

 

 

 

 

 

 

 

 

​
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Camera  

Scene cameras can be added to the scene group only. Scenes can have multiple cameras. 

All properties of the Camera effect are keyframable. 

Projection 

​ Perspective: 

​ Orthogonal: 

Rotation Type 

​ XYZ: 

​ Pan, Tilt, Roll: 

Field of View 

Transform 

​ Position: 

​ Rotation: 

 

 

 

​
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Character 

The “Character Effect” allows animations to happen one character, one word or one line at a 
time.  A character affect may be applied to a Text object only. 

 

This adds a “Character to the canvas to allow you to create a character effect.  The character is 
only in the canvas for editing purposes. 

 

When the character is selected, the property editor for the character animation is displayed.  

 

Mode 
●​ Character – Each individual character will animate 
●​ Word – Each word will animate as a group 
●​ Line – Each line will animate as a group.  

​
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Animation 
●​ Total Duration - Sets the duration of the animation regardless of the length of the text 
●​ Duration Between Elements - Set the time for each character. 
●​ Reverse - This will reverse the animation. 
●​ Random- Elements will be animated in random order 

 

Next Add a Transition to the Timeline Editor: 

 

Next create any type of animation on “Character 1.”  For example, a 360 degree rotation on the 
Z axis: 

​
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When this transition is played or previewed each character will rotate individually 360 degrees. 

 

 

Chroma Key 

The chroma key effect allows users to remove chromanace for an object. 

 

Color: The target color to make transparent 

​
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Gain: The hue threshold for the target Color.  Increasing this value will make colors similar to 
the target Color also transparent 

Softness: Sets pixels within the gain threshold to semi-transparent. 

Shape: Linear to non-linear softness value adjustments 

Despill: Removes some of the key color from the remaining pixels. 

Matte: Shows the alpha values as grey scale. Select this option to fine tune your key. 

 

 

 

Shows various softness shape graphs. 

 

 

​
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Clip Plane 

The Clip Plane effect allows for clipping in a single direction:  Left, Right, Top or Bottom. 

 

*There is a limit of 6 clipping fields in one single render path. ​
​
Transform - Allows positioning and rotation of the clip plane 

Clip Plane - Select the direction of the clip plane 

Feather - Applies soft edges to the clip plane 

Center Feather - Centers the feather of both the fill and shadow of the parent graphic.​
​
 

​
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Crawl 

The Crawl effect will cause all objects, including any child objects, to crawl Left or Right,  

Selecting the Crawl effect creates a Crawl Box.  In order for an object to be seen crawling, it 
must be inside the Crawl Box.  The Crawl Box is similar to a crop box. 

The crawl effect has two modes: 

1.)​ Crawl from Text file or Select a Resource Data Object (This mode is automatically 
entered if a file is selected) 

2.)​ Crawl from data (No file selected). Data source could be a control panel text box.​
 
The “Data File browser” will show Text files and Data Objects in the Scene resource tree. 

 

​
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The spacer is only applied in “File Mode” 

The spacer property can be an image, Text (Type text into the File drop down box) or a Render 
to Texture Group 

With a Render to Texture Group all things can be crawled like 3D objects, Live video input etc. 

​
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Texture 1 in this example is an image, Text and a 3D spinning logo. 

​
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The direction property allows crawling in 2 directions 

 

 

​
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Crawl Commands 

 

None: The crawl will remain in its current state 
 
Update: Crawl the data already in the 
associated text box 
. 
Restart: Starts the crawl from the beginning of 
the data 
 
Start: Start crawling the data 
 
Stop: Stops the crawl and clears it 
 
Pause: Pause the crawl in position 
 
Resume: Resumes the crawl from the current position. 
 
Clear: Clears the crawl  
 
CrawlSpacer:  Only displays the spacer in the crawl 
 

Note: Only None, Update, and Clear will be available a data source is not present.   

 

 

​
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Crawl Events 
Crawl events occur when specific conditions 
are met.  The occurrence of an event depends 
on whether the crawl is associated with a text 
file or not. 

 

Start of line  
Occurs as the data enters the crawl 
box 

End of line  
Occurs when the data exits the crawl box 

End of file  
Occurs when the last piece of data has 
been crawled when associated with a 
text file. 

End of data  
Occurs when there is no more data to 
crawl from an associated text file 

​
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Crop 

Crop is a “Crop box” that allows cropping in 4 directions: Top, Bottom, Left and Right. 

Each Crop effect is made up of 4 clipping planes. There is a limit of 6 clipping fields in one 
single render path.  

 

Transform - Allows positioning and scaling of the crop 

Surface - Sets the surface size of the crop box 

Crop - Select the sides of the crop box 

Feather - Applies soft edges to the crop 

Center Feather - Centers the feather of both the fill and shadow of the parent graphic. 

 

 

​
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Duplicate 

The Duplicate Effect’s intended use is to be a quick method for building a data bound table 
graphic in a fraction of the time. Best practice is to apply the Duplicate Effect at the group level, 
where a group with contents is duplicated.​
​
Best Practice: Use Data Object to bind to a Table Resource and then enable Bind to Table 
within the Duplicate Effect. Under Table - Select the same Table Resource bound to data. Data 
bound to Table will automatically row pop, and advance to the next row of data on each 
duplicate. This will save designers hours of time previously spent individually linking each cell to 
the corresponding data source.​
​
*It is recommended to make changes to the Group (parent) where the duplicate effect has been 
applied. If you are adding objects to the group or adding new bindings then revert the duplicate 
number to 1, apply changes and then increase the duplicate count to desired number to 
regenerate the duplicates. 
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ID - Name of scene tree object which contains Duplicate Effect 

Count - # of times Duplicate Effect replicates the object ID within the Scene Tree​
​

 

Copy Number - child Duplicate Effect identifier 

Bind To Table - Drop down will display table resource available in scene 

Table - Select table you want to bind to 

First Row - Will display data from Table’s first row 

Row Number - Will display data from selected row number in table 

Parameters 

●​ Add & Remove 
○​ Only available if Bind to table is deselected​

*If Bind to table is selected these controls are grayed out and not active.​
 

●​ Bindings - Bind any object properties to a parameter​
*Bindings can be set even when Add & Remove are grayed out. 
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Grid 

 

The Grid effect will subdivide or duplicate the child graphic into multiple graphics depending on 
the Rows and Columns properties.  The segments can then be modified and animated 
individually using the Transform, Surface and Grid properties on the Grid effect. 

A vertical or horizontal blind look can be created by setting Rows or Columns properties to 1 
and the opposite property to the desired number of blinds. 

The Grid effect can only be applied to a subset of objects: Image, Cube, Sphere, …  Other 
graphics including Clips, Video Input and Groups can still be affected by the grid effect by using 
a Render To Texture effect on the desired graphic, then adding a Grid effect to an Image object 
that has its File property set to the render to texture output 

​
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Transform and Surface properties work the same as those in Graphic objects other than they 
affect the individual segments created by the Grid effect. 

Grid Mode – used to set whether object is Subdivided or Replicated into rows and columns 

Columns – number of columns to create 

Rows – number of rows to create 

Spacing – used to set and animate the spacing of the segments.  1.0 is normal spacing.  0.0 is 
all segments on top of each other. 

Mirror Rotation – used to set opposite rotation values in X and Y for half of the grid segments 

Animation Mode – used to determine the order in which grid segments are animated.  
Currently only Linear is supported 

Angle – the direction in which grid segments are animated 

Duration – used to add an amount of time between starting the animation of the first grid 
segment and the last grid segment to create a staggered animation effect.  Set to 0 frames for 
no stagger 
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HDR 

High Dynamic Range 

Constant: No change in the curve just add more value to the 
existing range. 

 

 

 

 

Linear: 1=No change. 2 would be 0 to 200% 3 would be 300% etc. 

 

 

 

 

 

Squared: Curved Graph. Brighter areas become more bright. Darker 
areas are not as affected as much. 

 

 

 

 

Cubed: Same as squared but with a more severe affect. 

                 

​
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JavaScript  

Java Script Effect can be applied to any scene Graphic Object. ​
​
Java Script Resource can be applied to the Scene, Project, and Application levels as well as 
Master Control Panels. 

To import an existing JavaScript navigate to script file.  

 

To add or edit a JavaScript select the edit pencil icon. This will open the Scripting panel within 
Prime. From here, you can Execute and Halt scripts for testing.  

 

Press the Save icon to save any edits to the script.  

​
​
251 | PRIME 5.3 User Guide  



 

 

Mode: 

●​ Asynchronous - runs the script in the background and returns immediately to the context 
calling the script​
 

●​ Synchronous - blocks execution until the script is finished, or until the Timeout duration is 
elapsed 

Timeout: The duration of time in seconds that scripts in Synchronous mode will execute before 
timing out​
​
Execute on Load: Option to enable “Execute on Load” for Script to evaluate upon Scene load 
in Prime playout.  

*Please Note - Starting in 4.10.1, when Synchronous and Execute on Load are both enabled, 
the Script will complete before the rest of a scene is loaded.  
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JavaScript Local Parameters: Press Add to remove Parameters to a JavaScript Effect. Any 
Parameters added to the JavaScript effect will be saved with the effect itself. Option to bind any 
scene object to the JavaScript parameters.  

 

JavaScript Advanced Options: (settings are saved with the script) 

Enable XMLHttp Request: Allows you to download data 

Enable Window Functions: allow you to pop up windows.​
For example - alert, confirm, prompt and message boxes. 

Enable Extended Host functions: Enable for TCP clients, and other advanced objects. 
Without these checked functions, Prime is kept in a Sandboxed mode.   
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​
JavaScript Keywords, Properties, and Objects 

Further documentation can be found within the PRIME_JavaScript_User_Guide 

 

 

​
​

 

​
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Inline Text 

The Inline Text effect can be added to Group objects only. When added to a group object the 
objects within the group will no longer be part of the composited objects in the scene tree 
meaning that group stands alone. The object within the group are cached in memory and can be 
referenced as text tags in the Text Object. Text tags start with a backslash and are terminated 
with a semi colon. The letter “o” is an indicator that this is an “Object” tag followed by the name 
of the object. This method is the same as “Style Tags”. Refer to the “Style Effect”. 

Example: Hello\oImage1; 

 

The benefits of this approach is the objects can be animated individually. So, a crawl can have 
an animated Cube for example. A crawl “Trigger” can trigger an action that animates any of the 
objects in the “Inline Text” group. 

 

Light 
Type: Point or Directional 

Diffuse: Light color 

Ambient: Ambient color applied to the material 

Specular: Specular color applied to the material 
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Logic 

The Logic effect is a collection conditional and property statements which are applied to a 
Graphic Object. It is similar to Conditions but the statements are targeted to a parent object and 
its children.  Logic has the flexibility to be reused in a scene saving the designer time when 
creating similar statements. 
 

Logic Properties Controls 

 
 

●​ File: Shows the last loaded or saved Logic effect file (.PLE).  
o​ Asset Browser Control: Load .PLE file into existing Logic effect 

 
●​ Save (Button): Saves Logic effect to existing or new file.  By default 

the .PLE  files will be saved to the Scripts folder in the project 
directory. 

o​ Save 
o​ Save as 
o​ Reload From Disk: Remove changes and reloads the file. 

 
●​ Evaluate: Applies or Evaluates Logic Effect in Designer 

 
●​ Evaluate On Parent Changed: Applies the Logic effect to parent’s default property 

changed event. 
o​ The binding is internal and is not shown in Object’s Events Control 
o​ Example:  If Logic effect is applied on Text Object. The Logic Effect will bind itself 

to the TextChanged Event. So whenever Text is changed on Text Object and the 
Logic effect statement will evaluate. 

 
 
Logic Effect Parameters 
Parameters are variables that can be used to store information like color, strings, integers, etc. 
Parameters can be accessed in conditional and property statements.  

 
 

Parameter Changed Events:  Logic parameters utilize Changed Events that can be used to 
trigger other types of commands and in methods in scene.  The example below shows the 
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“Home Team” parameter triggers the Logic effect to evaluate when the value of the parameter 
value changes.  
 

 

Evaluating Logic Effects 
Similarly to Conditions, Logic effects should be told when to evaluate during playback.  Evaluate 
commands can be accessed in event lists.  This is an example of a Logic effect being evaluated 
on the Effect In event.   

 

This method of evaluating Logic effects is in addition to the Evaluate On Parent Changed 
property previously mentioned.   

 

Logic Effect Statements Editor 
●​ Statements can be constructed by dragging object properties from the Property Pane 

(similar to Conditions).  Users can also type statements with the assistance of PRIME’s 
auto-complete tool. 
 

 

Users who wish to reuse a Logic file in the same scene should consider giving graphic objects 
the same name.  For this to work, objects must be placed in separate groups.   
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In the example below, a scene contains objects with identical names.  The objects are contained 
in different parent groups with a Logic effect applied to the group, and both Logic effects are 
using the same .PLE file. 
 

 
 
The statement contained in the .PLE file states that if “Text 1” is empty “Image 1” will be 
disabled. Since both parents groups contain child objects with identical names the applied Logic 
file will evaluate exact same.   
 

 
 
 
Additionally, the Logic Effect can be written to address the Parent it is applied to. This would 
allow for the names of the objects to be unique while still giving the benefit of duplicating the 
Logic. In the example below the same Logic Effect is applied to 3 different text objects. As the 
statement uses Parent.Text the object name does not matter, the logic statement will be applied 
to its parent object. 
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LUA 

LUA scripts are scripts that run at a low level inside the 
render engine on a frame by frame basis unlike VB or 
C# scripts which run at a high level outside the render 
engine. 

LUA Script code can be written in PRIME by adding a 
LUA Script Effect. They can be embedded in the scene 
or saved out as “. GEF Effect Files”. These GEF files 
can be assigned to the LUA effect. The LUA property 
editor will show attributes defined in the LUA file; these 
attributes appear as properties of the LUA effect and 
can be keyframed on the timeline. 

 

The edit button allows for the script to be edited and then saved 
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Mask 

PRIME allows for two types of Masks: Layer or Group. 

 

Layer Masks  

Consist of “Sources” and “Targets” and can be assigned a “Channel” 

“Soft Mask” settings allow you to blend between both the target and the source. 

Layer Masks can be Hard (Stencil) or Soft. When Soft Mask is not checked, Hard (Stencil) Mask 
is being used.​
​
**Please Note - Designers should not use both a Soft and Hard Mask on the same Mask 
Channel. Mixing and matching different Mask modes will result in unintended behavior of the 
software. Mask modes should always match with their associated parent/sibling layers. If a 
designer attempts this, PRIME will present a warning.​
​
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There is a limit of 7 concurrent masks per channel for hard masking and 127 per channel if soft 
is enabled.  

A single target can only be the masked target of 8 total layers. If more than 8 layers are used on 
a single target, the first 8 effects with the mask layer effect will still mask. Any layer effects after 
that will not mask. You can have multiple objects use the same layer 

With multiple Hide Targets, any part of the source that is covered by a target will be hidden

 

With multiple Reveal Targets, ONLY the places where all of the targets intersect will be 
revealed.  

 

Layer Mask scope: 

●​ Global masks will affect any other Global masks. Scene masks will only affect other 
●​ Scene masks in the same scene (or base scene) 
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Group Masks 

Group masks will mask everything within its parent group and has no notion of “target and 
source”. ​
​
Mode: Hide/Reveal​

​
​
Soft Value:​

​
 

​
​
262 | PRIME 5.3 User Guide  



 

Material 

Materials can be applied to various scene objects.  The material effect controls double as an 
editor that can be used to manipulate the current effects properties.  It also has the capability of 
saving material effects for future use.  Saved materials can then be applied later to other scene 
objects.  A preview of the material is supplied to show the user the result of the created material 
effect. 

Faces 

Preset 

 

●​ The file that was saved or is being created.  Any saved materials can be chosen 
from this control​ ​  

Color 

 

●​ Diffuse 
●​ Emission 
●​ Ambient 
●​ Environment 
●​ Specular 
●​ Shininess 
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Diffuse 

Diffuse lighting is used to simulate re-emission from a surface where the re-emittance isn't 
"ordered"(that is, the re-emitted light is diffused). 

 

Texture 

Intensity 

Offset 

Repeat 

Wrap 

Contrast 

Gamma 

Saturation 

LOD Bias 

Invert 
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Specular 

A specular highlight is the bright spot of light that appears on shiny objects when illuminated  

 

 
Texture 

Intensity 

Offset 

Repeat 

Wrap 

Contrast 

Gamma 

Saturation 

LOD Bias 

Invert 
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Normal 

 

Texture 

Intensity 

Filter 

Offset 

Repeat 

Wrap 

LOD Bias 

Invert 

 

 

 

​
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Environment 

Environment lighting adds light to the scene as if it came from a sphere surrounding the scene. 
The light is usually colored using an image called an environment map. An environment map 
can match the lighting (and reflections) in a scene to a real-world location, or may simply be 
used to add interesting variation to the scene’s lighting. 

 

​
​
Texture 

Intensity 

Filter 

Offset 

Repeat 

Wrap 

Contrast 

Gamma 
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Saturation 

LOD Bias 

Invert 

Occlusion 

Ambient Occlusion is a sophisticated ray-tracing calculation which simulates soft global 
illumination shadows by faking darkness perceived in corners and at mesh intersections, 
creases, and cracks, where ambient light is occluded, or blocked. 

 

Texture 

Intensity 

Filter 

Offset 

Repeat 

Wrap 
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Gamma 

Contrast 

Saturation 

LOD Bias 

Invert 

Reflection 

 

Intensity 

Color 

Bias 

Fresnel 

Refraction 
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Intensity 

Color 

Bias 

IOR 

Function 

 

Multi Style 

The Multi Style effect is a user-friendly way to allow a single text box to display two separate 
styles. The Multi Style effect is predicated on having existing Styles available to your scene 
already. Refer to the “Effects->Style” section. 

In the first screen shot I have a simple scene with a single Text object, one “Style effect” placed 
on the Scene object, and one “Multi Style” effect placed on the Text object itself. 

The second screen shot is the “Style Effect”. See the “Style Effect” section in this guide. 

The first text will use the style defined by the Text object itself and the second piece of text will 
use the style defined by the “Style Effect” placed on the scene object. As a note the “Style 
Effect” could have easily been placed on the text object as well. 

 

 

 

​
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Select the Multi Style effect to show its Property Page. 

 

Now select the style you wish to use and enter the text for each to get the desired result. 

The Styles available to the Multi Style effect will enumerate in each of the “Style” drop down 
combo boxes. 

 

 

​
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The Multi Style Text objects function the same way as a single Text object. Each can be bound 
to any data source like the Data Object or XMP or as a replaceable for automation or 
Replaceables in LUCI. 

You can drag and drop each into the Replaceables for instance. Drag the Text 1 label from the 
Multi Select effect into the Replaceables window to expose this object to Automation. 

 

 

 

​
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Binding with XMP: 
Binding with the Data Object​
​

 

 
​
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Page Turn 

The page turn effect can be applied to any object. 

 

Transform 
​ Position 
Surface 
​ Size 
Page Turn Properties 
Angle 
Inner Radius 
Diameter of the roll (at the start of the roll) 

Outer Radius 
Defines how tight the roll is. With a higher value (greater then Inner Radius) there will more 
space between the layers of the roll. 

Tessellation 
Number of points per width and/or height. 

​
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Factor 
Value from 0 to 1 define roll process​

 

​
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Parameters Effect 

 

The parameters effect is intended to be used in parallel with the table resource. Best practice is 
to apply the parameters effect at the group level, where a group is duplicated. For example if 
you have a table of statics information and have designed your template with multiple rows that 
are individually grouped. Apply parameters effect to Row 1 Group, and the copy/paste for 
additional iterations, Row 2 Group, Row 3 Group ect… 

Parameters Properties 

●​ Parameters Effect name: updatable alphanumeric text field 
●​ Table 

○​ Bind to table: Drop down will display table resource available in scene 
○​ Row Number: Will display data from selected row number in table 
○​ Query: Custom Query for selecting data 

■​ Apply: Select to evaluate query 
■​ Reset: Column values will rest to default values 
■​ Apply on change: Enabled by default  

●​ Parameters 
○​ Toolbar 

■​ Add & Remove 
●​ Only available if Bind to table is deselected 
●​ If Bind to table is selected these controls are grayed out and not 

active  
​
​
276 | PRIME 5.3 User Guide  



 

○​ Bindings: Bind any object properties to a parameter  

 

​ ​ *use semicolon between objects if binding to more than one object 

 

 

​
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Photoshop Import 

Photoshop Import feature for ChyronHego Prime 
 
The PSD effect allows the user to import photoshop files (.psd) into prime. Photoshop layers are 
imported into PRIME as individual PRIME scene objects. The PSD effect can only be applied to 
a PRIME “Group” object. All PSD layers are imported into this PRIME “Group” object and can 
then be treated as native PRIME objects. 
 
Basic usage -  Add PSD effect on a group object. Select a psd file in the file box and press the 
‘Import button’. Import button acts as if checkboxes ‘Reset Layer Position on Update’ and ‘Clear 
Group Before Update’ were checked. It imports individual layers from PSD file into PRIME. 
 
Checkboxes:  

●​ Reset Layer Position on Update - resets coordinates of layers on Canvas based on the 
PSD file. 

●​ Clear Group Before Update - removes all objects from the group with the selected PSD 
effect. 

●​ Add Crop Effect - adds crop effect to the group. 
 
Update button usage - using the update button will not render images that were previously 
rendered, thus it can import the psd file quicker - this only works if you're using the same psd file 
multiple times. The update button will also import any new changes from the psd file.. This can 
be done using Import button as well, but that will automatically reset the layer coordinates and 
re-render all layers. 
 
Text drop-down menu usage - if the psd file contains text layers, the drop down menu contains 
three ways of how to deal with text: 

1.​ Image Only - the text layer will be imported as an image. 
2.​ Text Only - the text layer will be imported as a text object. 
3.​ Text With Disabled Images - the text layer will be imported as a text object and it will also 

be rendered as an image. The image will be disabled. 
 
When using an option where a text object is created, the basic text information from the PSD file 
will be transferred to PRIME if found, including: the text value, font name, font weight, font size, 
font color, kerning, alignment and whether the text is all caps. The positioning of the text can be 
a little off due to differences between PRIME and Adobe Photoshop. 
 
PSD effect properties 
 
File - Image browser same as in Image Object allows you to either select a file or import it into 
project images folder.  
 
Currently supported PSD elements: 
PSD effect is able to import psd files that use 8 bit depth color mode and Rle image 
compression. 
​
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PSD effect supports importing layers, masks on layers, groups, masks on groups. Supported 
attributes are opacity, open/closed folders, visible/invisible layers. 
Text supports both basic dropped shadow and outline PSD effects. Image supports only basic 
dropped shadow PSD effect. 
To get the best results, it is recommended to apply effects and clipping masks in Photoshop 
before importing. 
​
​
 

 

​
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QR Code 

The QR code effect allows users to assign QR properties to specific objects like Images. 

Overview 
QR Code effect allows users to create a QR code from URL or plain text. Once it’s created, they 
can bind it to an image, or a texture of a graphic object.  

QR Code properties controls  
●​ Size: QR Code size can be adjusted 

in the Surface section of the property 
editor. 

●​ Update (Button): Updates QR Code 
manually. 

●​ URL (TextBox): Contains a link to the 
webpage QR Code represents. 

●​ Error Correction (ComboBox): QR 
Code has error correction capability to 
restore data if the code is dirty or 
damaged. Four error correction levels 
are available for users to choose 
according to the operating 
environment: 

○​ Low 
○​ Medium 
○​ Quartile 
○​ High 

 Raising this level improves error 
correction capability but also 
increases the amount of data QR 
Code size. 

●​ Foreground and Background 
(ColorPickers): Colors can be adjusted 
in classic Prime Color Pickers. 

●​ File Name (TextBox): By default generated from URL, but custom name can be used if 
Update File Name from URL is unchecked. 

●​ Folder (TextBox):  allows users to change the name of the folder which is stored in the 
project’s Images folder. 

●​ File (TextBox): Non Editable, shows a path to the QR Code file. 
●​ Update File Name from URL (CheckBox): controls if File Name is generated 

automatically from URL  
​
​
280 | PRIME 5.3 User Guide  



 

●​ Update on Change (CheckBox): Determines if QR Code should be updated on any 
given property change or if it has to be updated manually by pressing the Update button. 

Binding controls 
●​ Target (TextBox): contains a path to the 

property which should be overridden by 
QR Code. 

●​ Auto Update Parent Size (CheckBox): 
Controls if the target object’s size should be inherited from QR Code. 

●​ Reload on update (CheckBox): Determines if target object should be reloaded when 
QR Code is updated. 

 

All QR code effect properties are specific to industry standard QR codes. 

 

Render to Texture 

 

ID- User friendly name to refer to this group. This Id will show up in the images browser 
as well. (The texture is also accessible under file name --render: ID -- or --render: channel / ID --) 
 
Resolution-Texture resolution. Can be used to render smaller texture when full size 
would be too large.​
Having smaller texture can have positive effect on performance.​
The resolution of one RTT name should be consistent among all RTT effects in the 
scene. 

●​ Full - Texture resolution and antialiasing is the same as used in the main frame 
buffer. 

​
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●​ Half - Texture resolution is 1/2 of both width and height of the main frame buffer 
resolution. 

●​ Quarter - Texture resolution is 1/4 of both width and height of the main frame 
buffer resolution.​
Antialiasing is disabled. 

Render Order- Render order of this texture among other RTTs.​
Lower number is rendered first.​
When undefined then the implicit order is given by depth of this effect in the scene.​
Do not mix explicit ordering with implicit ones at the ordering relationship is not obvious. 
 
Keep Transformation- By default (Off) the transformation applied from scene root to 
this object is reset.​
It mimics the rendering to empty frame buffer.​
Set to On to keep position/rotation/scale transformations applied to all parent nodes. 

​
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The “Render to texture” effect is a special effect that can be applied as a surface to objects. 

Typically, you will apply a “Render to Texture” to a group of objects. Once a “Render to Texture 
effect is applied to a group the group is no longer part of the scene tree although it appears to 
be. This “Render to Texture” group will then be available in the “Images” folder and be used as a 
Material on another object. 

In this scene tree example, the “Render to texture” effect is applied to Group 1. 

The cube has a “Material” effect applied to it. The Material effect is the “Render to texture” and 
is named “Texture 1 and appears in the image browser. 

Note: The Group Name of the render to texture Group will be italicized to indicate this group is a 
special “Render to Texture” group. 

 

​
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Example output: 

​
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Roll 

Refer to the “Crawl Effect”. A Roll is a vertical crawl. Crawl_Effect 

 

Roll Crawl 

The Roll Crawl effect animates an object using both the Roll and Crawl effect combined. The 
Roll effect is animated first followed by the crawl effect. 

Ex: Text can roll up from off screen to its set position and then begin to crawl. 

​
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●​ Animate behavior –  
o​ Always Crawl off-The crawl effect will always execute 
o​ Roll Off if it Fits: Only execute the crawl effect if the text does not fit into the 

bounding box otherwise roll off 
​
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●​ Roll Duration – The duration speed on to off and off to on 
●​ Roll Wait Duration – If the off effect is a roll (Roll off only if it fits mode) Wait time before 

next roll off begins. The Time the object is static on air. 
●​ Crawl Wait Duration – – If the off effect is a crawl (Based on animation behavior) Wait 

time before next crawl off begins. The Time the object is static on air 
●​ Crawl Ease Duration- Ease in crawl duration 
●​ Finish Fade Duration –If the finish offset is greater than zero the crawl will fade offset 

number of pixels from the bounding box edge. 
 
(For other property definitions see the “Crawl” effect section) 

 

​
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Scale to fit options 

Text Uniform Scale 

With the introduction of uniform scale we changed the word wrap options on Text Object’s 
property control and extended it with the option to uniformly scale in both horizontal and vertical 
directions. 

Text Uniform Scale Properties Control 
 

●​ Off - select this option to turn off any text word wrapping or 
scaling based on text bounding box size 
 

●​ Word Wrap - breaks text line into two if it is wider than text 
bounding box 
 

●​ Uniform Scale - when this option is selected text is scaled horizontally and vertically to 
fit into text bounds 

○​ It also sets vertical alignment to Top if it was set to First 
○​ Turns off Horizontal and Vertical Scale options if turned on 

Example 
        Text before Uniform Scale is applied                     Text after Uniform Scale is applied 

 

Auto Scale 

Auto scale effect is a tool that works together with adjacent text objects and allows a scene 
graphic with auto scale effect applied to target one of the texts and position and scale itself 
accordingly. This is especially useful when designing bullet graphics. 

 

​
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Auto Scale Properties Control​

 
 

●​ Target - dropdown that enables users to select from sibling text objects list (text objects 
in same group as an object auto scale is applied to) and specify target that an object will 
position and scale according to 

○​ By default target is first sibling text if it exists 
 

●​ Offset - offsets position of auto scaled object from its target 
○​ Default s to [-25,-25] 

 
●​ Scale X Offset - if enabled it scales down the Offset X value 

○​ True by default 
 

●​ Scale Y Offset - if enabled it scales down the Offset Y value 
○​ True by default 

 
●​ Scale Parent - if unchecked an object with auto scale applied will no longer scale itself 

according to target 
○​ Defaults to true 

 

 

​
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Example 
     A scene with Text 1 and Bullet 1 objects ​​    A scene with Text 1 and Bullet 1 objects  

    and no Auto Scale applied​​ ​         where Bullet 1 has Auto Scale 

​
Multi Scale 

Multi Scale effect was added as an extension tool for Uniform Scale effect and can be applied to 
group objects. If a group object contains text objects and Multi Scale effect is applied then all 
text objects in that group have Uniform Scale automatically enabled.  

Multi Scale Properties Control​

 
●​ Horizontal - controls horizontal alignment for the whole text group 

○​ Defaults to Left with other options Center and Right 

​
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●​ Vertical - controls vertical alignment for the whole text group 

○​ Defaults to Top with other options Middle and Bottom 
 

●​ Direction - allows to specify order of text objects in the group 
○​ Options Down and Up 

 
●​ Font Size - sets Font Size for all text objects in group 

 
●​ Leading - sets Leading on all text objects 

○​ Default value is 0 
 

●​ Threshold - higher the threshold is set more performance is gained but multi scale loses 
its precision 

○​ Text objects are scaled most precisely at value 0 
○​ Defaults to 1 

 
●​ Spacing - this property adds spacing between each text object in group 

○​ Defaults to 50 
 

●​ Scale Spacing - if enabled it scales down the Spacing value 
○​ Defaults to true 

 
●​ Update Width - if enabled it makes sure text objects in group are scaled horizontally 

according to the width of multi scale effect size 
○​ Defaults to true 

 
●​ Update X - if enabled text objects are repositioned according to multi scale effect x 

position changes 
○​ Defaults to true 

 

 

​
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Example 
 

 Group with 3 text objects without Multi Scale applied 

 
 

 Group after Multi Scale was applied, this example illustrates  
bigger spacing between text objects and horizontal  

alignment set to Center 

 

 

​
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Auto Size 

Auto size effect automatically calculates the size and  sizes its parent object based on other 
sibling objects in the parent group. This effect was designed to work in conjunction with other 
Scale to Fit Options. 
 

Auto Size Properties Control 
 

●​ Padding - this value controls the amount that is added to calculated size 
○​ Defaults to [0,0] 

 
●​ Update Width - if enabled it 

automatically adjusts the width of 
auto size parent object according 
to newly calculated extent of 
sibling objects 

○​ Defaults true 
 

●​ Update Height - if enabled it 
adjusts height of auto size parent 
object according to group extent 
 

●​ Hide On Empty - hides auto sized object if there is no content inside parent group 
○​ This can happen e.g. when all objects in group are disabled or there are empty 

text objects 
○​ Defaults to true  

 

​
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Example 
Multi Scaled group of text objects and Pod object 

without Auto Size applied 

 
Multi Scaled group of text objects and Pod object  

that has Auto Size effect applied 

 
 

​
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Shader 

Shader effects can be added to PRIME objects. They can be loaded and saved out as “. GEF 
Effect Files”. 

The property editor will show properties defined in the Shader file.​
All Shader properties are keyframeable.

 

​
Property Changed Events will be included. 

 

​
​
296 | PRIME 5.3 User Guide  



 

Style 

The Style effect allows multiple styles to be used within a single text object. The Style effect can 
only be applied to a group, including the scene group or any individual text object.  You can 
apply as many Style effects to each. 

In this example, the style tag will apply to all 4 text objects 

 

In this example the style tag applies ONLY to the Text 1 text object. 

 

Style properties: 

​
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Id: This is the name to be used in the text string that will change the inline Style 

Example: Text\tStyle 1;Text\t;Text 

Results in the following 

 

Font: 

​ Style: This list enumerates all of the Styles available for this project. These are user 
created style. See the Text Style Browser section of the “Text Object”. The Style can be edited 
and save here. 

Style Tag Format 
Backslash “t” starts the style tag notation followed by the Style Name ending with a semi-colon: 

\tStyle1; 

To revert the style back to the default style of the Text object leave the name blank; 

\t; 

​
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Style Sheets 

Style Sheet effects are a collection conditional and property statements which are applied to a 
parent object, in most cases this will be a parent group.  When a Style Sheet is evaluated the 
conditional statements are applied to the parent object and each of its children.  Only graphic 
objects and effects can be evaluated in a Style Sheet. Style Sheets run on when a scene object 
is updated. 
 
Style Sheet Properties Controls 
 

 
 

●​ File: Shows the last loaded or saved Style Sheet file (.pse file) 
o​ Asset Browser Control: load Style Sheet files into the existing Style Sheet 

effect. 
 

●​ Save (Button): Saves a Style Sheet to existing or new file.  By 
default, Style Sheets will be saved to the Styles folder in the 
project directory.  The dropdown consists of the following options:                                    

o​ Save 
o​ Save As 
o​ Reload From Disk: Remove changes and reloads the file. 

 
●​ Evaluate: Evaluates Style Sheet on the active Scene 

o​ Same functionality as the Evaluate button in the Logic window 
 

●​ Evaluate On File Changed: Automatically applies the Style Sheet to the scene when 
the .pse file is changed 

o​ This will evaluate the Style Sheet after the scene is loaded during playback. 
 

●​ Bind to Scene Style : Binds the Style Sheet File property to scene’s Style property 
o​ The binding is internal and is not shown in the scene’s Style Changed Event.  
o​ If the scene’s Style property is changed, the Style Sheet will load the .pse file 

with the same name as scene Style property value. 
o​ See Style and Style Changed Event for more. 

   

​
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In the example below, a morning news broadcast uses the scene Style “Morning”.  Because 
Bind To Scene Style is checked, the Style Sheet automatically loads “Morning.pse”.  With 
Evaluate On File Changed checked, “Morning.pse” will be automatically evaluated. 
 

 
 

Note: Evaluate On File Changed and Bind To Scene Style are saved to the Style Sheet 
object and not to the .pse file.  For instance, if “Morning.pse” was saved with Bind To Scene 
Style checked and “Morning.pse” were to be loaded with Bind To Scene Style unchecked, 
Bind To Scene Style would remain unchecked. 
 

 

​
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Style Sheet Parameters  
Parameters are variables that can be used to store Style information like Color, string, Int, etc.  
Parameters can be accessed in conditional and property statements.  

 
Notice the “ShowTag” parameter is being accessed in the property statement below. 

 
 

 
 
​
​
​
​
​
Style Sheet Events 
 
Parameters Change 
Add Triggers to listen to Parameter Change Event for particular Style Sheet’s parameter.  In this 
case the Data Object will update when the “ShowTag” value parameter changes. 
 

 
 
 
 
 
 
 

 

​
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Style Sheet Statement Editor 
 

 
 

Style Sheets can be edited, added and removed using Logic pane’s Style Sheet tab or in the 
Effects toolbox.   

●​ The Style Sheet statement editor supports conditional (If Else) as well as property 
statements  

o​ Triggering actions, conditions and other methods are prohibited in Style Sheets 
 

●​ Style Sheets can be created using With statements: 
o​ With statements begin with Dot “.” (ex. “.PositionX = 30) and attempt to evaluate 

if an object shares the matching property, in this case PositionX. 
 

o​ With statements are created by dragging keyframable properties from an object’s 
Properties Pane to Style Sheet Statement Editor. 

 
o​ With statements can also be typed but note that AutoComplete is not available in 

the Style Sheet Statement Editor.  
 

●​ The Type property can be evaluated by the type of object in the statement                 i.e. 
.Type = “Text”.  These can be constructed by dragging the object from Graphics Toolbox 
to the Style Sheet Statement Editor. 

 
●​ The Name property allow users to evaluate objects based its name.  These can be 

dragged from the Scene Tree 
 

●​ The Tag property has been introduced to each scene object and can be changed in the 
Properties tab.  Tags serve as an alternative to the Type and Name properties if users 
wish identify objects in batches.  Multiple objects can share the same tag. 
 

 
 

 

 

 

The following example shows a Style Sheet effect applied to a parent object, “GROUP HOME”.  
When the Style Sheet is evaluated it will evaluate over the parent object and all of its child 
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nodes.  The property statements will be applied to the corresponding child objects in the 
conditional statement. 

 

 

Similar to .Tag using .Parent is another method of applying the same statement to multiple 
objects. Using .Parent avoids addressing the object by it’s name as the statement evaluates 
against the Parent Object that the Style Sheet is applied to. 

 

​
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Table 

The Table effect can be used to duplicate a 
graphic multiple times with the purpose of 
binding multiple rows of a data source to 
the duplicated graphics.   

By default, the duplicated graphics will all 
appear in the same location.  An Auto 
Spacing effect, or some Lua effect with 
positioning logic must be placed higher in 
the scene tree in order to position the 
duplicated graphics. 

Row data is populated in the duplicated 
graphics by using the navigation 
commands in the Data object (Move Next, 
Update).  If the number of rows available in the Data object is more than the Row Count 
property, the additional data can replace the current data in the duplicated graphics by executing 
a Move Next on the Data object. 

Data Object – a Data object in Columns mode that contains the rows of data to duplicate 

Row Count – the maximum number of graphics to duplicate. 

Update In / Update Out – animations to play when new data is displayed or hidden 

Animation Mode – controls animation stagger when rows are animated 

Disabled – no stagger: all rows will animate at the same time 

Total Duration – rows stagger animation using the Duration property as the total duration 
from first to last 

Duration Between Rows - rows stagger animation using the Duration property as the 
duration between individual rows 

Direction – the direction of the animation stagger 

Duration – the duration of the animation stagger as specified in the Animation Mode property 
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Table Effect Example 

In the example to the right, a Table effect is placed 
on a Group that contains 3 Text objects and 2 
background Images.  This Group is then duplicated 
7 times as specified by the Row Count property on 
the Table effect.  The duplicated graphics are then 
spaced out evenly using an Auto Spacing effect.  
Each individual graphic is populated with its 
respective row from the Data object as specified in 
the column binding.  

​
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Texture 

Textures can be applied to various scene objects. Textures use the “Images” folder. 

Faces 
​ Only one face per texture 

Texture Properties 
 

Mapping: Texture wrap in X and Y dimensions. 
Method of texture application outside it's dimension. 
 
Wrap: 

Clamp - Edge pixels are repeated. 
Repeat - The whole texture is repeated. 

 

Filter: Texture filtering mode. 
Point - Pixel sampling, no interpolation. 
Linear - Linear interpolation. 

Mipmap - TriLinear interpolation of mipmap levels during minification. Linear 
interpolation is used for magnification. 
Mipmap Anisotropic - MIPMAP with enabled anisotropic filtering.​
♥This mode helps when texture get blurred because of viewing angle or 
non-uniform scale. 

 

LOD Bios 
Specifies a value that is to be added to the level-of-detail parameter for the texture sampling.​
This parameter has effect only for mipmap texture filtering.​
Value less than zero makes the image blurry. Value greater than zero makes the image sharper. 

Unit 
Texture unit. 

File 
File name which contains an image for texture. 

​
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Texture Matrix  

Texture Matrix Properties 
Offset: Offset defined in normalized 
coordinates. 
Scale Factor: Same as Pivot 

​Rotation: Rotation in degrees. See 
also Pivot attribute. 

​ Pivot: Rotation and scale pivot. 
Inverse: Setting true makes the 
transformation inverse.​
The inverted transformation makes 
it easier to understand and is similar 
to node transformation 

Touch 

​  

Properties 

​ Hit Test:  

●​ Geometry: Raise the touch event only when the object itself is touched. 
●​ Bounding Box: Raise the touch event when touch is within the bounding box of 

the object. 

Drag X: Allows the object to be dragged on X axis 

Drag Y: Allows the object to be dragged on Y axis 

Events 

●​ Touch Down: Triggered on touch down 
●​ Touch Up: Triggered on touch release (tap or slide) 

​
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●​ Touch Move: Triggers during drag 
●​ Tap: Triggers on touch up (not slide).  

o​ If the touch point is more than 3 pixels, then prime will assume this is 
a slide, not just a tap.   

o​ Tap threshold can be modified through Logic condition. For example 
Touch1.TapThreshold = 5​
 

Parent Visible: If disabled, parent object is not drawn but still available for picking 

Continuously Update Position: Enable real-time position updates while dragging 

 

Touch Setup: 

Use Windows Control Panel “Tablet PC Settings” found in the “Hardware and Sound” section to 
configure your touch screen device. 

 

Transform 

The Transform object allows you to add an additional transform to an object. This allows you to 
separate the transform of your object from your animations. Using the Transform effect reduces 
the number of groups you'll require to achieve the same result. 

Example: Add an image to a scene and position it. Add a transform effect to the image. Create 
an Action that animates the transition effect Position X. Now move the Position X of the image 
somewhere else in the scene and play the action again. The animation is the same and is 
relative to the position of the image. Being relative to the object it is applied to is the importance 
of a separate Transform effect 

Update Parent Bounds setting: Disabling this check box, prevents the parent object graphic 
bounds from applying any transform effect offsets. This behavior can be applied when Auto 
Follow Source mode and Transform effect are used together, and you want to avoid an auto 
follow update from effecting the Transform effect animation.      

​
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Transition 

Transition effects can be used to animate graphics from one value to another.  By default, the transition 

will occur when any child graphic default property changes (such as the Text property of a Text object, or 

the File property of an Image or Clip object), but can also be configured to trigger when child graphics 

are Enabled or Disabled, or when their Color changes. 

 

​
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There are two types of transition that can be applied to a group or Object: File or Custom.​
​

 

​
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File Based Transitions 

To create a new File Based Transition: 

 

This will open the Transition Editor: 

 

From this UI you can create transition effects. This UI begins with In and Out actions. 

There is a surrogate scene tree object named “Target”.  The target will be replaced by the actual 
scene object where the transition is applied. 

​
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Transition Properties: 

 

You can add many scene objects to the transition, like sound effects, flares etc. so you need to 
define the “Target Object” The Target object can be an Image object or a text object. When the 
transition is applied to a scene object it will inherit the “Target Objects’ properties. 

Saving the transition will allow it to show up in the transition browser. 

​
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To use a created transition: 

1.​ Within a Prime Scene, apply a Transition Effect from the toolbox onto an object​
Select the transition effect from the Scene Tree and the Transition Properties panel will 
be shown: 

​
 

2.​ Once a new transition is created it will show up in the browser. 

 

​
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3.​ Select the previously created transition from the browser.   

 

 

​
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●​ Preview 
o​ Hide - hides the content being transitioned 
o​ Out - plays the specified Transition Out Action 
o​ In - plays the specified Transition In Action 
o​ Show - shows the content being transitioned 

 
●​ Behavior - sets when the transition will fire. Your choices are “On Update” or “On 

change:” 
●​ On Update will fire for each update regardless if the data is the same or different. 
●​ On Change will fire ONLY on an update if the new value is different than the 

current value.​
 

●​ Duration - may be modified from its original value. This will allow for applying the same 
effect on multiple objects and creating a “staggered” effect. 
 

●​ Offset - Creates a Duration delay prior to the Transition playing 
 

●​ Out on Empty​
Performs the specified Out Animation when content is changed to an empty value​
  

o​ None - Out On Empty is disabled 
o​ Any - any object in the group blanked out will trigger Out 

▪​ (legacy behavior - version 4.4 and prior) 
o​ All - all objects in the group being blanked out will trigger Out 

▪​ (New behavior - version 4.5.0+) 
o​ *Please Note 

▪​ Scenes created before version 4.5.0 will be grandfathered to the Any option 
if out on empty was checked 

▪​ Scenes created in versions 4.5.0 or later will be set to the All option if out on 
empty was checked 

 
●​ Property Triggers 

 
o​ Default Property - If checked, the transition will be triggered when any child 

graphic default property changes (ie, Text property for a Text object, File property 
for Image or Clip objects…) 
 

o​ Enabled - If checked, the transition will be triggered when any child graphic 
Enabled property changes 
 

o​ Color - If checked, the transition will be triggered when any child graphic Color 
property changes  

 
 
 

​
​
315 | PRIME 5.3 User Guide  



 

Custom Transitions 

Custom transitions work the exact same way as file based except they require the transition to 
be in an existing “Action” in the scene. Simply choose your “In Action” and “Out Action”​

 

●​ Priority - specifies which graphic will be at the top during the transition: Incoming or 

Outgoing​

 

●​ In Action - specifies the animation(s) to play for the incoming graphic 

●​ Out Action - specifies the animation(s) to play for the outgoing graphic 

​
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Transition Event Properties 

Now you can modify the properties of the transition and hook up to its internal events.​
​

 

●​ Before Update - event is triggered before the transition occurs 

●​ After Update - event is triggered after the transition occurs 

●​ Finished - event is triggered after the transition finishes animating 

 

 

​
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Warp 

 

More information on Warp Clips can be found in the “Creating Warp Clips in After Effects CS6” 
user guide. 

 

Virtual Group 

This Effect is intended to be used in conjunction with AutoFollow Source Mode.  A Virtual Group 
effect can be applied to multiple objects in a scene, regardless of how they have been physically 
grouped together in the scene tree, to “virtually” group them together. The benefit of this is the 
effect will give the calculated values for the Left, Top, Right and Bottom of all objects within the 
virtual group.  

Example for using this effect: If you have a Full Screen graphic table, consisting of multiple rows 
and columns of data. The scene is constructed to animate each row individually. But the 
operator wants to change the amount of columns that display. Apply the virtual group effect to 
each text object, to create “virtual columns”. Then have each virtual column row autofollow the 
next. The virtual group will calculate the text field in the column that is the longest, making auto 
follow even easier. Essentially virtual groups will do math.max calculations, using the calculated 
property. 

​
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Virtual Group Properties 

Name: Naming convention must be exactly the same for any other virtual group effects that you 
want to reference within the same virtual group.  

ID: Read only, Prime’s reference name of the virtual group 

Parent: Left, Top, Right and Bottom values of the object the virtual group is applied to. Width 
and Height of the object the virtual group is applied to. 

Calculated: Left, Top, Right and Bottom values of all objects within the virtual group. Width and 
Height of all objects within the virtual group. 

References: List of all items within the virtual group. ​
​
*Please Note - Auto Spacing does not affect Virtual Group bounds. 

    

 

​
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XMP 

Adobe's Extensible Metadata Platform (XMP) is a file labeling technology that lets you embed 
metadata into files themselves during the content creation process. PRIME can bind to the data 
stored in Image files. 

 

Apply the XMP effect to an image object. If the Image contains XMP metadata, the data will 
appear in the XMP properties window: 

Notice the “Bindings” column. This is 
where you can drag and drop other 
object properties to bind the data. All 
Object properties are bindable like 
Color, opacity, Position etc.  

Users can alternatively type manually 
into this field to take advantage of 
PROME’s “Auto-Complete” feature as 
well. 

The Bindings field also allows for the 
use of Expressions.  

See the separate “Parameters & 
Expressions” document. 

​
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Example using an Expression: 

 

Using Auto-Complete:

 

 

In this example we will bind the image color: 

 

​
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XMP LUCI Workflow  

Any text, images or clip objects must be bound to a corresponding replaceable within Prime, to 
be visible and editable in the NRCS LUCI plug-in. In addition, for objects that are data bound to 
XMP, the replaceable must be flagged as databound.  

In the Replacables window there is a databound column with a chain link icon. Click in 
the empty row space of the replaceable column to turn on the databound icon for each 
object that is databound to XMP.       

 

If the databound column is not flagged for each object that is databound to XMP, then the 
corresponding XMP data will not be visible in the LUCI plug-in. 

​
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Example of databound XMP information visible in the LUCI plug-in

 

 

Unicode UTF-8 Region Setting for Character Accents 

XMP can fail to return character accents properly if Beta: Use Unicode UTF-8 for worldwide 
language support is not enabled within Windows.​
​
For example: without this setting turned on, cinéma would display as cinÃ©ma.​
​
To enable this setting, go to Windows Settings > Time & language > Language & region > 
Administrative language settings > Change system locale…, and check Beta: Use Unicode 
UTF-8 for worldwide language support. Reboot the PC for the change to take effect.  

 

​
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Resources 

 

 

Ancillary Data 

This resource provides the ability to change the routing of ancillary data on either horizontal 
(HANC) or vertical (VANC) intervals. This is commonly used for branding scenarios, when you 
have to squeeze back with 2 video sources and want to switch ancillary data (closed captioning) 
from source 1 to source 2.  

Select the SDI Input. 

 

​
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Both the Horizontal and Vertical Ancillary data selections are keyframeable allowing you to 
dynamically switch the source of your ancillary data. 

 

Audio 

The Audio object has three modes to choose from, Audio File, Text file and Text. 

Audio File 
This will be a .wav file or any other supported audio file. 

​
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●​ Commands 
●​ None: Do nothing 
●​ Play: Plays the associated audio file 
●​ Stop: Stops playing the associated audio file 

●​ Volume - Sets the volume level of any the associated audio file when played. The 
volume levels can be keyframed in the Timeline editor. 

●​ Channels - Sets the output channel(s) the associated audio file will play out to. 

​
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Finished Event: 

 

Any subscribers to this event will get notified and triggered. 

Text File 
A .wav file will be created based on the text file. This is “Text to Speech” 

Same holds true for “Text” mode. 

 

 

​
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Base Scene 

Base Scenes are scenes that can be referenced by other scenes. Consider Base scenes as 
parts and pieces that can be added to normal PRIME scenes. 

This is a very powerful feature of PRIME’s ability to reference scenes from within other scenes. 
The base scene allows for a basic building block. Example; Create a News Full Screen graphic 
as a base scene that all other Full Screen graphics will reference. The Base scene should 
contain all the graphical elements, transitions and logic that all Full Screen graphics will share. 
Link the base scene to all the other Standard” scenes. If you have 100 Full screen graphics, all 
100 can reference the “Base Scene”. Changing anything in the base scene will reflect to all 100 
scenes. 

You can add as many Base Scenes to a normal scene. Base Scenes can be created using the 
“File-> New Base Scene” menu item. Base Scenes are no different than normal scenes except 
they are tagged as “Base Scenes” and can be included in normal scenes. 

Additionally, the communication from the standard scene to the “Base Scene” is built into 
PRIME’s “Trigger List: The Standard scene can trigger Actions and Conditions to its “Base 
Scene” as seen in this Triggers list screen shot: 

 

​
​
328 | PRIME 5.3 User Guide  



 

 

BXF-Broadcast Exchange Format- As Run Files 

PRIME allows users to create “As Run BXF Files.” 

To configure the BXF Global settings, select “BXF” from the PRIME main “Settings” menu: 

 

●​ Enable BXF As Run Logging – Toggle the box on/off to enable/disable BXF As Run 
Logging  

●​ Output Directory – Specify a system location to store the BXF As Run Logging files 
●​ As Run Channel Properties: Name – Specify a name for the BXF As Run channel 
●​ As Run Channel Properties: Description – Enter a short description for the BXF As 

Run channel 
●​ As Run Device: Device Name – Specify a name for the BXF As Run Device 
●​ As Run Default Length: Frame Margin – The default length settings allows a margin 

for error when the asset is played out. 

Ex: If a sponsored logo is set to air for 15 seconds, it will be considered “Aired Without 
Discrepancy” if it airs for 14 seconds and 15 frames due to the Frame Margin being set 
to 15 frames.  If the logo airs for 14 seconds and 14 frames, the BXF file will be reported 
as “Aired With Discrepancy.”   

 

​
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To add a BXF resource to your scene and configure its Properties: 

 

 

●​ Name – Object name to be referenced throughout the 
scene 

●​ Enabled – Enable/disable this object 
●​ Type – Map this to the type defined in your traffic 

system 
●​ Target Object – Object in the scene this BXF refers 

too 
▪​ Start/End Keyframe – Start/End 

keyframes that brings this on/off air 
●​ Event Notes – User friendly notes 
●​ House Number – Match the traffic system house ID 
●​ Name – Traffic system name for this House ID 
●​ Genre – Type in a genre for this House ID 

●​ Description – User friendly description 
●​ Default Length –  Minimum duration on air this items is required to air 

When the action to bring in the sponsored logo is played a BXF file will be created in the folder 
defined in the global settings. 
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Clip Player 

The Clip Player resource allows users to have access to any “Clip Controllers” defined in the 
PRIME Playout Configuration: 

 

Player: Enumerates the clip players defined 
in the PRIME Playout Configuration “Clip 
Players” section. 

Each clip player has an output channel and a 
layer number assigned to it. (Program 
Channel 1, Layer -5) 

File: Associates a clip to this player 

Command: These commands control the 
clip player and can be keyframed. The Clip 
Players commands are automatically added 
to Primes “Trigger List” for access 
everywhere. 

Cue on Scene Load: When the scene is 
loaded into preview cue the clip. 

Play on Scene Play: When the scene is taken to air play the clip. 

Stop on Scene Stop: When the scene is taken off air stop the clip 

 

Clip Player Events: 

Allows triggering items from the triggers list 

 

 

 

 

​
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Control Panel 

A single Control Panel resource can be added to each individual scene or base scene.​
See Scene Control Panel in this user guide for more information.  

​
Data 

The Advanced Data Object is documented in the Prime Data Object Guide 

​
GPI Out 

GPI Out can be added to any scene as a resource within the scene. 

GPI Out Properties: 
●​ Device: ID of the device. Multiple devices can be used 
●​ Pin: Pin number for the out 
●​ Mode 

o​ Pulse: Sends out a pulse “High to Low” or “Low to High”. 
o​ Manual: Send the “High or Low” manually. Can be assigned to a keyframe or a 

control panel button 
●​ Pulse Direction: Set “Low to High” or “High to Low” 
●​ Pulse Duration: When Pulse mode is set to “Pulse” set the duration between the “High 

to Low” or “Low to High”.   of the pulse  
●​ Pulse: Sends the pulse.  

​
 

​
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GPI Events: 
●​ On Pulse: Event happens when GPI is pulsed 
●​ On High: Event is raised when GPI goes to high from some other state 
●​ On Low: Event is raised when GPI goes to Low from some other state​

 
​
When the mode is set to “Manual” two commands will be available in the Triggers list, “High & 
Low”:​

​
When the mode is set to “Pulse” The Triggers list will 
show “Pulse” only. 

 

To trigger a GPI out from the timeline, create a keyframe in 
the timeline editor by clicking the “Add Keyframe” button. 

 

From the “Keyframe Editor” select the “Triggers” combo box that will show the above (Figure 1 & 
Figure 2)​

 

GPI In 

​
GPI In resource can be applied to:  

●​ Scene  

​
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●​ Application  
●​ Project 

GPI In can be added to any scene as a resource within the scene.​
GPI In Properties: 

●​ Device: ID of the device. Multiple devices can be used 
●​ Pin: Pin number for the in 

​
GPI Events: 

●​ On High: Event is raised when GPI goes to high from some other state 
●​ On Low: Event is raised when GPI goes to Low from some other state 

 

 

​
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Hot Key 

Hotkey resource can be applied to:  

●​ Scene  
●​ Application  
●​ Project 

Key 
Select the Key(s) you wish to assign the Hot Key  

Command​
Select the command (action, condition, sequence ect.) you wish to trigger when the designated 
keyboard hotkey is pressed. 

 

​
If a hot key has been assigned in multiple places all of the assigned commands will execute.   

*The order of execution is the order in which they are registered in Prime. Generally this will be 
Application, then Project then Scene. At the scene level it will be prioritized in the order they are 
played to output.  

​
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Execute Behavior 

●​ Active Scene Only - Only executes the command if the scene is the active scene​
 

●​ Active Section Only - Only executes the command if the scene is in the active section of 
the channel (Preview or Program)​
 

●​ Active Channel Only - Executes the command if the scene is in the active channel​
 

●​ All Channels - Executes the command regardless of if the scene is in the active channel 
or active section​
​

 

​
​
 

 

 

 

​
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Execute Section 

●​ Preview - Only executes the command when the scene is in Preview (or not Playing)​
 

●​ Program - Only executes the command when the scene is in Program (or Playing)​
 

●​ Preview and Program - Executes the command regardless of whether the scene is in 
Preview or Program​
​

 

Hot Key Advanced: Control Panel Focus executes Condition with a Hotkey 
This feature allows an operator to tab into a control  panel object (which sets the focus) and 
press a hotkey to run a condition.  

Logic Syntax 

●​ ControlPanel.IsActive 
●​ ControlPanel.ActiveControl   
●​ ActiveControl.GetTargetObject() 

Example use case is the ability to change the color or weight of the text object bound to the 
control panel text object that has focus.  

​
​
337 | PRIME 5.3 User Guide  



 

 

●​ Parent Keyword 
○​ This will allow for the active control property to update graphics near selected text 

object 
○​ Parent keyword is accessible in logic statements  
○​ For example Text1.Parent.Background.File = “abc.png” could be used to update 

an Image named Background that is a sibling to Text 1 

Hot Key Logging:  
Hot Key triggers can be enabled in Prime workflow Logger.  

​
LIDIA 

See the separate dedicated LIDIA Users guide. PRIME LIDIA.pdf  

​
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Message 

The message object allows you to output messages via Serial port or by Network (Via TCP or 
UDP). 

The “Message” property may be “keyframed” in an Action or the “Send” command can be 
triggered from an event. This will transmit the message out.  

 

Maintain Connection: When checked, the Message resource connection will open on scene 
load and close on scene close.  It will timeout after 5 seconds if a connection cannot be 
established.  

 

In UDP mode to broadcast across the entire network set the 
“Address” property to “255.255.255.255” 

The message property supports common non-printing 
codes, hex values, and plain text. Codes and hex values 
need to be surrounded in a tag (angle brackets < and >) to 

​
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be interpreted correctly. Plain text can be written anywhere and do not require tags. If a tag is 
not recognizable, it will be left untouched. If necessary, angle brackets can be escaped with a 
leading backslash (\<). 

Code examples: 

●​ <LF> will be replaced with the line feed character 
●​ <TAB> will be replaced with the tab character 
●​ <EOT> will be replaced with the end of transmission character 

Hex examples: 

●​ <A> will be replaced with the line feed character 
●​ <41> will be replaced with the A character 
●​ <7D> will be replaced with the } character 

See the user’s guide for more information. 

Message formatting also applies to the Header and Terminator properties found in the 
screenshots above.​
​
 

 

Plugins 

See the separate “PRIME Plugin User Guide”. 

 

​
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Table 

Adding a table resource to a scene will open a new table window. To toggle visibility of the 
dockable Table window navigate to View in the toolbar.  

Table Properties 

 

●​ Table Name: Editable alphanumeric text field  
●​ Advanced: 

○​ Index: Option for first row to begin with 1 or 0. Select from drop down 1-Based 
(default) or 0-Based 

●​ Columns 
○​ Add Column 

■​ Name: Alphanumeric column name 
■​ Type: Select column default type. Table cell value must adhere to column 

type. For example String = alphanumeric, Boolean = true or false, Color = 
Hex or RGB value 

■​ Default value 
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Table View 

 

*For manual entry of data, begin with creating columns in Table properties  

Table Toolbar 

●​ Add: Add row  
●​ Remove: Remove Row 
●​ Import: Import CSV 

○​ Import Comma Delimited File. Format available in Excel & Google Sheets 
○​ Prime will automatically pre-determine column type by analyzing the data in the 

column. 
○​ Option to “Use First Row as Column Headers” 
○​ Delimiter Options 

■​ Comma 
■​ Pipe 
■​ Semicolon 
■​ Tab 

*.CSV files can be delimited with different characters (not just commas). This allows the 
user to specify the delimiter when importing a csv to a table. 

​
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Import CSV Examples​

​

​
​
 

●​ Table View Shortcut Keys 

​
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●​ Table Arrangement in Table View 
○​ Column can be dragged and dropped into preferred order 
○​ Row can be dragged and dropped into preferred order 
○​ Color Type: Enter a HEX, RGB value or use color picker control 
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Table Resource can be added to replaceables. This allows table data to be updated through 
Camio workflow and/or through Intelligent Interface commands.  

●​ Data property for Table Resource:Replaceable = Tab-delimited Data without the Column 
Names Rows. Tab will used as column separator, new line will used as row separator 

●​ JSON property for Table Resource: Replaceable = JSON Data 

​
Data Object data sources can be ingested into the Table Resource.​
Please see the PRIME Data Object Guide for more information. 

 

 

 

​
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Script 

Refer to the PRIME_API_Scripting_Guide for more  

The Script Resource Object allows for C# scripting to be part of the scene.​
A full C# editor with intellisense (Auto Complete) becomes available. The C# Script Resource 
allows access to the entire PRIME API. 

Timer 

 

 

​
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The Timer Properties panel allow users to configure: 

●​ Modes: 

Clock 

​ Display the system Time of Day. Includes Time zone properties 

Timer Up 

​ Counts upwards to specified time 

Timer Down 

Counts downward from specified time 

Time Countdown 

​ Counts downward from specified future time 

Date Countdown 

Counts downward from specified future Date 

Time Countup 

​ Counts upwards to specified time 

Date Countup 

Counts upwards to specified Date​
​
 

Timer Commands 

 

●​ Bindings - Binds the clock value to the scene object(s)​
 
Events 
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●​ Started 
●​ Stopped 
●​ Finished 
●​ Users defined events may be added as well to the “Time Elapsed” event list 

 
Property Changed Events 

 

Formats 
o​ Days, Hours, Minutes, Seconds, Frames 

 

​
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String literals can be applied in the format using the backslash character 

So d:\D\a\y\s will display the “4 Days” if d=4. 

 

Or quote the text you wish to display this way: 

​
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●​ Events 
 

●​ Started: Triggered when the time starts 
●​ Stopped: Triggered when the clock 

stops 
●​ Finished: Triggered at the defined 

finish time 
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XKeys 

XKeys can be set up globally in PRIME Playout module or can be scene based. 

Playout 

If users configure XKeys from the Runtime user interface, these button presses will act globally 
regardless of any scenes being currently opened. 

 

The “Index” property allows for multiple XKeys devices to be daisy chained. If multiple devices 
of the same type are plugged in PRIME will allow users to target each separately by using the 
“Index” property. 

​
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Scene based 

Key up-Down properties will expose the Triggers list for users to hook up events to the key 
presses​

 

​
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Scene Tree 

 

The Scene Tree is divided up into several sections: 

●​ Quick Functions and Search Bar 
●​ Advanced Search by Type and Tag 
●​ Object Properties Column 
●​ Objects Column 
●​ Effects Column 

 

​
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Scene Tree Quick Functions and Search Bar​

 

●​ Cut 
●​ Copy 
●​ Paste 
●​ Rename 
●​ Group Selected 
●​ Ungroup 
●​ Delete 
●​ Search Properties 

○​ Filter 
○​ Highlight 
○​ Advanced 

●​ Search Bar​
 

 

​
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Scene Tree Search by Type or Tag 

Left click the magnifying glass and select Advanced to toggle searching by Type or Tag 

​
​

 
 
Designers can search for and see all added Objects in a Scene. By selecting one or more 
objects at a time, designers can quickly search for certain objects such as Graphics, or Graphics 
+ Effects, or Graphics + Effects + Resources for example.​
​
Click the left menu from Type to Tag to Search by Tag. This allows designers to see all Tags 
within a PRIME Scene and also filter or highlight objects with only the specified tag.​
​
Search by Type and Tag uses the same Filter or Highlight Search Modes like when searching by 
name. Users can also combine Search by Type or Tag along with Searching by Name if needed.
​
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The Objects Properties Column​

 

The Left Column allows for toggling on and off the Object properties​
*Right click on the left column toolbar to hide/show these properties ​
 

Objects Properties 

Each object has properties to the left of the object in the darker section: 

●​ Disabled, Locked 
●​ Locked 
●​ Projection 
●​ Lighting 
●​ Node Color  

​
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The Objects Column​

 

Shows all added Scene Toolbox Objects (Graphics, Effects, and Resources), Control Panel 
Controls, Parameters, Expressions, Logic, Conditions, and Replaceable objects from top to 
bottom. 

​
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Selecting an object or effect will show its properties​

​

 

​
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The Effects Column: 

●​ Allows for the dragging and dropping of Effects from the Toolbox 

 

 

Parameters/Expressions/Conditions/Replaceables:​
See the separate sections and documents for descriptions. 

​
 

​
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Timeline Editor 
The timeline editor allows the creation of Actions 

Actions are groups of Animations 

Animations consist of Animation Tracks. 

An “Animation Track” is made up of Track Keyframes. 

Note: “Transitions” are individual effects that may be applied to objects. See the “Transitions” 
section. 

Proportional Scaling of the timeline: Select 3 or more keyframes, then hold down the Alt key and 
drag one​
​
The left-hand column is a list of scene objects that can be animated by creating object 
animations​
​

 

​
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Animation Track Properties 

Normal: 

Inherit The animation starts from or finishes in the current attribute value. It is like setting the 
value of the first or last keyframe to the value of the animated attribute at time the animation is 
started. This comes handy when you want to animate to/from defined state but the current state 
is unknown. Using this mode minimizes the number of animations you would have to create 
from all possible states. 

Relative: The animation evaluates a number that is added to the current attribute value. 
Available for before looping only 

Loop: Loops the Animation Track 
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Default Action  

There is a setting that determines the behavior of keyframes in the Default action.  The Default 
action will play when the scene is loaded to Preview, and will play on Program only when an 
Effect In event is not present.  Please see the Scene Events section for more information.   

 

 

When “Auto Default Keyframe” is checked keyframes will automatically be added to the Default 
action as keyframes are added in other Actions.  

Ex: If I create an action “Dissolve Off” for scene object “Image1”, an opacity keyframe for 
Image1 will be added to the Default Action. 

 

​
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Set Default Keyframe 

“Auto Default Keyframe” only sets the Default keyframe once and is not updated each time the 
property value is changed in other actions.  Users might find it helpful to use “Set Default 
Keyframe”.  This will copy the selected keyframe value and paste it automatically to the Default 
action.  “Set Default Keyframe” is accessible in the context menu by right-clicking on the 
keyframe.  

 
Ex. Continuing with the previous example, if I had accidentally set the opacity keyframe in 
“Dissolve Off” to 0, the Default action would also be 0.  This might provide me with incorrect 
previews.  Instead of copying and pasting the correct value from the “Dissolve Off” action into 
the “Default” action I could simply right-click on the keyframe in “Dissolve Off” and click “Set 
Default Keyframe” 
 
 
When “Auto Default Keyframe” is disabled, at no time will keyframes be automatically added to 
the Default Action. 
 
 
 

 

 

​
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Color Coding the Timeline 

Select “Node Color” from the Scene Tree​

 

​
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Keyframe Property Values 

 

The above screen shots show keyframe navigation per track and applying property value 
changes from the Timeline editor. 

Click on the color chicklet to open the color picker. 

Click on the Thumbnail image to change the filename 

Click on any Command property to select any command associated with that object 

Click on any blue link to modify the objects property value. 
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Keyframe Interpolations: 

 

See the “Timeline Triggers” section for executing triggers from the timeline. 

 

“In” interpolations can be Linear, Smooth, Ease or Bezier 

“Out” interpolations can be Hold, Linear, Smooth, Ease or Bezier 

 

 

​
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Linear: Proportional average between 2 adjacent values. This is the default 
interpolation unless changed in the settings. 

 

 

 

Ease: In and Out tangents are horizontal in the keyframes.  

 

 

Hold: The value from the previous keyframe is kept until it is redefined by 
the next keyframe. The only interpolation for attributes with discrete values.  
This might give some animations a jumping effect, depending on the 
properties keyframed. 

 

Smooth: In/Out tangents are synced to maintain a smooth continuity of a 
curve.  
 

 

 

Bezier: Similar to the Smooth interpolation, with the distinction that the 
In/Out tangents are not synced.   

 

 

NOTE: Clicking a Keyframe in the Timeline Editor with the Ctrl button down will cycle the 
different Keyframe types. 

 

​
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Keyframe Timeline Ease Editor 

When a keyframe is set to “Ease” arrows 
will appear in the User Interface allowing 
designers to modify the ease values. The 
same can be achieved in the Keyframe 
editor by entering the numeric values. The 
arrows allow for a nicer experience. 

 

Dragging the arrows inward or outward will 
modify the numeric values in the Keyframe 
editor. 

 

 

 

 

Default Ease value can be set in “Config->Settings->Action” 

Copy/Paste Interpolation 

When pasting a copied keyframe, the user can decide to paste the interpolation information 
only. This means the same smooth motion can be applied to different properties.

 

Keyframe Spline Editor 

The Spline Editor offers users more control over their animations.  Click on “Spline” to toggle 
between the Timeline view and the Spline Editor. 

​
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Only one property can be displayed at any given 
time.  To change which property is displayed 
click in the region to the right of the property 
values. 
 
 
Keyframes can be added and removed on the selected property at the selected point on the 
curve. 

 
 
The zoom tool in Spline Editor mode only affects the x-axis.   
 
Auto Fit to Height 
The y-axis will automatically scale to contain all keyframes in view when Auto Fit Curve toHeight 
is enabled.  

​
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With Auto Fit to Height disabled the curve may appear outside the viewing area.  
 
To Pan around the timeline on both the X and Y axis hold the middle mouse toggle wheel down 
and move the mouse in all directions. Pan mode can also be entered by clicking the pan icon. 

 
 

Interpolation 
Interpolation modes are accessed via the context menu 
by right-clicking on the keyframe 
 
Interpolation Both: Sets both the In and Out 
interpolation of the keyframe. 

Interpolation In: Sets only the In interpolation of the 
keyframe 
 
Interpolation Out: Sets only the Out interpolation of 
the keyframe 

​
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Triggers 
The event driven model of PRIME allows users to trigger methods of any scene object.  The 
“Triggers List” lists all objects that have commands.  These commands may be triggered from 
any event within the scene, including a Keyframe event in the timeline.  The trigger list is also 
available to the Control Panel controls.  The trigger list is available from any “Event” list. 

Trigger List 

 

Triggered by List​ 

In the event driven model sometimes it’s difficult to determine which event triggered the 
condition, Action, script or any other trigger. PRIME has a “Triggered” by liust that will show you 
what events will trigger your Condition, Action or Script or any other Trigger. 

Usually the Lighting Bolt icon on a tool bar will open the “Triggered By” list to show you what will 
be the trigger. 

For example, in the “Condition” Editor: 

 

​
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Clicking on the Lightning bolt will bring up the “Triggered By” dialog showing what event will 
trigger “Condition1” in this example: In this example it shows that the “Text1 TextChanged” event 
is the event that will trigger “Condition1”. Multiple events could hooked up to the same trigger. 

 

For Timeline Actions there is a “Triggered by” button. The label also shows the number of 
events that could trigger the Action: 

 

 

​
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Timeline Triggers  

Triggers can be applied to the Scene Group, Scene Objects and Resources via the Properties 
Pane.  

To add a Trigger to a scene object, first add a keyframe to the timeline then select a Trigger or 
multiple Triggers from the Triggers list in the Keyframe Properties.  

 

To add Triggers to the Scene Group use the command sequence in the properties pane. 

Timeline triggers can not be added to Expressions, Parameters Conditions and Replaceables 

 

Control Panel Triggers  

 

 

 

​
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Triggering C# Scripts  

C# Script functions can be triggered from the “Triggers List” 

 

 

 

​
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Application Logic 
Application Logic is a scene that functions on application level. 
Create a new or edit an existing Application Logic scene. Consider Application logic as a new 
scene that gets created by PRIME at startup and runs continuously while the PRIME application 
is running. There are a limited amount of scene resources available such as GPI out, PRIME 
Switcher and XKeys. Parameters, Conditions and expressions are available as well. The 
parameters defined here have a scope beyond Scene and Project parameters. Parameters 
defined here are available to all scenes in all projects. 

 
Application Logic Scene 
 
When Prime is started, Application Logic Scene is loaded with all the events, conditions and 
resources inside it. Prime creates an empty Application Logic Scene by default called 
“Default.pal” and stores it in Prime\Settings\Logic folder. 
 
This scene can be viewed and edited in Editor through File -> Application Logic -> Edit 
Application Logic. The user can also create a new Application Logic Scene through File -> 
Application Logic -> New Application Logic. 
 
Application Logic scene currently supports Data, GPI In, GPI Out, Hot Key, Java Script, 
Keyboard Bank, Message, Switcher, Table, and X-Keys resources. 

 

 
​ ​ ​         Resources supported by Application Logic 
 

​
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These resources can be used the same way they are used in a project scene. There are 
numerous scenarios this scene will enhance the experience of designing and working with 
Prime. 
 
Examples of use cases: 
 ​
Data object is created to evaluate conditions stored in Application Logic Scene. 
 

 
This example shows a data object, which is used to evaluate conditions to modify application 
parameters.  

​
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In this example Data 1 object loads its content from data source and fires Data Ready event, 
which can be used to send a message stored in Message1 object 
 
 

 

​
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External Activations 
External Activations are functions that activate Actions and or Conditions in other scenes on 
output. 

​
 

There are four possible arguments: 
 
<ChannelIndex> is a number describing a channel (one-based 
so the first output channel is 1). 
<ChannelName> is the text name of a output channel. 
<SceneName> is the text name of a scene 
<ActionName> is the text name of an action 
 
All of these arguments support a wildcard (asterisk) in the 
following manner: 

●​ *​
This will match anything. So * could match any channel, any 
scene or any action depending on which argument it is utilized 
for. 

●​ *Text​
This will match any value that ends in "Text" 

●​ Text*​
This will match any value that starts with "Text" 

●​ *Text*​
This will match any value that contains "Text" somewhere other than the start or end. 

You cannot use the wildcard like this: 

●​ *Text1*Text2* 

Supported External Activation Usage for Actions or Conditions: 

●​ ActionName​
This will match any action with the provided name regardless of which scene contains 
it; only scenes on the same channel as the scene causing this trigger will be affected. 
This is consistent with the original External Activation implementation. 

●​ SceneName.ActionName​
This will match any action with the provided name in a specific scene, but only on the 
same channel as the scene causing this trigger. This is also consistent with the 
original External Activation implementation. 

​
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●​ ChannelIndex.SceneName.ActionName​
This will match any action with the provided name in the designated scene, but only 
on the channel indicated by the provided index. 

●​ ChannelName.SceneName.ActionName​
This will match any action with the provided name in the designated scene, but only 
on the channel indicated by the provided name. 

The same format exists to execute Conditions: 

ConditionName​
Scene.ConditionName​
Channel.Scene.ConditionName 

 

Actual Usage Examples: 
​
Imagine the following scenario.  

●​ Two output channels: "Output1" and "Output2" 
●​ Two scenes: "FirstNames" and "LastNames" 

o​ FirstNames has an action named "SlideOn" and "SlideOff" 
o​ LastNames has an action named "DissolveOn" and "DissolveOff" 

●​ Play both scenes to both outputs 

Now for crazy examples: 

●​ SlideOn​
If triggered from a scene on Output1, this will play action FirstNames.SlideOn.​
If triggered from a scene on Output2, no actions will be played. 

●​ FirstNames.SlideOn​
If triggered from a scene on Output1, this will play action FirstNames.SlideOn​
If triggered from a scene on Output 2, no actions will be played. 

●​ *.*On​
If triggered from a scene on Output1, this will play action FirstNames.SlideOn and 
LastNames.DissolveOn.​
If triggered from a scene on Output 2, no actions will be played.  

●​ 1.FirstNames.SlideOn​
Regardless of which scene activated this trigger, this will play action 
FirstNames.SlideOn on Output1.​
 

​
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●​ 2.LastNames.DissolveOn​
Regardless of which scene activated this trigger, this will play action 
LastNames.DissolveOn on Output2. 

●​ 2.*.*On​
Regardless of which scene activated this trigger, this will play FirstNames.SlideOn and 
LastNames.DissolveOn on Output2. 

●​ *.FirstNames.SlideOn​
Regardless of which scene activated this trigger, this will play FirstNames.SlideOn on 
both Output1 and Output2. 

●​ *.*.*On​
Regardless of which scene activated this trigger, this will play actions 
FirstNames.SlideOn, LastNames.DissolveOn on Output1 and FirstNames.SlideOn, 
LastNames.DissolveOn on Output2. 

●​ Output2.FirstNames.SlideOn​
Regardless of which scene activated this trigger, this will play FirstNames.SlideOn on 
Output2. 

●​ Output*.FirstNames.SlideOn​
Regardless of which scene activated this trigger, this will play FirstNames.SlideOn on 
both Output1 and Output2. 

 

​
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Bindings View 

 

The Bindings view is a great tool for users to understand and visualize how properties within a 
scene are bound to events. This is a great diagnostic tool. 

In the above example the first item reads: 

Keyframe 2 references a condition named “CDHeadshotOne”. 

Source: The Object that has a binding 

Bound To: The location of the source object binding 

Target: The target object that is referenced by the binding 

Binding: The target object the source is bound to 

Value: The current value of the property 

​
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Events 
Events are the foundation of PRIME.  Almost everything in a scene, meaning all objects, may 
raise an event when any of their properties are changed.  Most objects have events.  Users may 
“Hook Up” any “Trigger” (Above) to any event that gets raised within a scene. 

Every Object will have an Event tab.  Listed there will be commonly used events in combo 
boxes.  There will also be a list view to add as many events as the object has to offer.   

Below is the “Property Changed” section of every Event page. 

 

The following example shows the events available to a Clip Object that trigger any item(s) in the 
Triggers list. 

​
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​
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In this example, if the opacity changes it will trigger Action1.  If the Volume property changes, it 
will trigger Action 2. 

 

 

 

 

 

​
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Parameters Editor 
The Parameters Editor allows you to create, modify and delete parameters. Parameters are 
considered as storage locations for data. The Scope of a parameter’s availability can be set to 
either Scene, Project, or Application. 

●​ Scene Parameters are only available to objects in the parent scene. ​
 

●​ Project parameters are global to all scenes in the project.​
 

●​ Application Parameters, defined in the Application Logic section, are available to all 
scenes in all projects. 

Disable - disables the parameter in the Parameters and Scene Tree windows.​
​
Scope - You can change the scope type by selecting the scope button next to the disable button 
for each added parameter.​

​
​
​
Parameters, Expressions & Conditions are documented in the PRIME Parameters, Expressions 
& Conditions 

Parameters are useful for binding scene objects properties.​
To bind any Object Property to a parameter: 

1.​ Drag and drop the Object into the Binding column.  

OR 

2.​ Drag from the Scene Tree as in the example above. By dragging Text1 from the Scene 
Tree into the parameters Binding column, the default property of the Text1 object is its 
“Text” property. The binding is shown as “SceneName.ObjectName.ObjectProperty”. 

​
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Dragging and dropping any attribute or keyframe into an existing parameter will bind that 
parameter to that attribute. Drag keyframes from the keyframe editor to bind these properties. 

​
 

Type 

PRIME will determine the type automatically when users drag and drop the parameter. If users 
add parameters manually then the type needs to be set by the user. Users can set the type by 
clicking on the abc text next to Parameter and choosing from the variety of options.​
​

 

 

​
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Expressions Editor 
Parameters, Expressions & Conditions are documented in the PRIME Parameters, Expressions 
& Conditions 

 

 

Expressions may be inserted into any binding that accepts a string of text. 

Expression Samples: 

●​ Set X position of one object to another: 

                       Type               Expression           Bindings 

Double    ​ Image1.PositionX    ​ Text1.PositionX 

 

●​ Set X position of one object to another plus an offset: 

               Type       ​      Expression                          Bindings 

Double    ​ Image1.PositionX + 100    ​ Text1.PositionX 

 

●​ Set Opacity of one object to another times a scale value: 

                      Type            Expression                ​ Bindings 

     Double    ​ Image1.Opacity * .5    ​Text1.Opacity 

 

●​ Set File of one object to the modified Text of another: 

             Type     ​ ​ Expression                            Bindings 

       ​ String    ​ "I:\Graphics\" + Text1.Text + ".png"   ​  Image1.File 
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Scene Control Panel​  
To add a Scene Control panel to a scene or base scene: 

1.​ Navigate to Toolbox > Resources > Control Panel 
2.​ Single click Control panel resource   

 

A single control panel resource can be added to each individual scene or base scene.​
Only one control panel is permitted per 
scene.  

To access the Scene Control panel: 

1.​ Navigate to View > Control Panel 

You can also add a new Control Panel by 
clicking Add Control Panel in the CP 
Panel itself  

​
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The Scene Control panel is used to design a custom user interface and bind the controls to Scene 
Objects. 

The simplest way to create these bindings is to drag and drop an existing element directly onto the 
Control Panel: 

●​ Actions from the Timeline 
●​ Scene Objects from the Scene Tree 

The system will automatically create and bind a corresponding control. 

 

​
 

​
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Control Panel Toolbar Options​

 

Order - Select one or more CP Control Objects first and then select an order operation to bring 
that object either forwards or backwards in layer order. 

●​ Bring to Front 
●​ Send to Back 
●​ Bring Forward 
●​ Send Backward 

Align - Select at least two CP Control Objects and then select an Alignment operation to align 
those objects. 

●​ Align Left Edges 
●​ Align Horizontal Centers 
●​ Align Right Edges 
●​ Align Top Edges 
●​ Align Vertical Centers 
●​ Align Bottom Edges 

Distribute - Select at least three CP Control Objects and then select a distribution operation to 
distribute those objects. 

●​ Distribute Left Edges 
●​ Distribute Horizontal Centers 
●​ Distribute Right Edges 
●​ Distribute Top Edges 
●​ Distribute Vertical Centers 
●​ Distribute Bottom Edges 

Control Placement -  When new Controls are added to a Control Panel, this determines their 
initial location relative to existing Controls. 

●​ None - layered directly on top of each other 
●​ Left to Right - adds CP controls from left to right 
●​ Top to Bottom - adds CP controls from top to bottom 

(Changing this option also changes the Config Control Panel Placement Setting) 

 

​
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Control Panel Binding Properties 

Control panel Controls have their own set of bindings 

 

Mode - Project, Object, and Keyframe​
​
Object - objects within the Scene Tree​
​
Property - selected object properties​
​
Clicking Add will create a blank placeholder Binding which allows users to manually type the 
Mode, Object, and Property desired.​
​

 ​
​
You can also click the dropdown next to add and select the Mode, Object, and Property.​

​
​
Selecting a target binding and clicking edit will bring up a populated dropdown UI with the Mode, 
Object, and Property.​
​

​
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​
​
Selecting Project Mode allows users to select the primary project scene group and the scene 
group properties.​
​

​
​
Selecting the Keyframe Mode allows users to select an Object, Action, a specific Keyframe, and 
the Property that has a Keyframe.​
​

​
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​
​
​
Control Panels have their own set of Properties:​

​
Auto Tab Index - sets the tabbing order for items on the control panel based on their position. 
The tab order is set automatically from left to right and top to bottom. To set a custom Tab Index 
uncheck this option and set the Tab Index using the advanced properties. 

​
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Selecting the lightning bolt will show all the events for the control: 

 

​
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Buttons allow users to bind different types of commands within the “Properties panel” of the 
control. In this example, the button is bound to a Condition.​
​

​
​
You can continue to bind as many commands to the button as needed. 

Each control panel control type has their own set of properties, many of which however are 
common between each control. ​

​
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​
Behavior 

Visible On - Designers can choose per control to appear on Preview, Program, or both in 
PRIME’s Playout Channels. 

●​ Preview 
●​ Program 
●​ Preview and Program (Default) 

 

Enabled - indicates whether the control is enabled 

Tab Stop - indicates whether the user can use the TAB key to give focus to the control​  

Tab Index - determines the index in the TAB order that this control will occupy  

​
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Shortcut Keys 
PRIME has a Shortcut key manager for both play out and design 

 

To assign a shortcut key select an item from the list, place your cursor in the “Keys” column and 
begin to press the keys on your keyboard you wish to have as the shortcut.  

As the application grows the list of available functions will appear in the “Name” column. 

 

​
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Parameters, Expression & Conditions 
Parameters, Expressions & Conditions are documented in the  

“PRIME Parameters, Expressions & Conditions.pdf” file located in the PRIME Documents folder. 

 

Replaceables 

 

Any and all properties can be set to be able to have its property value changed via automation 
or CAMIO using  the “Replaceables” table. 

●​ Reorder- Drag and Drop Replaceables to reorder  
●​ Order- Used to fulfill data from the Intelligent Interface “W” command. To disable II for a 

replaceable object click on the numeric value. Disabling II on a replaceable will 
automatically renumber the replaceables list order. 

●​ Auto Erase - Used to erase the default value. Used mainly for LUCI/CAMIO 
●​ External Updates- Used for Intelligent Interface “X”-”R” command set. 
●​ Databound - Enable any replaceable object that is getting updated from another object 

like dataobject, parameters, XMP. 
●​ Show/Hide Replaceable - Used to show or hide a replaceable object from Playout’s 

Replaceable Panel and Edit Scene Messages 
●​ ID - Alphanumeric updateable field 
●​ Description - Alphanumeric updateable field. In LUCI/CAMIO Description will be the 

object name visible to producers in the LUCI NRCS plugin. 
●​ Value - Updateable field for object’s value  
●​ Bindings - Objects that the replaceable is directly bound to.    
●​ Character Limit - Limits the number of characters allowed for text objects. This is applied 

in LUCI/CAMIO.  

​
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By default, All replaceables added to a scene will be visible in the replaceables panel in 
Prime Playout. You can choose not to have certain replaceables visible by utilizing the 
new Hide/Show Replaceable menu introduced in PRIME 4.9.0​
Base Scene replaceables will not be visible automatically in the replaceables panel. 
Manually add the base scene binding object to the parent scene replaceables (preferred 
option) or add the base scene replaceable to the parent scene replaceable. You must 
enable databound on any base scene replaceable object, you intend to add to a parent 
scene’s replaceables. 

 

 

 

​
​
399 | PRIME 5.3 User Guide  



 

Effect In/Out 
Effect In and Effect out are properties of the scene. The Effect in and Effect Out combo box will 
show the “Triggers” list. 

Select an Action(s) as your effect In/Out or select a Condition to use “Conditional Transitions”. 
(See the “Conditional transitions” section. 

Other choices are available as your Effect in/out as well such as a script or External Activation 
(Trigger an action in another scene). 

 

​
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Conditional Transitions 
There are two types of “Conditional Transitions”. 

1.)​ Rules that evaluate which transition to trigger as the Effect In play based on conditions 
within the scene itself. 

2.)​ Rules that evaluate which transitions to trigger in other scenes on output at the time the 
current scene plays to output. 

Prime uses its “Conditional Manager” to manage the logic. 

Users can select an action from the list or select a Condition to evaluate which transition to 
play as the effect in. 

 

 

​
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Example: If the Title text is blank trigger Name ONLY Action otherwise trigger the Effect In 
Action. 

 

Conditional Transitions Advanced 
Functions that allow evaluating the scene that’s on the output channel. 

From the condition editor the following functions are available for use with​
Conditional Transitions: 

Channel.IsSceneOnOutput(string sceneName)​
Returns true if there is another scene matching the given name on the current channel; the 
current channel is defined as whatever channel the scene executing the expression is on. 
This does not match the scene responsible for executing this function. 

The sceneName can include wildcards like the External Action Trigger work from earlier this 
year. 

Channel.IsSceneAndNameOnOutput(string sceneName, string layerExpression)​
Returns true if there is another scene matching the given name and layer restrictions on the 
current channel; the current channel is defined as whatever channel the scene executing the 
expression is on. This does not match the scene responsible for executing this function. 

The sceneName can include wildcards like the External Action Trigger work from earlier this 
year.​
The layerExpression behaves like the feature in Intelligent Interface (>1, 1, >=1). 

Channel.IsDescriptionOnOutput(string description)​
Returns true if there is another scene matching the given description on the current channel; the 
current channel is defined as whatever channel the scene executing the expression is on. 
This does not match the scene responsible for executing this function. 

The description can include wildcards like the External Action Trigger work from earlier this year. 
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Channel.IsDescriptionAndLayerOnOutput(string description, string layerExpression)​
Returns true if there is another scene matching the given description and layer restrictions on 
the current channel; the current channel is defined as whatever channel the scene executing the 
expression is on. This does not match the scene responsible for executing this function. 

The description can include wildcards like the External Action Trigger work from earlier this year.​
The layerExpression behaves like the feature in Intelligent Interface (>1, 1, >=1). 

Channel.IsLayerOnOutput(string layerExpression)​
Returns true if there is another scene matching the layer restriction on the current channel; the 
current channel is defined as whatever channel the scene executing the expression is on. 
This does not match the scene responsible for executing this function.​
​
Channel.Resolution (Channel.Resolution.Width and Channel.Resolution.Height)​
Gets the resolution of the channel as defined by the playout configuration which is available in 
Logic and return the correct Width and Height of the channel 

Scene.Layer​
Returns the layer of the current scene. 

Scene.Loaded​
Returns true if the current scene is loaded. 

Scene.Playing​
Returns true if the current scene is playing 

Scene.Name, Scene.Description, Scene.Locked, Scene.Version, etc. have also been added. 

 

Examples: 

Create some Effect In Conditions: 

​
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Hook up the “Effect In” as a “Condition”: 

 

 

 

​
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Update In/Out 
Prime will automatically apply “Update In/Out” rules if the incoming message uses the same 
base scene as the outgoing message. 

The Transition effect applied to the object will trigger automatically. 

For a two line lower third, 

If Message 200 (Not Scene, but Message) is on air and its base scene is “Lower third” and 
message 201 is cued and uses “Lower Third” as its base message then the transition that is 
assigned to each of the two lines will trigger when the incoming scene 201 is played. 

IMPORTANT: The “Replaceable’s list will determine which scene objects transitions will be fired. 
Add each object to the Automation ID list that you wish to be applied to Update In/Out. 

 

By default an incoming scene is prioritized over an outgoing scene. The Auto Priority sets the 
priority value for graphics automatically with respect to their position in the scene tree. To 
manually adjust the scene priority uncheck the Auto Priority in the Scene Properties and set the 
Scene Group Priority > Render > Priority value.  

​
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API & Scripting 
API & Scripting is documented in the PRIME_API_Scripting_Guide document. 

 

 

​
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Bypass 
Systems with a compatible Matrox DSXLE4 card can switch between Bypass and In Circuit 
directly in PRIME Playout.​
​
When using a compatible DSXLE4 card and Matrox Hardware is selected, users can switch 
between In Bypass and In Circuit by clicking the Bypass menu in the bottom right hand corner of 
PRIME Playout.​
​

​
​
Go In Bypass: System will not output PRIME graphics and video input will pass through​
Go In Circuit: System will output both graphics and video input 

​

​
​
PRIME Bypass Not Available Scenarios 

●​ The Bypass Device is set to None 
●​ The Bypass Device is set to Matrox and an incompatible Matrox card has been detected 
●​ The Bypass Device is set to External Panel but the External Bypass Panel is not 

detected or has thrown an error. 

​
*Please see the PRIME Playout Configuration Guide for Bypass Configuration details. 
*External panel detection executes when switching to In Circuit.​
​
 

 

​
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Power Clips 
Adding and Configuring Power Clips Controllers 

 

Showing the Power Clips Controllers 

Power Clips are clips that are not part of individual scenes 
but clips that can play from the independent clip players 
created and configured in the “Playout Configuration” 

When A clip player is added through the PRIME Playout 
Configuration, the player clip controller becomes 
accessible in the Runtime user interface menus. 

 

Checking a clip player to view will show the Clip Player 
and its controls: 

​
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Selecting the drop-down caret in the upper right corner 
allows users to select to show/hide Playback controls. 

 

Default Transition 

Assign a default transition for clips that play from this controller. 

Playing Power Clips 

Clips played with this controller will play to their assigned channel and layer which is defined in 
the Controller setup not the clip itself. 

​
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Clips can be played back by automation under various protocols or manually by dragging clips 
from the current Projects clip folder or the common clip folder. 

 

Editing the Clip Metadata 

Clip files consist of two files, 1.) The actual media file such as MyMovie.mov and the 
associated side car file that contains all the metadata associated with the clip. Information 
stored there are settings like “Hold first Frame”, “Description”, Thumbnail etc. 

Prime Clips do NOT use a backend database, instead it uses the Windows file system as its 
database and the Windows Search API for searching. 

Clips are stored in your Projects “Clips” sub folder or in you Projects Common Clips folder: 

​
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To edit your clip right click on your clip to edit all the associated meta data for the selected clip: 

 

This will bring up the standard clip dialog: 

​
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Insert all the meta data fields you require. 

4-point looping is available using the clip timeline cursors. 

 

Creating a Power Clip 

A Power Clip is the ability to add Graphics, Text and other scene elements to your clip. 

Select a clip from your Clips database and select “Edit Power Clip”: 

 

This will launch the Advanced Power Clip Editor allowing you to add more elements to the clip. 
As you can see a “Power Clip” is essentially a scene with the base clip at the heart of it: 

​
​
412 | PRIME 5.3 User Guide  



 

 

In the following example we will add an image and some text to the clip. We will add an 
animation to animate the image and text on. 

 

​
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From the Timeline “Default” transition I will fade up the logo and animate the text to move on 
screen from screen bottom. 

 

Save the clip. 

When the clip is played the “Default” transition is played dissolving up the logo and animating 
the text to move into position from the bottom of the screen. 

You may want to update the thumbnail associated with the clip. Select the top node from the 
scene tree. From the scenes property editor, you will see a “Thumbnail” section. Select “Update 
from Canvas”. 

 

 

Power Clips will have an icon in the thumbnail in the browser. This clip is a Power Clips and has 
key as shown in the browser by the two icons in the lower right hand corner: 

​
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To Expose the Image and text to the Playlist or CAMIO/LUCI add the items to the Automation 
List: 

 

 

 

 

​
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Creating Clip Transitions 

From the Designer File menu select “New Clip transition” to open up the Clip Transition Editor 

 

Select Your “In” or “Out” transition from the Scene Group 

 

The Timeline Editor allows you to keyframe your effects 

 

. 

Your transition can now be applied to a Clip using the “Edit Clip” menu 

​
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Select your clip transition from the “Transitions drop down menu. 

 

 

​
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Creating a Sub-Clip 

Right click on a clip and select the “Generate Sub-clip” menu item to bring up the clip editor 

 

 

Set new In and Out points to generate the new sub clip 

​
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Searching for Clips 

Primes Search functionality uses the Windows Desktop Search API used in Windows Explorer. 

Note: PRIME does NOT support search capabilities for projects on mapped drives due to the Microsoft Search API 

 

The Browser search box: 

 

Searches can be saved and edited: 

 

 

Edit/Save Searches 

 

 

If you type into the Search Field Prime will search the following fields; 

Name, File Path, Description and Keywords. 

​
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Now type in “Rain” results in: (any file that has “Rain” in the Name, File Path, Description or 
Keyword will show up as a result of the search) 

​
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Advanced Searching 

Click the magnifying glass icon to launch the advanced search dialog 

 

 

The advanced search allows searching on all the fields associated with clips 

 

For extended search and filtering capabilities use the extended windows search terms 

Microsoft Generic Search Query 

​
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Microsoft Image Search terms: 

Microsoft Video Search terms: 

 

Examples of extended search terms: 

System.FileDescription 

System.Title 

System.Video.FrameWidth 

System.Video.FrameHeight 

System.Video.FrameRate 

System.Keywords 

Prime.HoldLastFrame 

System.Video.FrameWidth:>10 

 

Archiving Clips 

Clip files consist of two files, 1.) The actual media file such as MyMovie..mov and the 
associated side car file that contains all the metadata associated with the clip. Information 
stored there are settings like “Hold first Frame”, “Description”, Thumbnail etc. 

 

Right click on a clip: 

●​ Set the destination for the archive. 
●​ Add a prefix or suffix to the clip file. 
●​ Move the Media file. This option moves the actual clip file otherwise just the associated 

metadata file is moved to the archive folder. 

​
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​
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Clip Recorder 
Adding and Configuring Power Clips Recorders 

To add Clip Recorders, view the PRIME Playout Configuration Guide 

 

View the Clip Recorder 

Once Clip Recorders are added in the PRIME Playout 
Configuration they will become accessible in the “View” 
menu 

 

​
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Clip Record functions: 

●​ Quick Record- Starts recording immediately from the selected input. 
●​ Record-Brings up the record dialog allowing users to enter meta data to be associated 

with the clip and select clip compression. 

​
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●​ Frame Grab-Grab a single frame of video input 
●​ Stop-Stops recording the Quick Record 

 

Clip Converter 
See the separate document on the Clip converter/Watch folders. 

​
 

​
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CAMIO 
Template Preparation 

Clips and Graphic Templates can have replaceable elements that will show up in the 
ChyronHego NRS plugin. To define which elements will show up add them to the “Replaceable 
Editor” found in the Designer. Drag and drop from the scene tree the elements you want to 
exposed to the NRS plugin for producers to be able to fulfill.  

Note: these elements will also now be shown in the Play List as well. 

Replaceable Fields 

 

​
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Auto Erase 

o​ Id: This is the ID automation will use to identify this item. 
o​ Description: This is a user-friendly description and is also used in the NRS 

Plugin (LUCI) as the label for the replaceable item. 
o​ Order: Used by legacy automation commands. 
o​ Auto Erase: The data in this field will be erased in LUCI when the template is 

selected. 

LUCI Preview Only 

The “Preview Only” option allows for scene elements to be visible in LUCI templates and 
Previews. Any Scene object that has “Preview Only” marked as “True” will be visible in LUCI but 
will NOT be visible on the Playout machines. This option can be toggled On/Off from the “Tools” 
menu. When set to “Inherit” the setting will inherit from its parent. This way an entire group can 
be “Preview Only” by setting the Groups “Preview Only” setting to True.

 

​
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Publishing 

Publish a single scene 

Right click on a scene or clip and select “Upload to CAMIO”. Select the CAMIO server from the 
list of available servers defined in the above configuration: 

 

Publish a Project 

Click the Project Icon in the upper left hand corner of the Runtime user Interface and select 
“CAMIO Upload” menu. Select the CAMIO server from the list of available servers. 

 

 

​
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CAMIO Playback 

This section refers to the PRIME Playout devices 

Configure the CAMIO Server: 

From the Runtime User Interface select the menu Config->Settings->CAMIO. Press the “Add” 
button to configure CAMIO Server(s): 

 

​
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Configuring for Playback Control: 

Add an XML connection in the Automation Settings: This connection will receive playback 
commands from the CAMIO playback device controller (ISQ). 

 

 

 

​
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CAMIO Renderer 

This section refers to the CAMIO PRIME Preview Render Application that runs on the separate 
CAMIO Render device. 

CAMIO PRIME is the PRIME software configured to generate previews within the NRS plugin. 

The ChyronHego Dongle will show the “Device Type” as “CAMIO Renderer”. When set the 
PRIME application will serve as a Preview Renderer ONLY. Many features within the PRIME 
software will be disabled or unavailable. When launched the splash screen will show a “CAMIO 
PRIME Renderer”. 

The CAMIO Renderer Automation Connection: 

This connection will automatically be added and enabled. No Configuration required but is 
useful for diagnosis purposes to view the command stream. 

 

 

Configure the CAMIO Renderer End Point: 

 

 

​
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LIVE 
Uploading to LIVE 

Configure Live Uploader 

In Prime Settings > Live Uploader select Add to create a new connection Profile. 

Name: Alphanumeric value of your choosing 

Bucket Details 

Region: Select the region where the S3 Bucket is hosted 

Bucket Name: Populate with S3 Bucket name provided to the admin of your Live environment. 

Credentials  

Access Key ID: Populate with Key ID provided to the admin of your Live environment 

Secret Access Key: Populate with Secret Access Key provided to the admin of your Live 
environment. 

 

 

 

​
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Upload a single scene 

Right click on a scene or clip and select “Live Upload”.  

 

 

Select the Live Platform from the list of available configured Live environments, in the top right 
hand corner.  
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Select Add Files to add additional files.  

Select Add Folder to add additional folders 

To begin the upload process select “Upload Selected”.  

 

 

​
​
436 | PRIME 5.3 User Guide  



 

Display Matrix Display Port (GPU) Output 
See the separate document: Display Matrix Configuration. 

​
Performance Monitor  
PRIME is accompanied by a utility tool for measuring the application and system performance.  
This tool is called the PRIME Engine Performance Monitor and is located on the Start menu 
inside the Prime Engine folder  

 

​

​
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